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Preface

Safety information

\Q Note: For general safety information, see this section and Appendix J, “Safety”
on page 185. For important safety information related to the use of the Covaris™
S2 system, please refer to the user documentation of the product. When a hazard
symbol and hazard type appear by a chemical name or instrument hazard, see the
“Safety” Appendix for the complete alert on the chemical or instrument.

Safety alert words  Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular
level of observation or action, as defined below:

IMPORTANT! — Indicates information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

ﬁ CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
results in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety symbols” on page 186).

SDSs The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or
Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs,
see “SDSs” on page 195.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems
or Ambion contact the chemical manufacturer.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 7



Preface
Safety information

Safety labels on
instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in

the preceding section.

Hazard
symbol

English

Francais

/N

CAUTION! Hazardous chemicals. Read the Safety
Data Sheets (SDSs) before handling.

CAUTION! Hazardous waste. Refer to SDS(s) and
local regulations for handling and disposal.

ATTENTION! Produits chimiques dangereux. Lire
les fiches techniques de slreté de matériels avant
toute manipulation de produits.

ATTENTION! Déchets dangereux. Lire les fiches
techniques de sireté de matériels et la régulation
locale associées a la manipulation et I’élimination
des déchets.

CAUTION! Potential slipping hazard.

ATTENTION! Risque potentiel d'avoir un sol
glissant.

/&
A\

WARNING! Hot lamp.

AVERTISSEMENT! Lampe brilante.

WARNING! Hot. Do not remove lamp until 15 min
after disconnecting supply.

WARNING! Hot. Replace lamp with an
Applied Biosystems lamp.

CAUTION! Hot surface.

AVERTISSEMENT! Lampe br(lante, apres avoir
déconnecté le cable d’alimentation de I'appareil,
attendre environ 15 minutes avant d’effectuer un
remplacement de la lampe.

AVERTISSEMENT! Composants brdlants.
Remplacer la lampe par une lampe
Applied Biosystems.

ATTENTION! Surface brllante.

CAUTION! Replace only with Applied Biosystems
recommended light source (PN 4388441).

ATTENTION! La Lampe devra étre remplacée par
un model recommandé par Applied Biosystems,
Réf de la lampe: 4388441.

> e

DANGER! High voltage.

DANGER! Haute tension.

WARNING! To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside. Refer
servicing to Applied Biosystems qualified service
personnel.

CAUTION! Moving parts. Crush/pinch hazard.

CAUTION! Potential overhead hazard.

AVERTISSEMENT! Pour éviter les risques
d’électrocution, ne pas retirer les capots dont
I’ouverture nécessite I'utilisation d’outils.
Linstrument ne contient aucune piece réparable par
I'utilisateur. Toute intervention doit étre effectuée par
le personnel de service qualifié venant de chez
Applied Biosystems.

ATTENTION! Piéces en mouvement, risque de
pincement et/ou d’écrasement.

ATTENTION! Présence d’objet pouvant heurter la
téte.
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Preface
How to use this guide

How to use this guide

Text conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

» [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

User attention  Two user attention words appear in Applied Biosystems user documentation. Each
words  word implies a particular level of observation or action as described below:

Ay Note: —Provides information that may be of interest or help but is not critical to
the use of the product.

IMPORTANT! — Provides information that is necessary for proper instrument
operation, accurate chemistry kit use, or safe use of a chemical.

How to obtain support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.
» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, SDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.

* Download software updates and patches.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 9
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Chapter 1

Introduction

SOLiD™ 4 System run types

On the Applied Biosystems SOLiD™ 4 System, you can perform a workflow analysis
(WFA) run and a sequencing run (see Table 1).
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Table 1 Run types on the SOLID™ 4 System

WFA Sequencing
Purpose e Assess various preparations of templated Generate sequencing data for
beads to determine the potential quality of fragment or mate-paired libraries

sequence data
e Evaluate the fraction of P2-positive beads
e Use as a tool to determine the deposition
density for sequencing slides

Run summary e P1 and P2 bead counting Multiple ligation cycles for each of 5
* Single ligation cycle primers, resulting in up to 50 bases of
. sequence information per tag*
¢ Report generation

Estimated run time$ ~4 to 5 hours e -~41to 14 days
Deposition chamber 4-well e 1-well
o 4-well
o 8-well
Number of beads 15 million beads per well e 708 million beads per well (1-well)

e 128 million beads per well (4-well)
e 56 million beads per well (8-well)

1 One tag for fragment sequencing and two tags for mate-pair sequencing and paired-end sequencing. The reverse read tag in paired-
end sequencing is currently limited to 25 bases. Only 5 or 10 bases of the barcode tag need to be sequenced.

§ Total run time for dual slide run. Run time varies with read length and type of sequencing run. Times may deviate depending on imaging
time.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 11



1 Chapter 1 Introduction
SOLID™ 4 System run types

Use Figure 1 to choose the run type that most closely meets your sequencing needs:

Yes

No

Library titrated?

No

qPCR to be
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(

N

3\ { N\
Templa_ted bead prepara_tlon at Quantitative PCR (qPCR) Templated bead preparation at
two library concentrations

optimal library concentration
~

J J

. }

~

p
Workflow analysis (WFA) run - Sequencing run on
on SOLiD™ Analyzer SOLiD™ Analyzer

) ( )

J \ J

Workflow analysis
(WFA) run

12

Figure 1 Relationship between the workflow analysis (WFA) and sequencing runs
on the SOLID™ System.

You can optimize sequencing results by performing workflow analysis (WFA) runs. A
WFA run analyzes a quadrant of a slide that undergoes a single ligation cycle. The
quadrant contains beads deposited at a lower density than the density of beads
deposited for a sequencing run.

A WFA run determines the:

» Optimal library concentration: the library concentration for optimal preparation
of templated beads using the library. You use this library concentration for any
preparation of templated beads for that library as long as the scale of templated
bead preparation is the same.

* Bead enrichment efficiency: the proportion of beads that have been successfully
amplified using emulsion PCR (ePCR) as a fraction of the total number of beads
prepared. You use this value to accurately deposit successfully amplified beads for
a sequencing run.

WFA runs require the same materials as those materials needed for sequencing runs. If
you perform multiple WFA runs routinely, you should order additional SOLiD™
Instrument Buffer Kits.

To perform a WFA run, prepare slide and install reagents according to the procedure in
Chapter 2, “Prepare and Install Slides and Reagents” on page 19, then set up and
monitor the run according to the procedure in Chapter 3, “Set Up, Control, and
Monitor the Run” on page 53.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Chapter 1 Introduction 1
SOLiD™ 4 System run types

Sequencing run  There are five types of sequencing runs that can be performed on the SOLiD™ 4
System: fragment sequencing, paired-end sequencing, mate-pair sequencing, multiplex
fragment sequencing, and multiplex paired-end sequencing (see Figure 2).

Fragment sequencing
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Paired-end sequencing

=) F3 F5-P2 ¢=

Bead ) P1 Adaptor | DNA Fragment | P2 Adaptor

Mate-pair sequencing
=) F3 =) R3

Bead ) P1 Adaptor | Mate pair tag m_apgﬂ Mate pair tag P2 Adaptor

Multiplex fragment sequencing
=) F3 =) BC
Bead ) P1 Adaptor | DNA Fragment Barcode | P2 Adaptor

Multiplex paired-end sequencing
=) F3 F5-BC @ =) BC
Bead ) P1 Adaptor | DNA Fragment @ Barcode

Figure 2 Types of sequencing runs.
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Chapter 1 Introduction
SOLID™ 4 System run types

The type of sequencing run
Table 2).

depends on the type of library to be sequenced (see

Table 2 Types of sequencing runs possible for each library type

Library type

Possible sequencing run type(s)

Fragment library

* Fragment sequencing
¢ Paired-end sequencing

Mate-paired library

Barcoded fragment library

e Mate-pair sequencing

e Multiplex fragment sequencing
e Multiplex paired-end sequencing

During a SOLiD™ sequencing run, two probe sets are used to maximize the fraction of
mappable beads, read length, and sequencing throughput. (Mappable beads are beads
amplified with template that map to the reference genome.)

Compared to terminator-based sequencing chemistry, with SOLiD™ System
sequencing, base information is not collected; instead, five rounds of primers (Primers

A, B, C, D, and E) are used

to sequence template by ligation of di-base labeled probes

for each tag (for examples, see Figure 3).

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Chapter 1 Introduction 1
SOLiD™ 4 System run types

0123456 7 8 91011121314 1516 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50

00000000006000000000000000000000000000000000000000OCO0O0OCA0N

(@)

=0

|R3 Tag - Primer A | Cycle 1 | Cyce2 | Cycle3 | Cycled | Cycle 5 | Cycle6 | Cycle 7 | Cycle8 | Cycle 9 | Cycle 10] Y

R3 Tag - Primer B | Cycle 1 | Cycle2 | Cycle3 | Cycled | Cycle 5 | Cycle6 | Cycle 7 | Cycle8 | Cycle 9 | Cycle 10 | -%
[R3Tag—Primer C|  srageprove | Cycle 1 | Cycle2 | Cycle3 | Cycled Cycle 5 | Cycle6 | Cycle7 | Cycle8 | Cycle 9 | Cycle 10 | =
[R3Tag —Primer D | sige Prove Cycle 1| Cycle2 | Cycle3 | Cycled | Cycle5 | Cycle6 | Cycle7 | Cycle8 | Cycle 9 | Cycle 10| =
[R3Tag—Primer D | siageprobe | Cycle 1 | Cycle2 | Cycle3 | Cycled | Cycle5 | Cycle6 | Cycle 7 | Cycle 8 | Cycle 9 | Cycle 10 5
3

o

c
| | 2

I#Sequence up to 50 bp I#Sequence up to 50 bp 8

Bead ) P1 Adaptor | Mate-pair tag @I Mate-pair tag | P2 Adaptor

0123456 7 8 91011121314 1516 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50

000000000000000000000000000000000000000000000006000000000000CA06E

[F3 Tag - Primer A | Cycle 1| Cycle2 | Cycle3 | Cycled | Cycle 5 | Cycle6 | Cycle 7 | Cycle8 | Cycle 9 | Cycle 10 |
F3 Tag - Primer B | Cycle 1 | Cycle2 | Cycle 3 | Cycled | Cycle 5 | Cycle6 | Cycle 7 | Cycle8 | Cycle 9 | Cycle 10|
‘ F3 Tag — Primer C ‘ Bridge Probe ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [
Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \
Cycle 9 | Cycle 10]

Cycle 10 \

[F3 Tag — Primer D | Bridge Probe | Cycle 1 |
|F3 Tag - Primer E | Bridge Probe | Cycle 1 | Cyce2 | Cycle3 | Cycled | Cycle5 | Cycle6 | Cycle 7 | Cycle8 |

012345678910

L T

‘ Cycle 5 [ Cycle 4 | Cycle 3 [ Cycle 2 | Cycle 1 | F5-BC Tag — Primer A ‘ ‘ BC Tag — Primer A ‘ Cycle 1 [ Cycle 2 \
[cycle s [cycle 4 [ cycle s [ cycle 2 [ cycle 1 | F5-BC Tag - Primer B BC Tag — Primer B
‘ Cycle 5 [ Cycle 4 | Cycle 3 [ Cycle 2 | Cycle 1 ‘ Bridge Probe | F5-BC Tag — Primer C ‘ ‘ BC Tag — Primer C ‘ Bridge Probe ‘ Cycle 1 [ Cycle 2 \
‘ Cycle 5 [ Cycle 4 | Cycle 3 [ Cycle 2 | Cycle 1 | Bridge Probe [ F5-BC Tag — Primer D \ [ BC Tag — Primer D \ Bridge Probe ‘ Cycle 1 [ Cycle 2 \
‘ Cycle 5 [ Cycle 4 | Cycle 3 [ Cycle 2 | Cycle 1 ‘ Bridge Probe ‘ F5-BC Tag — Primer E ‘ ‘ BC Tag — Primer E ‘ Bridge Probe ‘ Cycle 1 [ Cycle 2 \

[ | [ |
l# Sequence up to 50 bp Sequence up to 25 bp(:l q Sequence 5 or 10 bp

Bead | P1Adaptor | DNA Fragment Barcode P2 Adaptor

0123456 7 8 9101112131415 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50

0000000000000000000060000000000000006000000000OOOCO0O0OCA0E

‘ F3 Tag — Primer A ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \
F3 Tag — Primer B ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \
‘ F3 Tag — Primer C ‘ Bridge Probe ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \
[ F3 Tag — Primer D \ Bridge Probe ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \
‘ F3 Tag — Primer E ‘ Bridge Probe ‘ Cycle 1 [ Cycle 2 \ Cycle 3 [ Cycle 4 \ Cycle 5 [ Cycle 6 \ Cycle 7 [ Cycle 8 \ Cycle 9 [ Cycle 10 \

Figure 3 Di-base sequencing in a mate-pair sequencing run (top) and in a
multiplex paired-end sequencing run (bottom).
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SOLID™ 4 System run types

The workflow for each type of sequencing run is shown in Figure 4.

Fragment sequencing

Paired-end sequencing

Mate-pair sequencing

Load reagents and slide onto SOLiD™ Analyzer

Run F3 Tag — Primers Ato E
(up to 10 cycles per primer)

Load reagents and slide onto SOLiD™ Analyzer

Run F5-P2 Tag — Primers Ato E
(up to 5 cycles per primer)

Load reagents and slide onto SOLiD™ Analyzer

Run R3 Tag — Primers Ato E
(up to 10 cycles per primer)

ent completes the run

Y

Y

Load reagents onto SOLiD™ Analyzer

Run F3 Tag — Primers Ato E
(up to 10 cycles per primer)

Load reagents onto SOLIiD™ Analyzer

Run F3 Tag — Primers Ato E
(up to 10 cycles per primer)

ent completes the run

ent completes the run

Multiplex fragment sequencing

Multiplex paired-end sequencing

Load reagents and slide onto SOLiD™ Analyzer

Run BC Tag — Primers Ato E
(1 or 2 cycles per primer)

Load reagents and slide onto SOLiD™ Analyzer

Run BC Tag — Primers Ato E
(1 or 2 cycles per primer)

Y

v

Load reagents onto SOLiD™ Analyzer

Run F3 Tag — Primers Ato E
(up to 10 cycles per primer)

Load reagents onto SOLiD™ Analyzer

Run F5-BC Tag — Primers Ato E
(up to 5 cycles per primer)

ent completes the run

v

Load reagents onto SOLiD™ Analyzer

Run F3 Tag — Primers Ato E
(up to 10 cycles per primer)

lent completes the run

16

Figure 4 Sequencing run workflows.
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Chapter 1 Introduction 1
Software operation and data analysis

Software operation and data analysis

The SOLiD™ 4 System comprises multiple complementary analysis software
components that complete primary analysis (image acquisition, signal processing,
color calling, and quality control) and secondary analysis (alignment to a reference
genome, SNP identification, and base calling) of fragment, mate-pair, and paired-end
sequencing experiments.

For information describing the relationship between ICS (SOLiD™ Instrument Control
Software), SETS (SOLiD™ Experimental Tracking System), and BioScope Software,
refer to the Applied Biosystems SOLiD™ 4 Software Operation and Data Analysis
Quick Reference Guide (PN 4448432).
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For additional secondary and tertiary analysis tools, visit the SOLiD™ Software
Development Community website (http://solidsoftwaretools.com). You can integrate
standalone tools from the SOLiD™ Software Development Community with BioScope
to perform more automated analysis. For details, refer to the BioScope™ Software for
Scientists Guide (PN 4448431).

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 17
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2 Prepare and Install Slides and Reagents
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2 Chapter 2 Prepare and Install Slides and Reagents
Materials and equipment required

Materials and equipment required

See Appendix A, “Set up and perform a workflow analysis (WFA) run” on page 102
for a list of equipment, kits, and consumables necessary to set up a workflow analysis
(WFA) run.

See Appendix A, “Set up and perform a sequencing run” on page 105 for a list of
equipment, kits, and consumables necessary to set up a sequencing run.

Workflow

Deposit the beads on the slide(s)
Wash the beads

Prepare the slide(s)
Deposit the beads

Y

Install on-instrument reagents

Prepare 1x Instrument Buffer
Prepare 1x T4 Ligase Buffer
Prepare Imaging Buffer
Prepare Universal Buffer
Prepare Cleave Solution 2.1
Install reagents

Check the waste level

Prime instrument and Storage Buffer lines

\ J
v

( Install slide(s) on instrument )
v

( Install reagent strip(s) on instrument )
v

( Set up, control, and monitor the run (see Chapter 3) )

20 Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Chapter 2 Prepare and Install Slides and Reagents 2
Workflow

Workflow overview Deposit the beads on the slide(s)

For a WFA run, the beads are quantitated using the Applied Biosystems SOLiD™ Bead
Concentration Chart (PN 4415131), and 15 million beads are deposited in one well of
a 4-Well SOLiD™ Deposition Chamber.

For a sequencing run, the choice of SOLiD™ Deposition Chamber depends on factors
such as the requirements of the experiment, number of libraries being assessed, the size
of the genome, and the sequencing coverage required. Three SOLiD™ Deposition
Chamber designs are available for use (see Table 3).

Table 3 Three deposition chamber designs

Deposition chamber Number of image panels
1-Well 2357
4-Well 426 per well
8-Well 186 per well

e
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«Q
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>
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»

Install on-instrument reagents

Prepare 1X Instrument Buffer using glycerol and 10X Instrument Buffer provided in
the SOLiD™ Instrument Buffer Kit. You may formulate 1X Instrument Buffer in 8-L
batches as needed or prepare it in larger volumes and store at 4 °C until ready for use.

pue sapl|S |[e1su] pue aiedald g Jeideyn

Prepare T4 Ligase Buffer, Imaging Buffer, Universal Buffer, and Cleave Solution 2.1
by combining the two parts provided in the SOLiD™ ToP Instrument Buffer Kit.

Cool the chiller block prior to installation of buffers.

Because the tubing from the Instrument and Storage Buffer bottles to the flowcell is
long, prime the lines before installing the slides in the flowcell.

Install slide(s) on the instrument

Remove the slide from the Deposition Chamber and prepare it for installation on the
instrument. Each flowcell can be loaded with the slide independently of each other.
Install reagent strip(s) on the instrument

Install the workflow analysis or sequencing reagent strips on the reagent strip chiller
block. Cool the chiller block prior to installation of reagent strips.
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Chapter 2 Prepare and Install Slides and Reagents

Tips

General

Covaris™ S2
System

Prior to deposition, store the slides at —20 °C to ensure optimal bead deposition
and to minimize loss of P2-enriched beads.

Remove the slides from storage at —20 °C 5 minutes prior to use.

If only one slide from the two-pack is used, place the remaining slide back into the
box and place the box back into the resealable pouch. The pouch should be
resealed and stored at—20 °C. The stored slide should be used within 1 month.

Use Eppendorf LoBind Tubes to perform all steps requiring 0.5-mL, 1.5-mL, and
2.0-mL tubes. LoBind Tubes from other vendors may have a chemical coating that
can have adverse effects on bead deposition.

Adjust microcentrifuge speeds and times according to the g-forces specified in the
protocols (160 x g, 167 x g).

The procedures are optimized for the Covaris"~ S2 System. The Covaris" S2
System must be specially adapted to prepare beads for the Applied Biosystems
SOLiD™ 4 System. Do not use the Covaris S1 sonicator or an unadapted Covaris
S2 System for bead preparation. For more information, contact an

Applied Biosystems SOLiD™ System Applications Specialist.

Ensure that the Covaris™ S2 System is degassed, that no bubbles are present in the
system, and that the instrument and tube are properly aligned for appropriate
sonication of beads.

To ensure optimal sonication by the Covaris™ S2 System, use the appropriate
adaptor with the Covaris”™ S2 System. For sample volumes < 200 pL, use a 0.5-
mL LoBind Tube and 0.65-mL tube adaptor. For sample volumes between 200 pL
and 600 pL, use a 1.5-mL LoBind Tube and 1.5-mL tube adaptor. For sample
volumes between 600 uL and 1.2 mL, use a 2.0-mL LoBind Tube and the same
adaptor as used for the 1.5-mL tubes. Place the tube collar at the indicator line of
the adaptor.
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Deposit the beads on the slides

Wash the beads \@ Note: The bead wash procedure is for one WFA or sequencing run sample.

1. Sonicate P2-enriched beads using the Covalent Declump 1 program on the
Covaris'™ S2 System (for program conditions, see “Covalent Declump 1” on
page 168). Pulse-spin, but do not pellet the beads.

2. If a WFA run has already been performed, use the results from the WFA report to
estimate the bead concentration and proceed to step 5; otherwise, use the Applied
Biosystems SOLiD™ Bead Concentration Chart (PN 4415131) to estimate the
bead concentration (see Figure 5).

(— OPTIMAL RANGE —\

125K 250K 500K 750K m 1.25M 1.5M M

Figure 5 The SOLID™ Bead Concentration Chart. For best results, use the Applied
Biosystems SOLID™ Bead Concentration Chart (PN 4415131), supplied separately.

3. Adjust the volume of beads so that the color of the bead solution matches a color
in the optimal range (750,000 beads/uL to 1.25 million beads/uL; see Figure 5 and

Figure 6).
( Match beads to color chart (750,000 to 1.25 million beads/pL) J
Too light Too dark

¢ Color of suspension? ¢
Place bead suspension in magnetic
rack and remove some of the Dilute with more 1x TEX Buffer
supernatant

[ Match beads to color chart (750,000 to 1.25 million beads/uL) }
Too light Too dark
Color of suspension?
Matched
[ Quantitate beads using the NanoDrop® ND-1000 Spectrophotometer }

Figure 6 SOLiID™ Bead Concentration Chart workflow.
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2 Chapter 2 Prepare and Install Slides and Reagents
Deposit the beads on the slides

4. When the bead concentration is within the accurate range, quantitate the beads
using the NanoDrop® ND-1000 Spectrophotometer [refer to “Quantitate the beads
using the NanoDrop® ND-1000 Spectrophotometer,” in the Applied Biosystems
SOLiD™ 4 System Templated Bead Preparation Guide (PN 4448378)].

5. Transfer the appropriate number of beads to a 1.5-mL LoBind Tube and store the
remaining beads at 4 °C.

Table 4 Number of beads to use according to the type of run and deposition

chamber
soLiD™ Target number of Maximum threshold
Type of run Deposition P2-positive beads number of beads per
Chamber per well* well*

WFA 4-Well 15 million 30 million
Sequencing 1-Well 708 million 778 million
Sequencing 4-Well 128 million 141 million
Sequencing 8-Well 56 million 61 million

I Note: The targeted bead deposition density is 300,000 P2-positive beads per panel, and the maximum
threshold bead deposition density for all beads (P2-positive or not) is 330,000 beads per panel. Exceeding
the maximum threshold number of beads per well may result in decreased sequence quality. Bead
deposition densities may deviate from the targeted bead deposition density of 300,000 P2-positive beads
per panel due to variability in the bead quantitation process. The calculated bead concentration based on
the WFA report is the most accurate because it specifically measures the concentration of P2-positive
beads (see “Determine the bead deposition density for a sequencing run” on page 66). If WFA run results
are not available, it is(%:)ossible to estimate the bead concentration using the SOLID™ Bead Concentration
Chart and NanoDrop® spectrometer measurement. It is recommended you target an additional overage
volume to account for measurement variability, especially for off-instrument bead quantitation. Typical
overages can range as high as 20% to 50% and can vary with the library, operator, sample type, and other
factors.

6. Place the tube of aliquoted beads in a magnetic rack for at least 1 minute. After the
solution clears, remove and discard the supernatant.

7. Remove the SOLiD™ XD slide(s) from —20 °C storage to equilibrate at room
temperature.

8. Resuspend the beads in 400 uL of SOLiD™ XD Slide Deposition Buffer v2.
Vortex thoroughly, then pulse-spin.

@ IMPORTANT! Do not pellet the beads.

9. Place the tube in a magnetic rack for at least 1 minute. After the solution clears,
remove and discard the supernatant.

\Q Note: It may take longer than 1 minute for the solution to clear.

10. Repeat steps step 8 and step 9 twice.
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11. Resuspend the beads in the volume of SOLiD™ XD Slide Deposition Buffer v2
listed in Table 5 (calibration of the SOLiD™ Deposition Chamber with the
SOLiD™ 4 Slide Carrier or SOLiD™ Opti Slide Carrier).

IMPORTANT! For upgraded systems with new slide carriers, the SOLiD™
Deposition Chamber should be recalibrated using the SOLiD™ 4 Slide

Carrier to determine the exact deposition volume.

Table 5 Approximate Deposition Buffer volumes

Deposition chamber Volume per well (uL)
1-Well 550
4-Well 400
8-Well 300

\g Note: Deposition Buffer volume is dependent on the slide carrier as well as
the Deposition Chamber, and volumes vary from slide carrier to slide
carrier. In addition, residual SOLiD™ XD Slide Deposition Buffer v2 that
remains on the surface of the slide after washing may alter the volume
slightly.
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Prepare the slide(s) 1. Thoroughly clean, rinse, and dry the SOLiD"™ Deposition Chamber before
deposition:

a. Clean the SOLiD"™ Deposition Chamber by rinsing it with MilliQ water.

(1) MPORTANT! For upgrade customers, the SOLiD™ Deposition
Chambers and SOLiD™ Opti Slide Carriers must be cleaned
thoroughly using a sonicator or Extran 300 detergent before use with
SOLiD™ XD Slides to remove all traces of glycerol (see “Clean the
SOLiD™ Deposition Chamber using a sonicator” on page 114 or
“Clean the SOLiD™ Deposition Chamber using Extran 300 on
page 116). Once all traces of glycerol have been removed from the
SOLiD™ Deposition Chamber, it should not be exposed to glycerol-
based solutions such as Overlay Buffer (from previous versions of
SOLiD™) or Slide Storage Buffer.

\g Note: Do not wash the SOLiD™ Deposition Chamber with ethanol
because ethanol damages the adhesive on the O-ring.

b. Blot the SOLiD™ Deposition Chamber dry on a lab wipe. Be particularly
careful to dry around the O-ring and to remove fluid from the fill ports.
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2. Insert a new slide into the SOLiD™ 4 or Opti Slide Carrier (see Figure 7).

@ IMPORTANT! Do not touch the slide surface.

(1) MPORTANT! The SOLiD™ 4 and Opti Slide Carriers are painted blue
across the side (see Figure 7). If you are using the SOLiD™ ToP reagent
strips for sequencing, you must use either the SOLiD™ 4 Slide Carrier or
the SOLiD™ Opti Slide Carrier. Using a different slide carrier may lead to
run failure.

a. Move the retainers out so that the slide can fit into the SOLiD™ 4 or Opti
Slide Carrier. To do this, push down on the two spring knobs in the SOLiD™
4 or Opti Slide Carrier and slide the knobs towards the outside edges of the
carrier (see Figure 7 A).

b. Place the slide against the alignment nubs in the SOLiD™ 4 or Opti Slide
Carrier.

c. Ensure that the slide is precisely positioned in the SOLiD™ 4 or Opti Slide
Carrier and then slide the retainers inward until they hold the slide in position
(see Figure 7 B).

\j Note: To move the retainers over the slide, do not push down the
knobs.
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Spring knob

Spring retainer

Orientation key

Blue on the side

Spring knob

Spring retainer

By
)
L
Q
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Orientation key

Blue on the side
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Figure 7 (A) The SOLID™ 4 Slide Carrier with spring knobs and retainers pushed
out and (B) with spring knobs and retainers pushed in (the slide is held under the
retainers).
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3. Pipet 3 mL SOLiD™ XD Slide Prep Reagent over the surface of the slide. Make
sure the entire slide is covered with SOLiD™ XD Slide Prep Reagent (see
Figure 8).

4. Let the reagent sit for 2 minutes.

@ IMPORTANT! Do not let the slide dry out.

Figure 8 Cover the slide completely with SOLID™ XD Slide Prep Reagent and let
sit for 2 minutes—do not let it dry out.
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5. Lay a Kimwipes® wiper (or other lab paper towel) on the lab bench. Hold the slide
in the carrier perpendicular to the lab bench, and decant the SOLiD™ XD Slide
Prep Reagent off of the surface of the slide onto the Kimwipes® wiper or paper
towel. If needed, carefully put the towel in the corner of the slide to soak up excess
reagent (see Figure 9).

IMPORTANT! Do not let the Kimwipes® wiper touch the surface of the
slide.
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Figure 9 Carefully use a lab towel to soak up excess SOLiD™ XD Slide Prep
Reagent, but do not touch the slide surface.

6. Pipet 3 mL SOLiD™ XD Slide Deposition Buffer v2 over the surface of the slide.
Make sure the entire slide is covered with SOLiD™ XD Slide Deposition Buffer
v2.

7. Decant the SOLiD™ XD Slide Deposition Buffer v2 off of the surface of the slide
onto a Kimwipes® wiper or paper towel (as described in step 5).

A Note: A minimal amount of SOLiD™ XD Slide Deposition Buffer v2 on
the slide surface after washing will not have a detrimental effect on
deposition.

8. Repeat step 6 and step 7 twice.
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9. Immediately place the SOLiD™ 4 or Opti Slide Carrier assembly into SOLiD™
Deposition Chamber base, then place the appropriate SOLiD™ Deposition
Chamber lid on top (see Figure 10).

@ IMPORTANT! After washing, do not let the slide sit for more than 10
minutes before depositing beads.

E Note: The SOLiD™ Deposition Chamber top must engage with the
orientation key to fit properly. The orientation key is in the lower-left
position when the slide carrier assembly is placed on the instrument. This
orientation must be maintained in order to preserve the correct sample
order when the 4-Well or 8-Well SOLiD™ Deposition Chamber is used.

Screw tab

—c

*
1

J

J

Figure 10 SOLID™ Deposition Chambers: 1-Well, 4-Well, and 8-Well.

10. Tighten the four screw tabs on the SOLiD"™ Deposition Chamber in a crisscross
pattern until the 1id is securely attached.

11. Twist the tabs flat.

Deposit the beads 1. Sonicate the beads using the Covalent Declump 3 program on the Covaris' " S2
System (for program conditions, see “Covalent Declump 3” on page 169).
Afterwards, pulse-spin, but do not pellet the beads.

2. Repeat step 1.

3. Use a pipettor with an appropriate tip to pipet the bead solution up and down a few
times, then withdraw the sample of templated beads from the microcentrifuge
tube.

IMPORTANT! Samples must be deposited onto the slide immediately after
sonication to minimize clumping and maximize monolayering.
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4. Perform one of the following sequences:

If the SOLID™ Deposition Chamber has... Then perform steps...
1 well 5,6,and 9 to 11
4 or 8 wells 7 to 11

5. Elevate and tilt the SOLiD™ Deposition Chamber with the entry porthole of the
well at the lowest point.

6. Carefully pipet a sample of templated beads into the well through the porthole. As
the area of the well fills, lower the top of the SOLiD™ Deposition Chamber so that
it becomes level. Proceed to step 9.

7. With the SOLiD™ Deposition Chamber flat, carefully pipet a sample of templated
beads into one of the 4 or 8 wells through the porthole.

8. Repeat step 7 to fill each of the remaining wells with each sample of templated
beads. Note each sample's well position relative to the slide orientation.
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9. Place 3-mm adhesive disks over all the portholes in the SOLiD™ Deposition
Chamber.
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10. Centrifuge the slide in the SOLiD™ Deposition Chamber at 167 x g for 10
minutes.

11. Incubate the SOLiD™ Deposition Chamber at room temperature for 1 hour.
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Install on-instrument reagents

Prepare
1X Instrument
Buffer

Prepare 1X T4
Ligase Buffer

Prepare Imaging
Buffer

Prepare Universal
Buffer

32

\Q Note: For information about recommended fill volumes for on-instrument

reagents, see “Recommended fill volumes for on-instrument reagents” on
page 148.

) Note: Prepare buffers just prior to use on the SOLiD™ 4 Analyzer.

. Add 800 mL of 10X Instrument Buffer to an empty 8-L reagent bottle.

@ IMPORTANT! Regular cleaning of the 8-L Instrument Buffer bottle is
required for every run (see “Clean the Instrument Buffer bottle” on
page 118). Failure to clean the Instrument Buffer bottle regularly may allow
microbial contaminants to proliferate in the system. Never top off the
Instrument Buffer bottle.

. Add 1600 mL of glycerol to the reagent bottle. Use a graduated cylinder to

measure the glycerol.

. Add 5600 mL of double-distilled water, rinsing residual glycerol from the

graduated cylinder.

. Using a clean magnetic stir bar, mix the solution for 10 minutes to ensure

homogeneity.

. Remove the stir bar and install the prepared buffer on the SOLiD™ 4 Analyzer or

store at 4 °C until ready for use.

. Transfer the contents of the 1X T4 Ligase Buffer Part 1 tube to the 1X T4 Ligase

Buffer Part 2 bottle.

. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure

thorough mixing and to minimize bubbles.

. Transfer the contents of the Imaging Buffer Part 1 bottle to the Imaging Buffer

Part 2 bottle.

. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure

thorough mixing and to minimize bubbles.

. Transfer the contents of the Universal Buffer Part 1 bottle to the Universal Buffer

Part 2 bottle.

. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure

thorough mixing and to minimize bubbles.
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3. After mixing, apply the Universal Buffer label supplied with the bottle.

Prepare Qleave 1. Transfer the contents of the Cleave Solution 2.1 Part 1 bottle to the contents of the
Solution 2.1 Cleave Solution 2.1 Part 2 bottle.

2. Gently mix the contents by slowly inverting the bottle 3 to 5 times to ensure
thorough mixing and to minimize bubbles.

Install reagents 1. Ifneeded, flush the tubing of the SOLiD™ 4 Analyzer fluidics system (see “Flush
the fluidic lines” on page 120).

@ Note: If the SOLiD™ 4 Analyzer is in continuous use, the fluidics system
should be flushed every three months. If the SOLiD™ 4 Analyzer will sit
idle for more than two weeks, the fluidics system should be flushed and the
instrument powered down with the fluidics lines empty.
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2. Double-click the SOLiD™ Instrument Control Software icon to launch the
SOLiD™ Instrument Control Software, if it is not already open.

3. Under the System Status menu, select Cooling from the Chiller drop-down menu
(see Figure 11).
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m Flow Cell 1
DE Flow Cell 2
Protocol Protocol

System Status

Prime Buffer Line:
Larnp: @ brs on

£ 2 Mo Run Defined ¥ Run Control . Mo Run Defined

£=3 Load Flowcell,.,
B Start Run » Skark B

Door: Closed-Locked E7] 27y Clear Floweell,..

(1 Unlock Doors

Figure 11 Select Cooling to cool the flowcell.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 33



2 Chapter 2 Prepare and Install Slides and Reagents
Install on-instrument reagents

4. After the chiller temperature is <10 °C, install the prepared 1X Instrument Buffer
and Storage Buffer into the appropriate positions in the cabinet (see Figure 12).

@ CAUTION! POTENTIAL OVERHEAD HAZARD. Use caution when
working inside the cabinet.

Waste 1x Instrument Buffer Storage Buffer

Figure 12 Positions of buffers and waste in the cabinet.
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5. Install Cleave Solution 1, prepared Cleave Solution 2.1, and Reset Buffer in the
appropriate positions on the side of the instrument (see Figure 13). Make sure that
the tubes on the caps of the reagent bottles are fully screwed on.

@ CAUTION! POTENTIAL OVERHEAD HAZARD. Use caution when
working inside the cabinet. Keep the instrument side door closed over the
Cleave Solution and Reset Buffer bottles.

F50LiD™ Instrument

sjuabeay
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> AN

Cleave Solution 1 Reset Buffer Cleave Solution 2.1

Figure 13 Positions of reagent bottles on the side of the instrument.
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6. Install the prepared Imaging Buffer, prepared 1X T4 Ligase Buffer, and prepared
Universal Buffer into the appropriate positions in the chiller block (see Figure 14).
Make sure that the tubes on the caps of the reagent bottles are fully screwed on.

1X T4 Ligase Buffer Universal Buffer Imaging Buffer

Figure 14 Positions of buffer bottles in the chiller block.

Check the waste 1. Check the level of waste in the 10-L carboy.
level

2. If the carboy is more than % full, properly dispose of the waste according to your
institution's environmental health and safety guidelines.
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Prime Instrument
and Storage Buffer
lines

Chapter 2 Prepare and Install Slides and Reagents

Install on-instrument reagents 2

@ IMPORTANT! The priming of the lines must be performed prior to each run
whether the Instrument and/or Storage Buffers were changed or not.

1. Under the System Status menu, click Prime (see Figure 15).

B solid0062 - SOLID - 4.0 - User: lab_user

[BEIE

CFle Tools Wizards Window Help

Ruir Marme: ) Run Name: @
Created by: Created by
] sssion Run [ £l A P clear I Run Logs v ST | o i P it . P lear W Runlogs [ Heat Map AN WY
Sample Slide Sample Slide
ﬂ-\-> Create Runs Hide Samples << Hide Samples <<
[ Manage Runs
Protocol Protocol
system Status
Prime Buffer Line:
Chiller: 4.0¢
| | |
Lamp: 0 b O
e Al Mo Run Defined ¥ Run Cantral . Mo Run Defined ¥ Run Control .
S i223 Load Flawicel... - 4y Load Floweel. ..
T » Start Run ® Stark Run
Door: Closed-Locksd ] £A e il s i
1 Unlock Doors
Imaging is Oriine | Fluidies is Oriins | ]I | samorzarm [t

Figure 15 Click Prime to prime the instrument and storage buffer lines.
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2. During priming, open the middle front door of the SOLiD™ 4 Analyzer to check
that the syringe is filled with buffer when the plunger is at the aspiration stage (see
Figure 16). Confirm that the buffer lines are filled with buffer. If the syringe is not
filled with buffer even at the last stroke, click Prime again.

Figure 16 Syringe on the SOLID™ 4 Analyzer.
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Install slide(s) on the instrument

Prepare the slide (1) IMPORTANT! Before removing the slide from the SOLiD™ Deposition
Chamber, ensure that either the instrument flowcell is ready or a SOLiD™ Slide
Storage Chamber is available.

1. Remove the 3-mm adhesive disks.

2. Pour enough SOLiD™ XD Slide Deposition Buffer v2 to cover the top of the
SOLiD™ Deposition Chamber (1.5 mL in each port for the 1-Well SOLiD™
Deposition Chamber and 6 mL for the 4-Well and 8-Well SOLiD™ Deposition
Chambers).

3. Using an appropriate pipettor and pipette tip, press down the plunger button, then
place the tip into one of the portholes of the well. Slowly release the pipettor
plunger button, then aspirate the SOLiD™ XD Slide Deposition Buffer v2. Fresh
SOLiD™ XD Slide Deposition Buffer v2 is drawn into the well to replace the old
Deposition Buffer. Repeat this procedure for the other wells.
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4. Gently loosen the SOLiD"™ Deposition Chamber screws. As the screws are
loosened, more fresh SOLiD™ XD Slide Deposition Buffer v2 is drawn into the
Deposition Chamber.
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5. Open the SOLiD™ Deposition Chamber lid, then carefully remove the SOLiD™ 4
or Opti Slide Carrier assembly from the Deposition Chamber.

6. Immediately pour Slide Storage Buffer over the slide to completely cover the
beads. Allow the Slide Storage Buffer to flow off onto a paper towel or into a
waste container.

7. Repeat step 6.

8. Immediately place the SOLiD™ 4 or Opti Slide Carrier assembly onto the
instrument or into the SOLiD™ Slide Storage Chamber.

IMPORTANT! The Deposition Chamber should not have any contact with
Slide Storage Buffer or Overlay Buffer (from previous versions of SOLiD™
instruments).

STOPPING POINT. If you are storing the slide, place the SOLiD™ 4 or Opti Slide Carrier
assembly into the SOLiD™ Slide Storage Chamber, then fill with 5 mL Slide Storage
Buffer. Store the slide at 4 °C until the slide is ready for use (see Figure 17).
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Figure 17 SOLID™ Slide Storage Chamber.

Install the slide @ IMPORTANT! Before removing a slide from a previous run, ensure that the run,
images, and data collected from the previous run are satisfactory. For more
information, refer to the Applied Biosystems SOLiD™™ 4 System SETS Software
User Guide (PN 4448411).

1. Check to see if a SOLiD™ 4 or Opti Slide Carrier assembly from a previous run is
present in the flowcell chamber. If a SOLiD™ 4 or Opti Slide Carrier assembly is
present in the flowcell chamber, proceed with steps 2 to 4. If a SOLiD™ 4 or Opti
Slide Carrier assembly is nof present in the flowcell chamber, skip to step 5.
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2. For each flowcell to be used, click the Clear Flowcell button at the bottom of the

flowcell panel (see Figure 18).

HIde Samples <<

Protocol

Mo Run Defined > Run Control || Mo Run Defined = RunContral [
B\-E Load Elowsrell, .

B Start Run

3 Clear Flowcel...

e T
L £ Clear Flowcell. .. |

line: l  Fluidics is Oniine | [

domof 2971 | |

Figure 18 Click Clear Flowcell to flush the contents from the flowcell.

3. After clearing each flowcell, open the appropriate flowcell chamber.

4. Remove the SOLiD™ 4 or Opti Slide Carrier assembly from the previous run. If
the slide will be reused, place the SOLiD™ 4 or Opti Slide Carrier assembly into a
SOLiD™ Slide Storage Chamber, then fill the chamber with Slide Storage Buffer.
Store the SOLiD™ Slide Storage Chamber at 4 °C.

5. Clean the flowcell block with 70% ethanol and Kimwipes® wipers to remove

residue.
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6. Inspect the O-ring and reseat it if necessary (see Figure 19; for details, see “Install
the SOLiD™ System Flowcell O-ring” on page 124). Check the O-ring for cuts
and abrasions. If any abnormalities are observed, replace it. Inspect the O-ring
grooves for debris or contamination and clean with water as needed.

O ring

Figure 19 O-ring installed on flowcell.

7. Ensure that the instrument and storage buffer lines are primed before loading a
slide, or the slide will dry out.

8. Insert the SOLiD™ 4 or Opti Slide Carrier onto the instrument. Work quickly to
prevent the slide from drying out.

a.

Remove the SOLiD™ 4 or Opti Slide Carrier assembly from the SOLiD™
Deposition Chamber or from the SOLiD™ Slide Storage Chamber.

. Place the SOLiD™ 4 or Opti Slide Carrier assembly into the open flowcell,

engaging the alignment key on the carrier with the corresponding part on the
flowcell.

. Slide the two slide carrier lock-down tabs on the flowcell inward until they

are positioned over and flush with the carrier (see Figure 20).

IMPORTANT! Ensure that the tabs are flush with the carrier. If
necessary, loosen the Allen screws further, then slide the tabs over the
slide carrier.

. To properly seat the carrier on the flowcell, gradually tighten the 2 Allen

screws on both lock-down tabs in an alternating fashion to 20 inch-pounds.

Rotate the flowcell up and lock it into the scan position.
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Slide carrier lock-down tab

Slide carrier lock-down tab
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Figure 20 Slide carrier lockdown tabs.

9. Close the instrument doors.
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10. Click the Load Flowcells button located at the bottom of the flowcell panel. Each
flowcell has its own Load Flowcells button (see Figure 21).

ocol Protocol
un Defined w Run Control . Mo Run Defined  Run Control i
g Load Floweell. . > C@ Load Floweel... )
B Start Run — — ® Stark Run
£ Clear Floweell... 3 Clear Floweell...

Figure 21 Click Load Flowcells to load the flowcell with buffer.
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11. Click Yes to start loading the flowcell.

IMPORTANT! The flowcell should be loaded within 1 to 2 minutes of slide
installation. Slides should be installed one at a time, with flowcells loaded
before installing a second slide.

12. Check for leaks to ensure that the slide does not dry out.
13. If only one flowcell will be used, ensure that unused flowcell slide carrier lock-

down tabs are pushed all the way in and tightened before closing the unused
flowcell.
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Install reagent strip(s) on the instrument

1. Clean the needle and bottom of the needle holder with a Kimwipes® wiper (see
Figure 22). If needed, first moisten the Kimwipes® wiper with deionized water or
use a pre-moistened alcohol pad.

Needle holder

Needle
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Figure 22 Needle and needle holder.

2. Thaw the appropriate reagent strip(s) on ice.

See Figure 23 to determine which reagent strips should be used for a sequencing
run. Use reagent strips from the boxes that match the arrow symbol for the
appropriate library and tag.

@ IMPORTANT! Verify that there is sufficient volume of Reset Buffer for
each tag sequenced. The SOLiD™ ToP Instrument Buffer contains
sufficient Reset Buffer to reset two tags (see “On-Instrument Reagent
Volumes and Reagent Strip Layouts” on page 147). For multiplex
sequencing, a bottle of Reset Buffer is included with multiplex sequencing
kits to account for sequencing the BC tag.

The blue circled numbers indicate the order in which the tags should be sequenced
for each library type. The XX represents read length options in bases (35 and 50
for F3 and R3 tags; 5 and 10 for BC tag).

@ Note: The 5-bp barcode sequencing reagents can be used if only barcodes
1 to 16 are being used. The 10-bp barcode sequencing reagents are needed
for any set that includes barcodes 17 to 96. For example, if you are
sequencing 32 barcoded fragment libraries using barcodes 1 to 32, you
should use the 10-bp barcode sequencing reagents. Only 5-bp or 10-bp
barcode reads (not both) may be sequenced on a single slide.
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Fragment sequencing

@ F3 Tag

Part No.
35 4449352
Part No.
4449388
Bead ] P1 | DNA Fragment | P2
Paired-end sequencing* @ F3 Tag @ F5-P2 Tag
Part No.
35 4449352 Part No.
Part No. 4449328
4449388
Bead ] P1 | DNA Fragment | P2
Mate-pair sequencing @ F3 Tag @ R3 Tag
Part No. 35 Part No.
4449364 4449376
Part No. Part No.
4449400 4449412
Bead ) P1 | Mate pair tag m | Mate pair tag | P2 |
Multiplex fragment @ F3 Tag @ BC Tag
sequencing
35 PartNo. Part No.
4449352 4449308
Part No. Part No.
4449388 4449316
Bead | P1 I DNA Fragment ™  BC
Multiplex paired-end @ F3 Tag @ F5-BC Tag @ BC Tag
sequencing
35 Part No. Part No.
4449352 4449308
Part No.
Part No. 4449340 @ Part No.
4449388 4449316
Bead ) P1 | DNA Fragment rr_l BC

* For non-multiplex paired-end sequencing of libraries prepared using the SOLID™ Total RNA-Seq Kit, use the
SOLID™ ToP Sequencing Kit — BC Frag. Lib., F5-BC Tag, MM25 (PN 4449340) to sequence the F5-BC tag instead of the F5-P2 tag.

46

Figure 23 Reagent strip box symbols corresponding to fragment sequencing,
paired-end sequencing, mate-pair sequencing, multiplex fragment sequencing,
and multiplex paired-end sequencing.

3. Place the reagent strip(s) in an ABgene® 96-well square-well storage plate and
centrifuge at 160 x g for 2 minutes.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide




Chapter 2 Prepare and Install Slides and Reagents 2
Install reagent strip(s) on the instrument

4. Verify that the reagent strip blocks are oriented and seated properly in the chiller
block. The block must engage the orientation key to fit properly. The orientation
key (cut corner) is in the upper-left position when the block is placed on the
instrument (see Figure 24).
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Figure 24 The Reagent Strip Block.

@ IMPORTANT! Ensure that the chiller block temperature is below 10 °C
before proceeding with reagent strip installation. Under the System Status
menu, select Cooling from the Chiller drop-down menu (see Figure 11 on
page 33).

5. When the temperature is less than 10 °C, place the reagents in the appropriate
location in the chiller block (see Table 6 and Figure 28 on page 50).

See Figures 25 to 27 for the appropriate location of reagent strips on the chiller
block. For information about the contents of the reagent strip tubes, see “Reagent
strip layouts” on page 151.

Table 6 Where to place the strip tubes

If using flowcell... Then place the strip tube(s) in the...
1 Front block
2 Rear block

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 47



2 Chapter 2 Prepare and Install Slides and Reagents
Install reagent strip(s) on the instrument

SOLiD™ ToP Workflow Analysis Reagents

Figure 25 Reagent strip block layout for WFA.

SOLiD™ Mixing Strip Tube with Zinc

Primer E

.

Primer D

-

Primer C

.

Primer B

GE——

rimer A

SOLiD™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM50

SOLiD™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM35

SOLiID™ ToP Sequencing Kit — MP Lib Seq, F3 Tag, MM50

SOLiID™ ToP Sequencing Kit — MP Lib Seq, R3 Tag, MM50

SOLiD™ ToP Sequencing Kit — MP Lib Seq, F3 Tag, MM35

SOLiD™ ToP Sequencing Kit — MP Lib Seq, R3 Tag, MM35

Figure 26 Reagent strip block layouts for sequencing F3 and R3 tags.
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SOLiD™ Mixing Strip Tube

Primer E

Primer D

Primer C

Primer B

Primer A
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SOLiD™ ToP Sequencing Kit — BC Frag. Lib., F5-BC Tag, MM25

Figure 27 Reagent strip block layouts for sequencing F5-P2 and F5-BC tags.
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Figure 28 Position of the sequencing reagent blocks for flowcells 1 and 2.

6. Place the cover over the reagent strips and secure them using the cover fasteners
(see Figure 29).

\g Note: Ensure that the top and bottom of the cover is free of splattered wet
or dry reagents (see “Clean the reagent strip cover” on page 125).
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o d SDS.
{5°Cto-25°C Reat Tl
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Cover fastener Cover fastener

Figure 29 Securely fastened reagent strip covers.
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8 Set Up, Control, and Monitor the Run

This chapter covers:
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Materials and equipment required

Section 3.1 Set up and perform a workflow analysis
(WFA) run

Materials and equipment required

See Appendix A on page 101 for a list of equipment, kits, and consumables necessary
to set up a workflow analysis (WFA) run.
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Workflow

( Prepare slide(s) and install reagents (Chapter 2) )
v

( Create a WFA run record )
v

( Detect the focus range )
v

( Start the WFA run )

, Y \

Monitor the run
View the run log
View the heat maps

View cycle scans

~ J
4 . + N\
View the WFA report
Generate the WFA report

Determine the optimal titration point

Determine the bead deposition density for a sequencing run

Workflow overview Create a WFA run record
A WFA run record is created using the SOLiD™ Instrument Control Software (ICS).

Detect the focus range

Two methods exist for determining the focus range: automatic and manual. You should
first attempt automatic range detection. If automatic detection fails, use the manual
mode.
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Workflow

Start the WFA run

Start the run by using the SOLiD™ Instrument Control Software. Before starting a run,
you may need to remove previous data may need to ensure maximum disk space for
new results.

Monitor the run

While executing a WFA run, the instrument performs a Prescan. In a Prescan, all of the
beads are labeled and their positions on the slide are recorded to derive a focal map and
then they undergo a single ligation cycle. The run can be monitored through the ICS or
the SETS browser by using the Run Log, Heat Map, and Cycle Scans.

Each flowcell generates a separate Run Log that records high-level events, such as
fluidic modules and slide scanning. The start and stop times of these events, as well as
any pauses or errors during the run, are also recorded. The Run Log is particularly
useful in helping you anticipate and schedule reagent refills or troubleshoot instrument
errors.

Heat maps are generated from the analysis of the focal map images and analysis of
each ligation cycle. A heat map is a colorized display of a particular metric (bead
count, bead signal, or image signal) across all the panels for a run (for definitions of
the metrics, see the “Glossary” on page 199).

For each flowcell, the corresponding Cycle Scans window provides nearly real-time
feedback on initial data quality on a per-cycle basis.

View the WFA report

You can view a WFA report in the SOLiD™ Experiment Tracking System (SETS) after
the run is complete. Three important metrics are generated in the WFA report: P2#/P [#
ratio, On-Axis beads, and Titration Metric. These metrics guide the selection of the
best-performing bead population based on different titration points used in ePCR (for
definitions of the metrics, see the “Glossary” on page 199). In general, the closer the
image data points are on-axis, the higher the quality of data obtained due to good bead
deposition and chemistry.

From the WFA data, you can also estimate the bead deposition density to be used when
preparing a slide for sequencing. Differences between bead concentration measured on
the NanoDrop® ND-1000 Spectrophotometer and the concentration actually detected
by the bead counting algorithm on the instrument may occur. In order to maximize
throughput in a SOLiD™ System sequencing run, a bead density of 300,000 P2-
positive beads per panel is recommended.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Section 3.1 Set Up, Control, and Monitor the Run 3
Create a WFA run record

Create a WFA run record

There are two ways to create a WFA run. The first method is to use the Run wizard (see
below). The second method is to import a .txt file that contains the run definition (see
“Set up a run by importing a Run Definition file” on page 127). Importing a .txt file
saves time re-entering information of a repeated run. The .txt file can be generated on
an off-instrument computer.

1. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 30 on page 57).
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i solid0062 - SOLID - 4.0 - User: lab_user
File Tools Mwizards window Help

Welcome: lab_user

a0LIL

Fun Mame;
Created by:

"FD Assign Fun | & : |_T|;. :

Sample Slide

% Create Runs [ Hide Samples <<

f"\ Manage Runs

m.ﬂﬂﬂz

EJE Flow Cell Details |

Figure 30 Use the run wizard to create a WFA run.

2. Complete the information in the Select Run Type and Mask pane (see Figure 31
on page 58):

a. Select the WFA option.
b. (Optional) Type a new run name.

(Optional) Enter a description.

o

d. Ensure that the mask 4_spot_ WFA_mask_sf is selected.
e. Click Next.
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Tools ‘Wizards window

SETUP > Create/Edit Run > Select Run Type and Mask (7]

The following pages will guide you through to setup a run. Reguired fields are noted with an asterisk ().

*Select bype of run to create

(O Fragment (O Mate-Par  (ParedEnd @ WA

Create New Run

1. Select Run Type
and Mask Pultiplesing

Identify the run and enter & description

*Run Name: |solid0062_20091222_WFA |

Description:

Assign a Primer Set and # of bases. Primsrs run in ssquential order
*Seleck Run Protocal; | 010 WES Sequencing For Workflow Analysis.

Primer Set 11 F3 1 Bases

*Select maskto use: |4 spof WFA_mask_sf L
< Back Finish
Imagingis Onine | Fluidics s Online || | | J4smofzam @

Figure 31 Complete the information in the Select Run Type and Mask pane.
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3. Complete the information in the Specify Samples and Analysis pane (see
Figure 32):

a. Assign samples to spots.

b. Click Finish.

- SOLiD - 4.0 - User: lab_user

‘Wizards Window Help

SETUP > Create/Edit Run > Specify Samples and Analysis

Select how many samples you need for this run. For Application, Primary and Secondary Analysis columns in a sequencing or multiplexing run, you can click the column b
remaining rows.

*How many samples will you need For vour mask?
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Sample Mame Primary Analysis Secondary Analvsis Description
wlaSample_1 default primary none
whasample_z default primary none
wlaSample_3 default primary none

To assign samples to spots, select a sample in the list and then click on spots to assign that sample to them,

Sample Mask - 4_spot_WFA_mask_sF Spoks -
1, whasample_1
Z. wfasample_2
3. whaSample_3
3
2

Figure 32 Complete the information in the Specify Samples and Analysis pane.
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4. Choose either to assign a run to a flowcell for immediate use or to store the run in
the instrument database for later use, then click OK.

5. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.

6. (Optional) Repeat the above steps for the other flowcell if performing a WFA run
on a second slide.
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Detect the focus range

Ay Note: If automatic focus range detection fails, determine the focus range
manually (see “Manually find the focus range” on page 132).

1. Close the front doors of the SOLiD™ 4 Analyzer. Open the Imager window by
choosing Windows » Imaging System.

2. Select Tools » Detect Focusing Range.

3. In the focusing range dialog, specify the stage template file by entering the name
of the stage template file directly or by clicking the Browse button to navigate to a
suitable stage template file (see Figure 33).

The stage template must match the slide in the target flowcell(s). If you created a
run from the ICS, then select the file imagingMap.STG (from the subdirectory in
C:\Runs) whose name matches the name of the run (for example, select C:\Runs\
Solid0327_20081209_2_Oct_Test\imagingMap.STG).

Ei Detect Focusing Range Q@@

Select Stage Template

| _~| Browse

Please select flowcel: |2 +|

Q
=0
Y
gl
-
(0]
=
w
w
0]
—
c
¥
O
o
=)
=3
=
o
(W)
=}
(o}
=
o
=)
=
o
=

Go | Cancel |
IDLE I

Figure 33 Detect Focusing Range dialog.

4. Select the flowcell using the drop-down menu, then press Go. The Imager works
for several minutes while it determines the range. The blue progress bar indicates
how close it is to completion (see Figure 34). You can also click Cancel so that the
Imager aborts the ranging operation.

Ei Detect Focusing Range B@@

Select Stage Template

| C:/Runs/salid0327_20081204_1x15_530uad_1/imagngMap.STG _~| Browse
Flease select floweell: il -|

| _Concel |

Searching focusing range at [-22218, -24504) -_

Figure 34 Detect Focusing Range Dialog while detection in progress.
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5. When the Imager is done, a dialog appears (see Figure 35). Click Yes if you want
to replace the values in the local settings file. Click No if you want the Imager to
discard the newly calculated focus range.

G Focusing Range Detection

. P , The focus range For Flowcell 2 is:
(BEDE21, 6TOEZ1).
Do you wank bo save these For this Floweell?

Riiivesiii ol

Figure 35 Confirm that you want to replace the local settings file.

6. Verify the validity of the newly calculated focus range by taking images at random
locations.

IMPORTANT! You should see images of beads, ensuring that the algorithm
was able to focus on the beads and not on other artifacts (see Figure 36). If
you do not see bead images or if you see out-of-focus bead images, set the
focus range manually (see “Manually find the focus range” on page 132).

Figure 36 Beads in focus.
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Start the WFA run

\g Note: Before starting the run, make sure the air filter at the back of the
instrument is not clogged with dust (see “Clean the air filter” on page 119).

1. Click Start Run.

2. If there is not enough room to store the data, the Start Run dialog appears (see
Figure 37). Choose the appropriate option (see Table 7).
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i\ There Is not enough free disk space to complete this nun and the cumently active nuns
An additional 3,74868 is required

| Start Anyway | |Dedete Images Cance

Figure 37 This Start Run dialog appears if there is not enough room to store data
for the run.

Table 7 Options for managing disk space

Option Description

Start Anyway Initiates the run. The instrument pauses itself when it runs
out of free disk space.

Delete Images* Launches Historical Runs page in SETS. Images and/or
results can be deleted through SETS.

Cancel Aborts the run.

1 For more information on creating more available disk space, refer to the Applied Biosystems SOLID™ 4
System SETS Software User Guide (PN 4448411).

@ IMPORTANT! Before deleting any images, ensure that data analysis from the
previous run is satisfactory and complete. For more information, refer to the
Applied Biosystems SOLiD™ 4 System SETS Sofiware User Guide (PN
4448411).
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3. After the run has been initiated, you can click the Run Log, Cycle Scans, and
Heat Map buttons located at the top of the appropriate flowcell panel to learn
more information about the current run (see Figure 38).

P62 - SOLID - 4.0 - User: lab_user

s Wizards  Window  Help
lab_user ==
_! st =R
Run Mamne: @solidﬂﬂfﬁ 20091222 WEA Run Mame: | wis | solidD0s2 20091222 WEs, 2
et @ e
W | Created by: lab_user Created by: lab_user
l!! Assign Fur !‘.4’ Edit Run @ Cled LT}‘ Run Logs [l Heat: Map vt A\ -II Aasion Run Lz? Edit Run & Clear LT}‘ Run Logs ﬂ Heat: Map
Sample Slide Sample Slide
e 3 Samples -in- 4_spot_WFA_mask_sf 1 Sample -in- 4_spot_Y
: Runs
Al Details
A1
Az
Protocol Protocol
i BOLID_WFA [F3] 1 bases i BOLID_WFA [F3]
Pre-Scan | ] Pre-Scan |
Fa | | F3 |

64

Figure 38 How to learn more about the current run.

(1) IMPORTANT! Do not disturb the SOLiD™ 4 Analyzer while in operation and do
not open the flowcell during a pause in the run. Significant perturbations (for
example, opening system parts, vibrations) during the run is detrimental to the

results.
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Monitor the WFA run

\Q Note: To monitor the run remotely, use SETS from any computer to connect to
the networked instrument [refer to the Applied Biosystems SOLiD™ 4 System
SETS Software User Guide (PN 4448411)]. If desired, set up e-mail notification
regarding the instrument run and system information using SETS (refer to the
Applied Biosystems SOLiD™ 4 System SETS Sofiware User Guide).

View the run log 1. Click Run Log located at the top right corner of the flowcell panel. A dialog box
opens, describing a series of instrument events.
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2. After you finish viewing the Run Log, click Close, located at the bottom of the
Run Log window.

View the heat maps 1. To view the heat map showing bead densities found in the focal map images, click
Heat Map located at the top right-hand corner of the flowcell panel (see Figure 38
on page 64).

2. Look for:

* Uniform deposition of beads on the slide.

» The actual average bead deposition density/panel value being similar in value
to the targeted average bead deposition density/panel of 25,000 beads/panel
for WFA run. A large number of missing panels could indicate a deposition
problem.

E Note: The heat map may not immediately be available after the completion
of the Prescan. The software must process all the images collected during
the Prescan before the heat map is available. This process may take up to
30 minutes, depending on the number of panels imaged.

3. After you finish viewing the Heat Map, click Close located at the bottom of the
Heat Map window.

View cycle scans 1. Select the appropriate flowcell (Flow Cell 1 or Flow Cell 2) in the Cycle Scan
menu on the task bar on the left.

\Q Note: Details regarding which parameters to monitor are described in the
sequencing run section (see “Monitor the run” on page 95).
2. Click the heat map link to view the heat map for that cycle (see Figure 62 on
page 99).

3. Left-click any square panel on the heat map to open the panel browser window.
The panel browser allows you to view the focal map and the image for each
fluorescent dye signal (see Figure 63 on page 100).
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4. After you finish viewing the Cycle Scans, close the Cycle Scans window.

\g Note: If the WFA run appears problematic, you can: (1) Allow the run to
continue and troubleshoot after the run or (2) Pause the run and
troubleshoot. Consult an Applied Biosystems SOLiD"™ Field Applications
Specialist.

View the WFA report

Generate the WFA  The WFA report is automatically generated and available in SETS when the WFA run

report  finishes (see Figure 39). Refer to the Applied Biosystems SOLiD™ 4 System SETS
Software User Guide (PN 4448411).

{2 Template Bead Titration and Selection Report for: solid0054_20090827_WFA_JPB215_217 - Windows Internet Explorer, EEX)
@:—: + [ hetpid110.1.1. 1/ dakafresuitsisolid0ns4fsoliaOs+ 20090327 WFA_JPER1S_217jacreportdefaul. him | [4s][x] [s IE2E
Fie Edit ‘View Favorites Tools Help

W i@Tsmu\ateBead Tiration and Selection Report Fors sl [_‘ v B v [heage s Gods -

Report Summary
Name: Template Bead Titration and Selection Report for: solid0054_20090827_WFA_JPB215_217
Date Created: Fri Aug 28 08:56:10 GMT-07:00 2009

Created By: corona

Report Results
wfaSample 1 JPB215 V\ﬂasamglé 2 JPB216

4 20000877 WA JFE2 15 217 wiasample_1_IFB213_F3_PL 01 V1.

wfaSample 3 JPB217

Soliu0054_ 70090827 WFA IPEZL5 217 iasample_3 IFB217_¥3_F1_01 W1 7

54_20000827 WA IPE21> 217 wiasample_t_IFEZ10_¥3_F1_01 Vit
5

% : R P e e o

P2_Rfu 191013 P2_Rfu 154872 P2_Rfu 146822

P2_Exp 135 P2_Exp 47 P2_Exp 51

P2_Gain [32 |P2_Gain 32 P2_Gain [32

P1# (median per panet) 44799 P1# (median per panel) 44113 IP1# (median per panei) 38490

P2# (median per panel) 35831 a 34282 IP23# median per panei) 31807

P2#/P 1# ratio 80% P2#/P1# ratio |78% P2#/P1# ratio 83%

N2S§ 9% |N28 11% N2§ 6% W

On Axis 68% |On Axis 65% On Axis 80%

Titration Metric 54% Titration Metric 50% Titration Metric 66% v
< j >
- 3@ e oo, -

Figure 39 One WFA report for a single 4-well slide displayed in SETS.

Determine the Determine which titration has the highest titration metric. This titration is the optimal
optimal titration titration point.
point

Determine the bead 1. Calculate the concentration of P2-positive beads using the formula below, where X
deposition density is the volume of templated beads used for the WFA sample (equivalent to 15

fora sequenc:zg million beads) and P2# is given by the WFA report:
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15 x 10° beads
# beads/uL (according to NanoDrop

X|JL = @)r

P2# beads/panel x 426 panels
XL

Y P2-positive beads/uL =

Example:

For a sample with a concentration of 500,000 beads/uL measured by NanoDrop® ND-1000,
where the WFA report indicates a P2# value of 20,000 beads/panel.

15 x 10° beads
500,000 beads/uL

Y P2-positive beads/pL = 20,000 beadsg)oa:eLI x 426 panels

XuL = = 30uL
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= 284,000 P2-positive beads/uL

2. Use the calculated concentration in place of the value determined by the
NanoDrop® ND-1000 Spectrophotometer for more accurate deposition densities
when preparing slides for sequencing. It is recommended that you use this
resulting calculated bead concentration to determine the volume of beads for
deposition.

3. Multiply that volume by 120% to calculate the volume of beads for deposition.

‘ﬁ Note: The 20% overage has been estimated empirically and is attributable
to bead loss during washing and bead deposition steps. The overage factor
may be adjusted by individual operators based on their experiences.

Desired # P2-positive beads to be deposited

Z L bead solution =
Y P2-positive beads/pL

Example:
For a sample with a concentration of 284,000 P2-positive beads/jL to be deposited in
one well of an 8-well SOLID™ Deposition Chamber at a density of 300,000 beads/panel.

56 million P2-positive beads
x 120%

Z L bead solution
284,000 P2-positive beads/pL

= 237 pL bead solution
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Section 3.2 Set up and perform a sequencing run

Materials and equipment required

See Appendix A on page 101 for a list of equipment, kits, and consumables necessary
to set up a sequencing run.

Workflow
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( Prepare and install slide(s) and reagents (Chapter 2) )
]
Create a sequencing run record Create a multiplex sequencing
run record
Fragment
Paired-end Multiplex fragment
Mate-pair Multiplex paired-end
( Detect the focus range )
( Start the sequencing run )
I
Control the run Monitor the run
Pause/resume run View the run log
Use the Run Control menu View the heat maps
Use image controls View cycle scans

Workflow overview Create a sequencing (non-multiplex) run record

A sequencing (non-multiplex) run record is created using the SOLiD™ Instrument
Control Software (ICS). Primary Analysis Settings and Secondary Analysis Settings
should be created prior to creating a sequencing run record using SETS [refer to the
Applied Biosystems SOLiD™ 4 System SETS Software User Guide (PN 4448411)].

Create a multiplex sequencing run record

A multiplex sequencing run record is created using the SOLiD™ Instrument Control
Software (ICS). At this step, barcodes are matched to libraries. The run record file can
be created using a spreadsheet program either on or off the instrument.

Primary Analysis Settings and Secondary Analysis Settings should be created prior to
creating a sequencing run record using SETS [refer to the Applied Biosystems SOLiD™
4 System SETS Software User Guide (PN 4448411)].
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Workflow

Detect the focus range

Two methods exist for determining the focus range: automatic and manual. You should
first attempt automatic range detection. If automatic detection fails, use the manual
mode.

Start the sequencing run

The run is started using the SOLiD™ Instrument Control Software. Before starting a
run, previous data should be removed to ensure maximum disk space for new results.
The instrument is limited to run 5 primers per flowcell. If you are performing a
sequencing run with multiple tags, the instrument automatically pauses and stays
paused until the reagents are replaced and the run is resumed.

Control the run

You can control how the SOLiD™ 4 System collects sequencing data with the SOLiD™
Instrument Control Software (ICS). With the ICS, you can repeat a primer to improve
the real-time primary analysis results or set an early pause point to change reagents on
your schedule. You can choose to turn off imaging of specific samples to collect only
the best sequencing data.

To control the ICS, use the Run Control drop-down menu. Use the Run Control menu
only if you understand clearly the series of fluidic and imaging steps in a run. Skipping
or repeating certain steps could lead to errors in the resulting data. For example, with
the ICS menus, you can repeat a ligation; however, you must first cleave the fluorescent
label from the ligation product.

Monitor the run

While executing a sequencing run, the instrument performs a Prescan. In a Prescan, all
of the beads are labeled and their positions on the slide are recorded to derive a focal
map followed by a single ligation cycle. The run can be monitored using the Run Log,
Heat Map, and Cycle Scans through the Instrument Control Software (ICS) or from the
SETS browser.

Each flowcell generates a separate Run Log that records high-level events, such as
fluidic modules and slide scanning. The start and stop times of these events and any
pauses or errors that occur during the run, are also recorded. The Run Log is
particularly useful in helping you anticipate and schedule reagent refills or
troubleshoot instrument errors.

Heat maps are generated from the analysis of the focal map images and analysis of
each ligation cycle. A heat map is a colorized display of a particular metric (bead
count, bead signal, or image signal) across all the panels for a run (for definitions of
the metrics, see the “Glossary” on page 199).

For each flowcell, the corresponding Cycle Scans window provides nearly real-time
feedback on initial data quality on a per-cycle basis.
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Create a sequencing (non-multiplex) run record

\g Note: For instructions to set up a multiplex sequencing run record, go to the
next section “Create a multiplex sequencing run record” on page 75.

There are two ways to create a sequencing run. The first method is to use the Run
wizard (see below). The second method is to import a .txt file that contains the run
definition (see “Set up a run by importing a Run Definition file” on page 127). It saves
time re-entering information of a repeated run. This file can be generated on an off-
instrument computer.
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1. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 40).

i s0lid0062 - SOLID - 4.0 - User: lab_user
File Tools ‘Wizards Window Help

Welcome: lab_user

Run Mame: @ Run M.

Created by: Create

'iD Assign Run |5 ? ’I‘D' 3 'GD A

Sample Slide Sam

. Create Runs E

{@ Manage Runs

EJ_E Flows Cell Details

[0 Flow Cell 1

Figure 40 Use the run wizard to create a sequencing run.

2. Complete the information in the Select Run Type and Mask pane (see Figure 41):

a. Select the type of run:
» If performing a fragment sequencing run, select Fragment
» If performing a mate-pair sequencing run, select Mate-Pair
+ If performing a paired-end sequencing run, select Paired-End

b. (Optional) Type a new run name.

. (Optional) Enter a description.

2]

. Ensure that the Run Protocol is set to SOLiD4.

(o}

e. Select Primer Set 1 and Primer Set 2.
» If performing a fragment sequencing run, leave F3 as Primer Set 1.
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+ If performing a mate-pair sequencing run, select R3 as Primer Set 1 and
F3 for Primer Set 2.

@ IMPORTANT! The R3 tag must be run first in a mate-pair
sequencing run. The reagent strips for the F3 tag do not contain
Focal Map reagents.

+ If performing a paired-end sequencing run, select F5-P2 as Primer Set 1
and F3 for Primer Set 2.

» [f performing a paired-end sequencing run on a library prepared using
the SOLiD™ Total RNA-Seq Kit, select F5-BC as Primer Set 1 and F3
for Primer Set 2.

f. Enter read lengths for Primer Set 1, and if used, 2. A typical read length for
the F3 and R3 tags is 35 to 50 bases. A typical read length for the F5-P2 tag
or F5-BC tag is 25 bases.

d. Select the appropriate mask to use.

h. Click Next.
Ay Note: Ifa message window appears during these steps, then continue

setting up run as indicated. If a message remains after all selections
have been made, correct the entries before clicking Next.
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SETUP > Create/Edit Run > Select Run Type and Mask 2]

The following pages will guide you through to set up a run. Required fields are noted with an asterisk ).

*Select type of run to create

() Fragment. () Mate-Pair (&) Paired-End O WFA

Create New Run

1. Select Run Type
and Mask [ Multiplexing

Anal Tdentify the run and enter a descriptian

R Narme: | solid0S4_20100203_PE

Descripkion:
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Assign a Primer Set and # of bases. Primers run in sequential order

*Select Run Protocal: |SOL\D4 R | Barcode and Sequencing with 5 primer walkaway,
Primer Set 1: [Fsp2 | |25 Bases vl
Primer Set 2: F3 EllsoEases B

*Select mask to use: | 1_spat_mask_sf g [ Preview

<pack [ Mext» ] Finsh |[ Cancel ]

| ing is Online Fluidics is Online | [45M of 207M | T

9:;;1‘ S8 [ 2R " Gl e ning.bmp - Paint B & PED % 4sepm

Figure 41 Complete the information in the Select Run Type and Mask pane.

3. Complete the information in the Specify Samples and Analysis pane (see
Figure 42):

a. Select the number of samples that will be used in the run. If a single sample
will be run in multiple spots of the same slide, it counts as only one sample.
Otherwise, the number of samples typically matches the number of spots on
the mask.

b. (Optional) Edit the Sample Name, Library, Analysis settings, and
Description.
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SETUP > Create/Edit Run > Specify Samples and Analysis

Select how many samples you need for this run. For Application, Primary and Secondary Analysis columns in a seguencing or multiplexing run, vou can click the column header and use cirl+C
remaining rows.

#
Create New Run How many samples will you need For your masks?

1. Select Run Type
and Mask Sample Mame Library Primary Analysis Application Secondary Analysis Deescription

2, Specify Samples Samplel defaultLibrary default primary w | <Optional: Type or Select> w | <Select settingsz w
and Analysis

To assign samples to spots, select a sample in the list and then click on spots to assign that sample to them,

Sample Mask - 1_spob_mask_sF Spots - Samplel

1. Samplel

Figure 42 Complete the information in the Specify Samples and Analysis pane.

4. Assign Samples to spots in the mask on the Specify Samples and Analysis pane. A
blue or white circle on the mask indicates that the numbered sample has been
assigned to a spot. Clicking on a white circle selects that spot, and clicking on a
blue circle un-assigns that spot. To assign a sample, select it from the Sample list,
then click on a spot with no sample assigned to it.

5. Click Finish to return to the Setup Task pane.

6. Choose either to assign run to a flowcell for immediate use or to an instrument
database to store for later use, then click OK.

7. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.
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Create a multiplex sequencing run record

\Q Note: For instructions to set up a sequencing (non-multiplex) run record, go to
the previous section “Create a sequencing (non-multiplex) run record” on
page 71.

There are two ways to create a multiplex sequencing run. The first method is to use the
Run wizard (see below). The second method is to import a Run Definition file created
offline (see “Set up a run by importing a Run Definition file” on page 127).

Q
=3
Y
o
=
(0}
=
w
w
0]
-
c
=
O
o
=)
=3
=
o
(W)
=}
(o}
<
o
=)
=
o
=

@ IMPORTANT! For all barcodes > Barcode 16, ten bases of barcode tag must be
read. While creating a multiplex sequencing run file on the System, the barcode
definition file for the 1-96 series already specifies ten bases of sequence. If at
least 1 library on the slide uses barcode 17 or higher, ten bases of barcode tag
will be read for all other libraries on the slide, even if they are on separate spots.

1. (Optional) If desired, modify the Barcode Error Correction Level. A Barcode
Error Correction Level is set at 0 mismatches by default. A Barcode Error
Correction Level of 1 mismatch increases the number of reads by about 10%, but
lower-quality sequencing reads are included in the data.

For information about how to modify the Barcode Error Correction Level, see
“Modify the Barcode Error Correction Level” on page 145.

2. Click Create Runs in the Setup task pane on the left menu pane of the ICS (see
Figure 43).
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s solid0062 - SOLID - 4.0 - User: lab_user

File Tools ‘Wizards ‘indow Help

Welcome: lab_user

Ruir Marme: ) Run Name: @
S |Created by: Created by

o] sssion Run [ £l Aun @ clear I RunLogs [ Heat s el ST | o i P it . P lear W Runlogs [ Heat Mag aad NN

Sample Slide Sample Slide

Hide Samples << Hide Samples <<

Protocol Protocol

Prime Buffer Line:
Chiller: 4.0¢
|Codling v ‘ ‘ | |
Lamp: 0 hrs on
E “ || MoRunDefined ¥ Run Control Mo Run Defined > Run Control [
e
g Load Floweel... 229 Load Flowcel. .,
B Start Run » Stark Run
Door: Closed-Locksd ] £A e il s i
7 Unlock Doors
Imagngls Orlne | Fluidics s Online || ) I | samoFzam ||

Figure 43 Use the run wizard to create a multiplex sequencing run.

3. Complete the information in the Select Run Type and Mask pane (see Figure 44):

a. Select the type of run:

» If sequencing only one end of the barcoded fragment library, select
Fragment.

» If sequencing both ends of the barcoded fragment library, select Paired-
End.

o

Ensure that the Multiplexing option is checked.

(Optional) Type a new run name.

a o

(Optional) Enter a description.
e. Ensure that the Run Protocol is set to SOLiD4 Multiplex.

f. Select BC for Primer Set 1. Enter the read length for the BC Primer
according to the barcodes used in the libraries:
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Barcodes used on the slide Set the read length to...(bases)
Barcodes 1 to 16 only 5
Barcodes 17 to 96 10

\Q Note: If you do not select the correct read length for the number of
barcodes specified in your run definition file, the SOLiD™ System
software will display an error. If at least 1 library on the slide uses
Barcode 17 or higher, ten bases of barcode tag should be read.
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d. Select Primer Set 2 (and Primer Set 3):
» If sequencing only one end of the barcoded fragment library, select F3
for Primer Set 2.

» If sequencing both ends of the barcoded fragment library, select F5-BC
for Primer Set 2 and F3 for Primer Set 3.

h. Enter read lengths for Primer Set 2, and if used, Primer Set 3. A typical read
length for the F3 tag is 35 to 50 bases. A typical read length for the F5-BC
tag is 25 bases.

\Q Note: For barcoded fragment libraries of short inserts such as small
RNA samples, consult your Field Applications Specialist for the
recommended sequencing reagents and read length.

i. Select the appropriate mask to use.

j- Click Next.
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r: lab_user

File Tools ‘Wizards Window Help

SETUP > Create/Edit Run > Select Run Type and Mask

The following pages will guide you through to set up a run. Required fields are noted with an asterisk

*Select type of run ko create

Create New Run
— () Fragment () Mate-Pair () Paired-End () WFA
i. Select Run Type

and Mask Mulkiplexing

les and
Identify the run and enter a description

*Run Mame: |snlidE|E|54_2E|1EIE|2E|3_PE_BC

Description:

Assign a Primer Set and # of bases, Primers run in sequential order

#Select Run Probocal: Swp{m ~ | Barcode and Sequencing with S primer wall
Prirner Set 1: BC % | |10 Bases w
[106es 9]
Primer Set 2; F5-BC v | |25 Bases |
Primer Set 3: |F3 T“W vl

Figure 44 Complete the information in the Select Run Type and Mask pane.

4. Complete the information in the Specify Samples and Analysis pane (see
Figure 45 on page 79):

a. Select the number of samples that will be used in the run. A sample consists
of a bead sample that may contain many barcoded libraries. A single sample
that will run in multiple spots on the same slide counts as only one sample;
otherwise, the number of samples typically matches the number of spots on
the mask.

b. Click the first sample name to select it. Change the sample name if desired.
After you select the sample, you are able to enter the names, primary
analysis, and description of libraries that are in the sample.
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File  Tools ‘izards  Window Help

SETUP > Create/Edit Run > Specify Samples and Analysis

Select how many samples you need for this run. For Application, Primary and Secondary Analysis columns in a sequencing or multiplexing run, you can click the
remaining rows.

1
*How many samples will you need For your mask? | 1 b

1. Select Run Type Samnple Name Primary Analysis Description
and Mask

Create New Run

becSample1 default primary L

2. Specify Samples
and Analysis

Please select a sample in the above table to define its librarigs, Create Barcode Library

Library Mame Application Secondary Analysis #Barcodes Tl
BC_samplel <Optional: Type or Select> w | <Select settings= w1l BCH
BC_sampls2 <Optional: Type or Select= w | <Select settings > w1 BCH
BC_sample3 <Optional: Type or Select= w | <Select settings= |1 BCH
BC_sampled <Optional: Type or Select = w | <Select settings= w1l BCH
BC_sampleS <Optional: Type or Select = w | <Select settings= w1l BCH
BC sampled <0ptional: Type or Select > w | =Select settings= w1 BCH

Figure 45 Complete the information in the Specify Samples and Analysis pane.

5. If performing a paired-end sequencing run, click Create New Library to begin
entering library information for that sample (see Figure 45).

For a barcode sample in a fragment sequencing run, select Barcoded Sample and
click Create New Library to begin entering library information for that sample
(see Figure 45).

@ IMPORTANT! Each barcoded sample requires at least one library.

If there are any non-barcoded fragment library samples to be sequenced on the
same slide as barcoded samples, select Non-barcoded Sample for that sample.

Ay Note: Non-barcoded samples cannot be sequenced on the same slide as
barcoded samples for paired-end sequencing runs.
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6. Enter information for the first library present in the sample (see Figure 46):
a. Enter the library name.

b. Select a Multiplexing Series.

i Create New Library

For each library present in a multiplexed sample, enter a Library Mame, select the Multiplexing Series used, and specify which Barcode(s) have
been added during that library's creation,

Library Name; |C0ntr0|_1| |

1) Select Multiplexing Series 2) Select Barcodes 3) Review selected barcodes For this library

B Kit Module 1-16 1 BC Kit Madule 1-16 (1)
Oz :

Fs3
4
s
s
.
s
(k]
1o
1
1z

More about the Selected Multiplexing Series O1s

Barcodes on DA and RMA libraries made with 014
SOLID Barcoding Kits: Module 1-16 (PN 4444836 Ots
and 4427046}, Use 5 bp sequencing reagents to
sequence these barcodes, 18

[ Save ] l Cancel

Figure 46 Enter the information for the libraries in the sample.

@ IMPORTANT! Be sure to select the correct Multiplexing Series for your run. You
can obtain additional information by selecting the Multiplexing Series and
looking at the lower left panel: More about the Selected Multiplexing Series.
If at least 1 library uses Barcode 17 or higher on the slide, you should select the
BC Kit Modules 1-96 option for each library on the slide.
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Table 8 Contents of the Multiplexing Series¥

Multiplexing Series

Contents

BC Kit Module 1-16

BC Kit Modules 1-96

Multiplexing Series A
(1-10)

16 barcodes in the SOLID™ Fragment Library Barcoding Kit Module
1-16 (PN 4444636) and SOLID™ Transcriptome Multiplexing Kit (PN
4427046)

96 barcodes in the SOLID™ Fragment Library Barcoding Kit 1-96
(PN 4449637), or 48 barcodes in the SOLID™ RNA Barcode Modules

10 barcodes that are in the SOLID™ Small RNA Expression Kit

Multiplexing Series B
(1-20)

20 barcodes that are supplied with the SOLID™ 3 System or
16 barcodes supplied with the SOLID™ 3 Plus System

Use the “Multiplexing Series B (1-20)” option with the SOLiD™
Transcriptome Multiplex Kit, which contains up to 16 barcodes

T For the latest information regarding Multiplexing Series and barcode kits, contact your Field Applications

Specialist.

7. Click the selection box for the barcode or barcodes assigned to the library.

8. Click Save when you have completed the information for the first library.

9. (Optional) Repeat step 5 to step 7 for all remaining libraries. The Libraries panel
of the Specify Samples and Analysis screen now shows information for all
libraries for a particular sample (see Figure 47).
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Tools Wizards Windaw  Hel

SETUP > Create/Edit Run > Specify Samples and Analysis

Select how many samples you need for this run. For Application, Primary and Secondary Analysis columns in a sequencing or multiplexing run, you can click the column header and use cirl+D for column fill down which will
remaining rows

*Hom many samples will you need For your mask?

1. Select Run Type sample Name | Primary Analysis ‘ Description | P
and Mask

Create New Run

besamplel default primar -
2. Specify Samples B [ primary ] |

and Analysis

Please select a sample in the sbovs table to define its liraries. || Create Barcode Library

Library Name Application Secondary Analysis #Barcodes Multiplexing Series GOptions

BC_sample1 <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sample2 <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sample3 <Optional: Type or Select> | <Select settings: w1 BC Kit Module 1-96 B X
BC_samplet <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sampleS <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sample <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sample? <Optional: Type or Select> | <Select settings> w1 BC Kit Module 1-96 B X
BC_samples <Optional: Type or Select> + | <Select settings: v|1 BC Kit Module 1-96 B X
BC_sampled <Optional: Type or Select> + | <Select settings> v|1 BC Kit Module 1-96 B X
Control_t <Optional: Type or Select> + | <Select settings> v|1 BC Kit Module 1-96 B X

To assign samples to spots, select a sample in the list and then dick on spots to assign that sample to them,

sample Mask - 1_spot_mask_sf Spots - beSamplel

1. besamplel

< Bac

Imaging is Online Fluidics is Onling

Figure 47 The Libraries panel shows information for all libraries.

@ IMPORTANT! Review the Selected Barcodes for each library to ensure that
they are correct, and be sure that the libraries are correctly assigned to the
sample. After a run is started, you cannot change the barcode or library
assignment.

10. Repeat step 5 to step 9 for all remaining samples.
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11. Assign samples to unassigned spots in the mask. White circles are unassigned, and
blue circles are assigned. To assign a sample:

a. Select it from the Sample list.
b. Click a white (unassigned) spot.

To remove a sample from an assigned (blue) spot, click the spot. The sample is
removed, and the spot turns white.

12. Once all of the samples have at least 1 library, click Finish and select Save to
Database.
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13. Click Manage Runs in the task pane on the left menu pane of the ICS (see
Figure 48).

i s0lid0062 - SOLID - 4.0 - User: lab_user
File Tools ‘Wizards Window Help

Run Mame: @ Rur Mz

Created by: Create

-iD #Assign Run | & [ sl g v 'GE} I

Sample Slide Sam

. Create Runs E

< (@ Manage Runs

E[ﬁ Flows Cell Details

Figure 48 Manage Runs.

14. (Optional) To complete the information in the run record using a separate
spreadsheet program, see “Set up a run by importing a Run Definition file” on
page 127.

15. Choose to assign the run to a flowcell for immediate use or to an instrument
database to store for later use, then click OK.

16. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.
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Detect the focus range

Ay Note: If automatic focus range detection fails, determine the focus range
manually (see “Manually find the focus range” on page 132).

1. Close the front doors of the SOLiD"™ 4 Analyzer. Open the Imager window by
choosing Windows » Imaging System.

2. Select Tools » Detect Focusing Range.

3. In the focusing range dialog, specify the stage template file by entering the name
directly or by clicking the Browse button to navigate to a suitable one (see
Figure 49). The stage template must match the slide in the target flowcell(s). If
you created a run from the ICS, then select the file imagingMap.STG from the
subdirectory in C:\Runs whose name matches the name of the run (for example, in
Figure 50, C:\Runs\Solid0327_20081209_2_Oct_Test\imagingMap.STG is
selected).

Ei Detect Focusing Range Q@@

Select Stage Template

| =] Bromss]

Flease select flowcel. [2 =]

Go | Cancel |
IDLE [

Figure 49 Detect Focusing Range dialog.

4. Select the flowcell using the drop-down menu, then press Go. The Imager works
for several minutes while it determines the range. The blue progress bar indicates
how close it is to completion (see Figure 50). You can also click Cancel so that the
Imager aborts the ranging operation.

Ei Detect Focusing Range B@@

Select Stage Template

| C:/Runs/salid0327_20081204_1x15_530uad_1/imagngMap.STG Lm‘
Flease select foweell: il |

| _Corcel |

Searching focusing range at [-22218, -24504) B

Figure 50 Detect Focusing Range Dialog while detection is in progress.

5. When the Imager is done, a dialog appears (see Figure 51). Click Yes if you want
to replace the values in the local settings file. Click No if you want the Imager to
discard the newly calculated focus range.
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[_i Focusing Range Detection

9P } The focus range For Floweell 2 is:
-
(660621, 6706210,
Do vou wank bo save these For this Flowecell?

L oves o]

Figure 51 Confirm that you want to replace the local settings file.
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6. Verify the validity of the newly calculated focus range by taking images at random
locations.

@ IMPORTANT! You should see images of beads, ensuring that the algorithm
was able to focus on the beads and not on other artifacts (see Figure 52). If
you do not see bead images or if you see out-of-focus bead images, set the
focus range manually (see “Manually find the focus range” on page 132).

Figure 52 Beads in focus.
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Start the sequencing run

\g Note: Before starting the run, make sure that the air filter at the back of the
instrument is not clogged with dust (see “Clean the air filter” on page 119).

1. Ensure that there is adequate disk space for images and results of the sequence run
(for the minimum needed disk space, see Table 9). To know the amount of disk
space that is available, click Manage Runs on the task pane.

Table 9 Minimum required disk space to store images and results

Minimum space needed Minimum space needed

Run Type Minimum space for Primary Analysis for Secondary Analysis

needed for images results (()s\;?gltjl;;sfasta, results (mapping/pairing)
Fragment (35 bp) 2.7TB 1.3TB <200 GB
Fragment (50 bp) 3.8TB 1.8TB <200 GB
Mate-paired (25/25 bp) 3.8TB 1.8TB <200 GB
Mate-paired (35/35 bp) 5.3TB 24TB <200 GB
Mate-paired (50/50 bp) 7.6 TB 3.3TB <200 GB
Paired-end (35/25 bp) 46TB 227TB <200 GB
Paired-end (50/25 bp) 5.7TB 2.7TB <200 GB
Multiplex fragment (35/5 bp) 3.1TB 1.5TB <200 GB
Multiplex fragment (35/10 bp) 3.4TB 1.7TB <200 GB
Multiplex fragment (50/5 bp) 42TB 21TB <200 GB
Multiplex fragment (50/10 bp) 4.6 TB 2.3TB <200 GB
Multiplex paired-end (35/25/5 bp) 46TB 247TB <200 GB
Multiplex paired-end (35/25/10 bp) 5.3TB 2.6TB <200 GB
Multiplex paired-end (50/25/5 bp) 6.1 TB 29TB <200 GB
Multiplex paired-end (50/25/10 bp) 6.5TB 3.1TB <200 GB

2. Click Start Run.

3. If there is not enough room to store the data for the run, then the Start Run dialog
box appears (see Figure 53). Choose the appropriate option (see Table 10).

;‘_\ There Is not enough free disk space to complete this nun and the cumently active nuns

An additional 3, 7488 IS requined

| Start Aryway | |Delete Images... Cance

Figure 53 This Start Run dialog appears if there is not enough room to store data
for the run.
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Table 10 Choose one of the three options to manage disk space

Option Description

Start Anyway Initiates the run. The instrument pauses itself when it runs
out of free disk space.

Delete Images* Launches Historical Runs page in SETS. Images and/or
results can be deleted through SETS

Cancel Aborts the run.

1 For more information on creating more available disk space, see the Applied Biosystems SOLID™ 4
System SETS Software User Guide (PN 4448411).
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@ IMPORTANT! Before deleting a image, ensure that data analysis from the
previous run is satisfactory and complete. For more information, refer to
the Applied Biosystems SOLiD"™ 4 System SETS Software User Guide (PN
4448411).

4. After the run has been initiated, you can click the Run Log and Heat Map buttons
located at the top of the appropriate flowcell panel to learn more information
about the current run (see Figure 54). You can also select the appropriate flowcell
in the Cycle Scans menu on the task bar on the left.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide 87



8 Chapter 3 Set Up, Control, and Monitor the Run
Start the sequencing run

solid0419 - SOLID - 4.0 - User: lab_user

File Tools ‘Wizards Window Help

Flow Cell 1 Running [
Run Name: @ solid1419 20100412 PE MCE7wta 1 g [Rorne
W |Created by: lab_user Created by:
-il fssign Run E{’ Edit Run ’ Claks LT}‘ Fun Logs U Heat: Map Y | hﬁ“\.'\‘ 'OE Assign Run ﬁ Edit B
Sample Slide Sample Slide
i_ﬁ(V Manage Runs
Eﬁ Flows Cell Details
2
& Details ~
Martie: MCF7 Il
Description
nu sl primaryAnalysisSetting default primary
et = Libraries/Secondary ...
[ Flow cell 2 Libratias i
= Sample Loading
Spot Mumnbers 1 o
Protocol Protocol
@ S0LID4 [Fa-BC] +[F3] 25+ 50 bases
Fre-sean [
F5-BC (I I I | W O [~ O ([ (]
Fa | !
ystem Status B
“i» FA&-BC - Primer D - Ligation 5
Prime Buffer Line: 3
Chiler: 4.0C Executing Scan Slide Filter 3 of 4 Panel 1503 of 2358
| ||
L 1 6589 hi O
AMPEEEENE "™ % 1| Pre-Scan, Primers A, B, C, D and E [f F&-BC] = RunCantral i | Mo Run Defined
=

Figure 54 How to learn more about the current run.

(1) IMPORTANT! Do not disturb the SOLiD™ 4 Analyzer while in operation and do
not open the flowcell during a pause in the run. Significant perturbations (for
example, opening system parts, vibrations) during the run is detrimental to the
results.
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Control the run

Pause/Resume Run \C Note: Special considerations need to be made when using the Pause
Run/Resume Run function in certain modules:

When the run has been paused in the middle of or at the end of the Scan Slide
module, and if the Scan Slide module of the same cycle needs to be repeated, it
is recommended that you resume the run starting from the Image Prep module.

Pausing the run is generally followed by automatic filling of the flowcell with
Storage Buffer. Resuming from the Image Prep module fills the flowcell with
Imaging Buffer again, which is required to perform the functions in the Scan
Slide module. You can resume from the Image Prep module using the Change
Run Progress Point command in the Run Control menu (see “Use the Run
Control menu” on page 92).
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Eleven modules contain a pre-mixing step for the next module:

* Prime/Ligate Mix

+ Ligate/Dark Ligate Mix

» Dark Ligate/Phosphatase Mix

* Cleave/Ligate Mix

* Prime/Bridge Ligate Mix

» Bridge Ligate/Phosphatase Mix

» Dark Ligate/Capper Enzyme Mix

* Cleave/RevPhosphatase Mix

» RevPhosphatase/Ligate Mix

+ RevPhosphatase/Bridge Ligate Mix
* Bridge Ligate/Capper Enzyme Mix

When you try to pause a run in the middle of the module, a dialog displays (see
Figure 55).
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i~ Pause Run

This module contains pre-mixing.
Select the type of pause to perform.

How do you want to pause the run?

Pause after current module completes v

Recommended pause. Pauses the run after the
current module completes. On resume of the run,
execution will begin with the next scheduled module.

| ok || cancel |

Figure 55 Pause Run dialog for pre-mixing module.

The default setting is to pause after the current module completes so that pre-mixing is
not interrupted. If you want to pause the run within a pre-mixing module, select Pause
anyway (see Figure 56).

i~ Pause Run

This module contains pre-mixing.
Selectthe type of pause to perform.

How do wou want to pause the run’?

|F‘ause anyway V-|

Pause after current module completes
Fauses the run afier abording the current module. Tn

resume of the run, resume ar remix script will be
executed prior to the execution of the current module.

[ o] 4 ][ Cancel

Figure 56 Pause Run dialog options for pre-mixing module.
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When you resume a run to use the pre-mixed reagents in the strip tube, a dialog box
displays (see Figure 57). While it is recommended to simply resume the run, the system
provides an option to remix the reagents by clicking Remix/Resume. In this case, the
previous pre-mixed reagent is delivered to the waste and a new reagent is mixed.

Resume - Remix/Resume

IUse the pre-mixed reagents as is.
(Recommended if pausing kime is < 1 hour.)
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{1 Remix/Resume
Waste the existing pre-mixed reagents and make a new mixed reagent.,

(Recommeded if pausing time is = 1 hour.)

Figure 57 The options to resume or remix/resume the run are available.

\Q Note: One reagent strip contains reagents enough for 10 cycles per primer.
Therefore, if the remix option is used, the cycle number which can be used with
the reagent strip is reduced.
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Use the Run 1. Click Run Control to display the Run Control menu (see Figure 58).
Control menu

‘Wizards ‘Window Help

AU Mama: %sohdmm 20100412 PE MCFFwta 1

Created by lab_user
ol assion pun [#EdtRun @ clar [l Runtogs [ HeatMap el ™ )

- sample Slide sample Slide
ns
gtails
= Details ~
. ||| |name MCF7 i
_ Description
primaryanalysisSetting default primary =
& Libraries/Secondary ...
_
1 .
Protocol Protocol
“i» BOLID4 [F5-BC] + [F3] 25+ 40 hases
pre-gean (I
Fs-BC [T ) O | [ [ [ ]
R
< F5-BC - PrimerD - Ligation 5
fas Executing Scan Slide Filter 3 of 4 Panel 1503 of 2358
- 1|
Cr
¥ Pre-Scan, Prirmers & B, C, D and E [0fF5-BC| ( ¥ Run Control . Mo Run Defined ( ¥ Run Control .

Run Marne:
Created by:

#ﬂnssign Run B Editrun @ clear

oo EANy WY

92

& Stark Run

2 Load Flowcell...
£ Clear Flowcell...

Figure 58 Click Run Control to display the Run Control menu for that flowcell.

Run Control commands

(1) IMPORTANT! Do not disturb the SOLiD™ 4 Analyzer while in operation and do
not open the flowcell during a pause in the run. Significant perturbations (for
example, opening system parts, vibrations) during the run is detrimental to the

results.
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Table 11 Run Control commands %
Command? Commar_ld is availat?Ie while the %

instrument is... %

Stop Run Running or paused g_%:
Reset Current Primer Paused within Primer Cycle %
Change Primer Schedule Paused Q
Set Early Pause Point Running or paused 5_**
Change Run Progress Point Paused g
T Certain commands have sub-menus that allow you to control every step in a run protocol. %
_%

Stop Run

The Stop Run command launches a Stop Run dialog box. Choose the appropriate
option in the dialog according to Table 12.

Table 12 Options available in the Stop Run dialog

Option Description
Abort Run Run aborts and analysis jobs are cancelled.
Set run as completed Run is set as completed. Secondary
analysis jobs start.

Change Primer Schedule

The Change Primer Schedule command allows you to choose a first and second primer,
in any order. Depending on how you set up the run, only primers from a selected primer
set are available in the sub-menu.

Set Early Pause Point

The Set Early Pause Point command allows you to define when the instrument pauses.
This command can be used to replenish reagents at a more convenient time than the
time defined by the software. Note that if the Change Run Progress Point command
(see below) is selected, any changes to the Early Pause Point resets to the default.

Change Run Progress Point

The Change Run Progress Point command allows you to back up or skip to any specific
point in the run. Ensure that you select points that are consistent with the progress of
the run.

Repeating primers can be performed by using the Change Run Progress Point
command, selecting a primer to repeat, resuming the run, and using the Set Early Pause
Point command to pause the run after the repeated primer has completed.
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Use imaging and
analysis controls
for specific spots

The Instrument Control Software (ICS) allows you to control imaging for individual
spots on a slide. With the controls, you can deposit fragment and mate-paired library
samples onto the same slide and turn off imaging of a spot. To access the imaging and
analysis controls, in the Sample Slide display of the ICS, right-click a sample name to
display options menu. These options are not available until the focal map (prescan) is
complete.

The options menu includes:

* Enabled
* Imaging Turned Off
* Spot discarded

Enabled

Enabled is the default setting and allows for both imaging and analysis of the spot.

Imaging Turned Off

Imaging Turned Off turns off imaging but allows analysis to complete.

Spot Discarded

Spot Discarded turns off both imaging and analysis. Spot Discarded can be used to
remove problematic samples from the software workflow. Use of Spot Discarded
updates the Sample Slide display according to the selection in Spot Discarded. Use of
Spot Discarded also affects subsequent cycles (see Figure 59).

Spot

iecarded

Figure 59 The Sample Slide display updates after using Imaging Turned Off or
Spot Discarded.
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Monitor the run

\Q Note: To monitor the run remotely, use SETS from any computer to connect to
the networked instrument (refer to the Applied Biosystems SOLiD™ 4 System
SETS Software User Guide [PN 4448411]). If desired, set up e-mail notification
regarding instrument run and system information using SETS (refer to the
Applied Biosystems SOLiD™ 4 System SETS Sofiware User Guide).

View the run log 1. Click Run Log located at the top right corner of the flowcell panel to open a
dialog box describing a series of instrument events.
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2. After you finish viewing the Run Log, click Close located at the bottom of the
Run Log window.

View the heat maps 1. To view the heat map showing bead densities found in the focal map images, click
Heat Map located at the top right corner of the flowcell panel (see Figure 60).

2. Look for:
» Uniform deposition of beads on the slide.
* The actual average bead deposition density/panel value being similar in value
to the targeted average bead deposition density (for example, 300,000
beads/panel). A large number of missing panels could indicate a deposition
problem.

A Note: The heat map is not available until after the completion of the

~first sequencing cycle. The software refines the focal map using
images collected during the first sequencing cycle and does not
display the heat map until after all of the images collected during both
the Prescan and cycle 1 have been processed. This may take up to 30
minutes depending on the number of panels that were imaged.

3. After you finish viewing the Heat Map, click Close located at the bottom of the
Heat Map window.
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Bead Count  Bead Signal  Image Signal

0 Bead Count  Bead Signal  Image Signal e Bead Count  Bead Signal Image Signal a
[ Fixed 5caig

] — = = -} ~ o w
- - = = =2 = = =
=] = =] = =] =

[ T

Ower Limit . Under Limit |

Close

Ower Limit . Under Limit | Orver Limit . Under Limit |

Close Close

Figure 60 Bead Count (left), Bead Signal (center), and Image Signal (right) heat
maps.

View cycle scans 1.

96

Select the appropriate flowcell (Flow Cell 1 or Flow Cell 2) in the Cycle Scan
menu on the task bar on the left.

The top section of the Cycle Scans window lists all the scans per ligation cycle for
the slide, and the bottom section shows scan information sorted by sample for the
scan selected in the top section. Use the parameters shown in Figure 61 to assess
the progress of the sequencing run (see Table 13).
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File | Tools ‘Wizards ‘Window Help

,““*: Ll Cclc Scans > Flow Cell 1 - solid0045_20100119_PE_BC108_1 0

=
ILID
P The Cycle Scan Reporting Panel presents scan data from the current run in tabular format. Click on any scan to display sample detals in the bottom panel. To view used scans exclusively, chec (]
/ . contral labeled 'Show Used Scans Only', below.  The format of bead counts and value bar scaling can be adjusted wia the controls labeled ‘Display Bead Counts' and 'Display Value Bar Scaling'. w
% . : : &
== -2 [ how Used Scans Cnly  Display Bead Counts as: | Average Beads Per Panel v Display Yalue Bar Scaling as: | Export Scans || Focal Heat Map =
s < o
= [
Em Scan Date Complete Used Panels | Failed Panels  Usable Beads Best Beads Best+Good Beads Bead Color Balance™® Effective Ex :O
- BC PA 01 V1 [ oo | O [TEgYR o | [ e e | 15 o
%, Create Runs BC PA 02 Y1  Jan 19, 2010 6:03 PM yes \# HeatMap 2358 237,362 143,850 o
B A BC PE 01 ¥1 Jan 20, 201012:11 PM yes & Heat Mar 2358 236,962 147,254 ,?,.
[ Manage Runs BC PB 02 ¥1  Jan 20, 20103:51 PM ves & HeatMap 2358 287,375 142,330 3
BC PC 01 ¥1 Jan 20, 20109:00 PM yes \# HeatMap 2358 236,477 145,119 5
BC PC 02 ¥1  Jan 21, 2010 12:40 AM yes & HeatMap 2358 236,843 136,526 167,867 s — — — (V)
M BC PD D1 ¥1 Jan 21, 2010 4:40 AM YEs W HeatMap 2356 237,058 140,680 164,034 [ m—— ] 15 =)
BC PD D2 V1 Jan 21, 20107:09 AM Wes U Heat Map 2358 61 (2%) 237,012 135,303 162,608 [ —— | 19 Q
E@ Flowe Cell Details Z
|
m Cycle Scan
uu Flow Cell 1
uu Flow Cell 2
< |
Sample data for scan [ BC PA 01 V1]
Sample Panels = Failed Panels  Usable Beads Best Beads Best+Good Beads Bead Color Balance® Effective Exposure Times {ms)*
besamplet 2358 59 (%) 236,556 149,060 178,748 S — —— 15 15 9 9 N2S P

Prime Buffer Line:

Chiller: 5.9 C

Lamp: 0 hrs on

Figure 61 Parameters available in the Cycle Scans window to assess the progress
of the sequencing run: 1 Failed panels; 2 Best + Good Beads / usable beads; 3a/3b
Effective exposure times; 4 Satay plots.
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Table 13 Cycle Scans window: Distinguish normal runs from problematic runs

Parameter

Normal run

Problematic run

(1) Failed panels (humber of
panels that failed image
alignment during color-
calling).

(2) The fraction of (Best +
good beads)/usable beads

(3a/3b) Effective exposure
times*

(4) Satay plots

In general, the number of failed panels
should be relatively small and consistent.

The fraction can vary depending on the
quality of the library, the efficiency of the
PCR, and the enrichment process.

As a guideline, the fraction is around 0.5 to
0.6 in the first ligation cycle of each primer
and drops to 0.2 to 0.3 in the last cycle.

Gradual increase from ligation cycles 1 to 5
or higher for each sequence primer.
Performance varies from slide to slide and as
a function of the age of the SOLID™ Light
Source.$

As a guideline, the effective exposure time is
typically 20 to 40 ms in the first ligation cycle
and increases to 100 to 300 ms in the tenth
cycle.

The first cycle of any primer should show a
relatively “clean” Satay plot, with most points
clustered on the four color axes and with
minimal fraction of the points clustered
around the origin.

The quality of the Satay plot typically
degrades gradually with each ligation cycle
for a single primer cycle, becoming more
“fuzzy” in the last cycle.

Run begins with extremely high number
of failed panels or dramatic increase in

any subsequent ligation cycle for each

sequencing primer.

A significant drop in the fraction of
good beads in the initial ligation cycles
would indicate a reason to pause the
run and to troubleshoot the
performance.

250 ms or greater in ligation cycle 1 or
when instrument times out when the
effective exposure time exceeds

500 ms. Long exposure times may
indicate replacement of the SOLID™
Light Source.$

An abnormal “fuzzy” Satay plot in the
first cycle is a reason to pause the run
and troubleshoot the performance.

T Exposure time is indicative of the signal intensity of the beads. The instrument uses an auto-exposure routine, on a per sample basis, to
maximize bead signal with minimal image saturation. Shorter exposure times are associated with efficient ligation of the fluorescent

probes.

§ You should replace the SOLID™ Light Source in the Applied Biosystems SOLID™ 4 Analyzer every 1500 hours of use. See Appendix B for

instructions.
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2. Click the heat map link to view the heat map for that cycle (see Figure 62).
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Figure 62 Click the heat map link to view the heat map for that cycle.

3. Left-double-click any square panel on the heat map to open the panel browser
window. The panel browser allows you to view the focal map and the image for
each fluorescent dye signal (see Figure 63).
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id0045_20100119_PE_BC_WTA_2 - BC_P3_01_V1 - 0152 - SOLID Panel Browser

File ‘%ew Options Help

DO EBA= AR aal 4> «»E

<

Images Layout

[Focamee  ~] | [Fam =l | Jovs |
apply [Tim ARG Bl
FOCALMAP Fam Y3
s0lid0045_20100119_PE, | solid0045_20100119_PE, | solid0045_20100113_PE_
01/19(10 13:46:54 01/20{10 14:46:43 01/20710 15:05:08
Min: 496, Max: 163383 Min: 0, Max: 255 Min: 1, Max: 255
TaR CYs
solid0045_20100119_PE, | soliddn45_20100119_PE.
01/20{10 15:20:42 01/20710 15:34:55
Min: 2, Max: 255 Min: 4, Max: 255

Figure 63 View the focal map and the image for each fluorescent dye signal.

4. After you finish viewing the Cycle Scans, close the Cycle Scans window.

\g Note: If the sequencing run appears problematic, you can: (1) Allow the
run to continue and troubleshoot after the run or (2) Pause the run and
troubleshoot. Consult an Applied Biosystems SOLiD™ System Field
Applications Specialist.
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Required Applied Table 14 Required Applied Biosystems reagent kits: WFA run
Biosystems reagent

kits Item (part number) Components Kit compc_)nent(s)
used in...
SOLID™ ToP Instrument Reset Buffer Sequencing and/or WFA
Buffer Kit (4452688) Glycerol

10X Instrument Buffer
Cleave Solution 1

Cleave 2.1 Kit (Cleave 2.1
Parts 1 and 2)

Storage Buffer
Imaging Buffer Kit (Imaging
Buffer Parts 1 and 2)

1X T4 Ligase Buffer Kit (1X
Ligase Buffer Parts 1 and 2)

Universal Buffer Kit
(Universal Buffer Parts 1

and 2)
SOLID™ XD Slide & Slide Prep Reagent Bead deposition
Deposition Kit v2 . .
(4456997)} 4 x 2 Sequencing Slides
Slide Deposition Buffer v2
(4456998)8
Slide Storage Buffer
SOLID™ ToP Workflow SOLiD™ ToP Workflow WFA
Analysis Reagents Analysis Reagents
(4453237)
SOLID™ Flowcell O-rings 10-pack of flowcell O-rings =~ Sequencing and/or WFA
(4398217)

T If this kit is not available, you can use the SOLID™ XD Slide & Deposition Kit (4448393).
§ If the SOLID™ XD Slide Deposition Buffer v2 (4456998) is not available, you can use SOLiD™ XD Slide
Deposition Buffer (4448388).
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Required Table 15 Required equipment: WFA run

equipment
Item* Source
SOLID™ 4 System Applied Biosystems PN 4452773 (110 V)
Applied Biosystems PN 4452774 (220 V)
SOLID™ 4 Analyzer Applied Biosystems PN 4452775

SOLID™ 3 Plus to SOLiID™4 Upgrade Kit
SOLID™ 3 to SOLID™4 Upgrade Kit

Applied Biosystems PN 4452784
Applied Biosystems PN 4452785

SOLID™ Light Source
SOLID™ Slide Storage Chamber

Applied Biosystems PN 4383441
Applied Biosystems PN 4406354

SOLID™ Deposition Chambers, 1-Well$

Applied Biosystems PN 4406352

SOLID™ Deposition Chambers, 4-Well$
SOLID™ Deposition Chambers, 8-Well$

Applied Biosystems PN 4406358
Applied Biosystems PN 4406359

SOLID™ Uninterruptible Power Supply (UPS)

SOLID™ Accessory Disk Drive
SOLID™ Bead Concentration Chart

Applied Biosystems PN 4397781 (SOLiD™
UPS North America)

Applied Biosystems PN 4393695 (220 V;
SOLID™ UPS International)

Applied Biosystems PN 4426101
Applied Biosystems PN 4415131

Covaris™ S2 System
(110 V for U.S. customers)

(220 V for international customers)
The system includes:

¢ Covaris™ S2 sonicator
¢ Latitude™ laptop from Dell
e MultiTemp lll Thermostatic Circulator

e (Covaris-2 series Machine Holder for (one)
1.5-mL microcentrifuge tube

e (Covaris-2 series Machine Holder for (one)
0.65-mL microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
13 mm x 65 mm tube

e Covaris-2 Series Machine Holder for (one)
microTUBE

e Covaris microTUBE Prep Station

e Covaris Water Tank Label Kit

e Covaris microTubes (1 pack of 25)

For system materials summary, refer to
“Covaris™ S2 System Materials Summary,”

Applied Biosystems SOLID™ 4 System Site
Preparation Guide.

6-Tube Magnetic Stand

Applied Biosystems PN 4387833 (110 V)
Applied Biosystems PN 4392718 (220 V)
or

Covaris

Applied Biosystems AM10055

Microcentrifuge 5417R, refrigerated, without | Eppendorf*
rotor 022621807 (120 V/60 Hz)
Eppendorft

022621840 (230 V/50 Hz)

Applied Biosystems SOLID™ 4 System Instrument Operation Guide
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Appendix A Required Materials
Set up and perform a workflow analysis (WFA) run

ltem# Source
FA-45-24-11, fixed-angle rotor, Eppendorf*
g:rzsl).ﬁfgmL, including aluminum lid, 022636006
NanoDrop® ND-1000 Spectrophotometer Thermo Scientific
(computer required) ND-1000
Tabletop Centrifuge (for 96-well plate) Major Laboratory Supplier (MLS)
Vortexer MLS
Picofuge MLS
Magnetic stirrer MLS
Refrigerator (4 °C) MLS
Freezer (— 20 °C) MLS
Pipettors, 20 pL MLS
Pipettors, 200 pyL MLS
Pipettors, 1000 pL MLS

1 Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

affect system performance.

§ The SOLID™ 4 Analyzer is shipped with 2 of each size SOLID™ Deposition Chambers and SOLID™ 4 Slide
Carriers. Two SOLID™ Slide Storage Chambers are provided for use with all chambers.
# Or equivalent but validation of the equipment for library preparation is required.

Table 16 Required consumables: WFA run

ltem#

Source

Nuclease-free Water

ABgene® 96 1.2-mL square-well storage
plates

Applied Biosystems AM9932
ABgene AB-1127

3-mm adhesive disks

Ethylene glycol

Grace Bio-Labs ST200
American Bioanalytical AB00455-01000

CF-1 Calibration Fluid Kit

Thermo Scientific CF-1

PR-1 Conditioning Kit$

Thermo Scientific PR-1

1.5-mL LoBind Tubes Eppendorf 022431021
Kimwipes® Major Laboratory Supplier (MLS)
Filtered pipettor tips MLS

T Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

affect system performance.

§ The NanoDrop® Conditioning Kit is useful for “reconditioning” the sample measurement pedestals to a
hydrophobic state if they become “unconditioned” (refer to the Nanodrop® user’s manual for more
information). The PR-1 kit consists of a container of specially formulated polishing compound and a

supply of convenient applicators.
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Appendix A Required Materials
Set up and perform a sequencing run

Set up and perform a sequencing run

Required Applied Table 17 Required Applied Biosystems reagent kits: Sequencing run (for part

Biosystems reagent

numbers of individual boxes, see Figure 23 on page 46).

kits
Item (part Components Kit component(s)
number) P used in...

SOLiD™ ToP SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35 Fragment
Sequencing Kit - " . e . sequencing up to
Frag. Lib., F3 Tag, SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35 35 pases
MM35 (4449352) SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35

SOLID™ Mixing Strip Tube with Zinc
SOLID™ ToP SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50 Fragment
Sequencing Kit — ™ . by . sequencing up to
Frag. Lib., F3 Tag, SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50 50 bases
MM50 (4449388) SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 50

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50

SOLID™ Mixing Strip Tube with Zinc
SOLID™ ToP Paired =~ SOLID™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM35 Paired-end
End Sequencing M . B . sequencing up to
Kit - Frag. Lib., SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35 35 bases for the
MM35/25 SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35 forward read and
(4452690) 25 bases for the

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — Frag. Lib., F5-P2 Tag, MM25

reverse read

SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag - Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag - Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer E Master Mix 25
SOLID™ Mixing Strip Tube
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Item (part

Appendix A Required Materials
Set up and perform a sequencing run

Kit component(s)

number) Components used in...
SOLID™ ToP Paired | SOLID™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM50 Paired-end
End Sequencing ~T™ . Dy . sequencing up to
Kit - Frag. Lib., SOLID ™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50 50 bases for the
MM50/25 SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50 forward read and
(4452693) 25 bases for the

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — Frag. Lib., F5-P2 Tag, MM25

reverse read

SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag - Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag - Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-P2 Tag — Primer E Master Mix 25

SOLID™ ToP Mate-
Paired Sequencing
Kit — M-P. Lib.,
MM35/35
(4452684)

SOLID™ Mixing Strip Tube

SOLID™ ToP Sequencing Kit — M-P. Lib., F3 Tag, MM35
SOLID™ ToP MP Lib Seq, F3 Tag — Primer A Master Mix 35
SOLID™ ToP MP Lib Seq, F3 Tag — Primer B Master Mix 35
SOLID™ ToP MP Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP MP Lib Seq, F3 Tag - Primer D Master Mix 35
SOLID™ ToP MP Lib Seq, F3 Tag — Primer E Master Mix 35
SOLID™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — M-P. Lib., R3 Tag, MM35
SOLID™ ToP MP Lib Seq, R3 Tag — Primer A Master Mix 35
SOLID™ ToP MP Lib Seq, R3 Tag — Primer B Master Mix 35
SOLID™ ToP MP Lib Seq, R3 Tag — Primer C Master Mix 35
SOLID™ ToP MP Lib Seq, R3 Tag — Primer D Master Mix 35
SOLID™ ToP MP Lib Seq, R3 Tag — Primer E Master Mix 35
SOLID™ Mixing Strip Tube with Zinc

Mate-pair
sequencing up to
35 bases for each
tag
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Appendix A Required Materials
Set up and perform a sequencing run

Item (part Kit component(s)
number) Components used in...
SOLiD™ ToP Mate- = SOLID™ ToP Sequencing Kit — M-P. Lib., F3 Tag, MM50 Mate-pair

Paired Sequencing
Kit — M-P. Lib.,
MM50/50
(4452685)

SOLiD™ ToP
Fragment BC
Sequencing Kit —
BC Frag Lib.,
MM35/5 (4452696)

SOLiD™ ToP
Fragment BC
Sequencing Kit —
BC Frag Lib.,
MM35/10
(4452698)

SOLID™ ToP MP Lib Seq, F3 Tag — Primer A Master Mix 50
SOLID™ ToP MP Lib Seq, F3 Tag — Primer B Master Mix 50
SOLID™ ToP MP Lib Seq, F3 Tag — Primer C Master Mix 50
SOLID™ ToP MP Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP MP Lib Seq, F3 Tag - Primer E Master Mix 50
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — M-P. Lib., R3 Tag, MM50
SOLID™ ToP MP Lib Seq, R3 Tag — Primer A Master Mix 50
SOLID™ ToP MP Lib Seq, R3 Tag — Primer B Master Mix 50
SOLID™ ToP MP Lib Seq, R3 Tag — Primer C Master Mix 50
SOLID™ ToP MP Lib Seq, R3 Tag - Primer D Master Mix 50
SOLID™ ToP MP Lib Seq, R3 Tag — Primer E Master Mix 50
SOLID™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit - Frag. Lib., F3 Tag, MM35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35
SOLID™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM5
Reset Buffer

SOLiID™ ToP Sequencing Kit - Frag. Lib., F3 Tag, MM35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM10
Reset Buffer

sequencing up to
50 bases for each
tag

Multiplex
sequencing up to
35 bases for the F3
tag of barcoded
fragment libraries
(Barcodes 1 to 16)

Multiplex
sequencing up to
35 bases for the F3
tag of barcoded
fragment libraries
(Barcodes 1 to 96)
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Item (part

Appendix A Required Materials
Set up and perform a sequencing run

Kit component(s)

number) Components used in...
SOLiD™ ToP SOLID™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM50 Multiplex
Fragment BC ~T™ . e . sequencing up to
Sequencing Kit - SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50 50 bases for the F3

BC Frag Lib.,
MM50/5 (4452697)

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM5
Reset Buffer

tag of barcoded
fragment libraries
(Barcodes 1 to 16)

SOLiD™ ToP
Fragment BC
Sequencing Kit —

SOLID™ ToP Sequencing Kit - Frag. Lib., F3 Tag, MM50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50

Multiplex
sequencing up to
50 bases for the F3

BC Frag Lib., SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50 tag of barcoded
?jﬂgggg SOLID™ ToP Frag Lib Seq, F3 Tag - Primer C Master Mix 50 Igfr?;;;sl,i?r?gg%)
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50
SOLID™ Mixing Strip Tube with Zinc
SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM10
Reset Buffer
SOLID™ ToP Paired | SOLID™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM35 Multiplex paired-

End Sequencing
Kit - BC Frag. Lib.,
MMB35/25/5
(4452691)

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35
SOLID™ Mixing Strip Tube with Zinc

end sequencing up
to 35 bases for the
F3 tag of barcoded
fragment libraries

(Barcodes 1 to 16)

SOLiD™ ToP Sequencing Kit - BC Frag. Lib., F5-BC Tag, MM25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer E Master Mix 25
SOLiD™ Mixing Strip Tube

SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM5
Reset Buffer
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Item (part
number)

Appendix A Required Materials
Set up and perform a sequencing run

Components

Kit component(s)
used in...

SOLiID™ ToP Paired
End Sequencing
Kit — BC Frag. Lib.,
MM35/25/10
(4452692)

SOLiD™ ToP Paired
End Sequencing
Kit — BC Frag. Lib.,
MM50/25/5
(4452694)

SOLiID™ ToP Sequencing Kit - Frag. Lib., F3 Tag, MM35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 35
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 35
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — BC Frag. Lib., F5-BC Tag, MM25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer E Master Mix 25
SOLID™ Mixing Strip Tube

SOLID™ ToP Sequencing Kit - BC Frag. Lib., BC Tag, MM10
Reset Buffer

SOLID™ ToP Sequencing Kit - Frag. Lib., F3 Tag, MM50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50
SOLID™ Mixing Strip Tube with Zinc

SOLiD™ ToP Sequencing Kit — BC Frag. Lib., F5-BC Tag, MM25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer E Master Mix 25
SOLID™ Mixing Strip Tube

SOLID™ ToP Sequencing Kit — BC Frag. Lib., BC Tag, MM5
Reset Buffer

Multiplex paired-
end sequencing up
to 35 bases for the
F3 tag of barcoded
fragment libraries
(Barcodes 1 to 96)

Multiplex paired-
end sequencing up
to 50 bases for the
F3 tag of barcoded
fragment libraries
(Barcodes 1 to 16)
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A Appendix A Required Materials
Set up and perform a sequencing run

Item (part Kit component(s)

number) Components used in...
SOLID™ ToP Paired | SOLID™ ToP Sequencing Kit — Frag. Lib., F3 Tag, MM50 Multiplex paired-
End Sequencing ~T™ . Dy . end sequencing up
Kit — BC Frag. Lib., SOLID™ ToP Frag Lib Seq, F3 Tag — Primer A Master Mix 50 to 50 bases for the
MM50/25/10 SOLID™ ToP Frag Lib Seq, F3 Tag — Primer B Master Mix 50 F3 tag of barcoded

(4452699) fragment libraries

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer C Master Mix 50 (Barcodes 1 to 96)

SOLID™ ToP Frag Lib Seq, F3 Tag — Primer D Master Mix 50
SOLID™ ToP Frag Lib Seq, F3 Tag — Primer E Master Mix 50
SOLiD™ Mixing Strip Tube with Zinc

SOLID™ ToP Sequencing Kit — BC Frag. Lib., F5-BC Tag, MM25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer A Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer B Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer C Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag - Primer D Master Mix 25
SOLID™ ToP Frag Lib Seq, F5-BC Tag — Primer E Master Mix 25
SOLID™ Mixing Strip Tube

SOLID™ ToP Sequencing Kit - BC Frag. Lib., BC Tag, MM10
Reset Buffer

SOLID™ ToP Reset Buffer Sequencing and/or

I}Q_strument Buffer Glycerol WFA
it (4452688)

10x Instrument Buffer

Cleave Solution 1

Cleave 2.1 Kit (Cleave 2.1 Parts 1 and 2)

Storage Buffer

Imaging Buffer Kit (Imaging Buffer Parts 1 and 2)

1x T4 Ligase Buffer Kit (Ligase Buffer Parts 1 and 2)

Universal Buffer Kit (Universal Buffer Parts 1 and 2)
SOLID™ Flowcell 10-pack of flowcell O-rings Sequencing and/or
O-rings WFA
(4398217)
SOLID™ XD Slide & | Slide Prep Reagent Bead deposition
ai%%sgig%q i 4 x 2 Sequencing Slides

Slide Deposition Buffer v2 (4456998)§

Slide Storage Buffer

Other components | SOLID™ Mixing Strip Tube with Zinc (4449506)
SOLID™ Mixing Strip Tube (4406595)

1 If this kit is not available, you can use the SOLID™ XD Slide & Deposition Kit (4448393).
§ If the SOLID™ XD Slide Deposition Buffer v2 (4456998) is not available, you can use SOLID™ XD Slide Deposition Buffer (4448388).
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Required Table 18

Appendix A Required Materials
Set up and perform a sequencing run

Required equipment: Sequencing run

equipment
ltem* Source
SOLID™ 4 System Applied Biosystems PN 4452773 (110 V)
Applied Biosystems PN 4452774 (220 V)
SOLID™ 4 Analyzer Applied Biosystems PN 4444317

SOLiID™ 3 Plus to SOLID™4 Upgrade Kit
SOLiD™ 3 to SOLiD™4 Upgrade Kit

Applied Biosystems PN 4452784
Applied Biosystems PN 4452785

SOLiID™ Light Source
SOLID™ Slide Storage Chamber
SOLID™ Deposition Chambers, 1-Well$

Applied Biosystems PN 4388441
Applied Biosystems PN 4406354
Applied Biosystems PN 4406352

SOLiD™ Deposition Chambers, 4-Well$
SOLiD™ Deposition Chambers, 8-Well
SOLiD™ 4 Slide Carriers$

Applied Biosystems PN 4406358
Applied Biosystems PN 4406359
Applied Biosystems PN 4453027

SOLID™ Uninterruptible Power Supply (UPS)

SOLiID™ Accessory Disk Drive

Applied Biosystems PN 4397781 (SOLID™ UPS North

America)

Applied Biosystems PN 4393695 (220 V; SOLiD™

UPS International)
Applied Biosystems PN 4426101

SOLiD™ Bead Concentration Chart

Applied Biosystems PN 4415131

Covaris™ S2 System
(110 V for U.S. customers)

(220 V for international customers)
The system includes:

e Covaris™ S2 sonicator
e Latitude™ laptop from Dell
e MultiTemp lll Thermostatic Circulator

e Covaris-2 series Machine Holder for (one) 1.5-mL
microcentrifuge tube

e Covaris-2 series Machine Holder for (one) 0.65-mL
microcentrifuge tube

e Covaris-2 series Machine Holder for (one)
13 mm x 65 mm tube

e Covaris-2 Series Machine Holder for (one) microTube

e Covaris microTube Prep Station

e Covaris Water Tank Label Kit

e Covaris microTubes (1 pack of 25)

For system materials summary, refer to “Covaris™ S2 System

Materials Summary,” Applied Biosystems SOLID™ 4 System Site
Preparation Guide.

Applied Biosystems PN 4387833 (110 V)
Applied Biosystems PN 4392718 (220 V)
or

Covaris

6-Tube Magnetic Stand

Microcentrifuge 5417R, refrigerated, without rotor

Applied Biosystems AM10055
Eppendorf# 022621807 (120 V/60 Hz)
Eppendorf* 022621840 (230 V/50 Hz)

FA-45-24-11, fixed-angle rotor,
24 x 1.5/2 mL, including aluminum lid, aerosol-tight

Eppendorf* 022636006

Applied Biosystems SOLID™ 4 System Instrument Operation Guide
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Appendix A Required Materials
Set up and perform a sequencing run

ltem# Source

NanoDrop® ND-1000 Spectrophotometer (computer required) Thermo Scientific ND-1000
Tabletop Centrifuge (for 96-well plate) Major Laboratory Supplier (MLS)
Vortexer MLS

Picofuge MLS

Magnetic stirrer MLS

Refrigerator (4 °C) MLS

Freezer (20 °C) MLS

Pipettors, 20 pL MLS

Pipettors, 200 L MLS

Pipettors, 1000 pL MLS

I Applied Biosystems has validated this protocol using this specific material. Substitution may adversely affect system performance.

§ The SOLID™ 4 Analyzer is shipped with 2 of each size SOLID™ Deposition Chambers and SOLID™ 4 Slide Carriers. Two SOLID™ Slide
Storage Chambers are provided for use with all chambers.

# Or equivalent but validation of the equipment for library preparation is required.
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Required Table 19 Required consumables: Sequencing run

consumables

ltem#

Source

Nuclease-free Water

ABgene® 96 1.2-mL square-well storage
plates

Applied Biosystems AM9932
ABgene AB-1127

3-mm adhesive disks
Ethylene glycol
CF-1 Calibration Fluid Kit

Grace Bio-Labs ST200
American Bioanalytical AB00455-01000
Thermo Scientific CF-1

PR-1 Conditioning Kit$

Thermo Scientific PR-1

1.5-mL LoBind Tubes Eppendorf 022431021
Kimwipes® Major Laboratory Supplier (MLS)
Filtered pipettor tips MLS

1 Applied Biosystems has validated this protocol using this specific material. Substitution may adversely

affect system performance.

§ The NanoDrop® Conditioning Kit is useful for “reconditioning” the sample measurement pedestals to a
hydrophobic state if they become “unconditioned” (refer to the Nanodrop® user’s manual for more
information). The PR-1 kit consists of a container of specially formulated polishing compound and a

supply of convenient applicators.
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Supplemental Procedures

This appendix covers:

B Clean the SOLiD™ Deposition Chamber using a sonicator . . ............. 114
B Clean the SOLiD™ Deposition Chamber using Extran 300 . .............. 116
B Clean the Instrument Bufferbottle . . ............ ... .. .. .. ... ..... 118
B Cleantheairfilter....... ... .. .. .. . .. 119
B Flushthe fluidiclines .. ...... ... ... . . 120
B Install the SOLiD™ System Flowcell O-ring .......................... 124
B Clean the reagent Strip COVET. . .. v\ v vttt e ee s 125
B Replace the SOLID™ Light Source. . ................................ 126
B Set up a run by importing a Run Definition file. .. ..................... 127
B Manually find the focusrange . ............. ... ... 132
B Shut down the SOLIiD™ 4 Analyzer . ................................ 144
B Reset the robot POSItION .. ... ..ovtvtn e 144
B Store theslideinaflowcell............ ... .. .. .. ... . ... 144
B Modify the Barcode Error Correction Level .......................... 145
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Appendix B Supplemental Procedures
Clean the SOLID™ Deposition Chamber using a sonicator

Clean the SOLID™ Deposition Chamber using a sonicator

114

Required
equipment

Required
consumables

Only users upgrading from a SOLiD™ 3 or SOLiD™ 3 Plus System need to clean the
SOLiD™ Deposition Chamber a day before slide deposition with a sonicator or with
Extran 300 (see “Clean the SOLiD™ Deposition Chamber using Extran 300” on

page 116). The cleaning procedure needs to be performed only once after upgrading to
the SOLiD™ 4 System.

Table 20 Required equipment: Clean the Deposition Chamber with a sonicator

Item Source
Sonicator? Branson Ultrasonics, Inc.
8510R-DTH
2-L beaker Major Laboratory Supplier (MLS)

1 Applied Biosystems has validated this protocol using this specific material. Substitution may adversely
affect system performance

Table 21 Required consumables: Clean the Deposition Chamber with a sonicator

Item Source
Bleach Major Laboratory Supplier (MLS)*
Deionized water MLS
Hot water MLS

1 Forthe SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant
precautions.

1. Thoroughly wipe the beaker and the inside of the sonicator with 10% bleach, then
fill the sonicator to the fill line with deionized water. Clean the sonicator and
replace the deionized water every week. Clean the beaker before use.

2. Set the sonicator temperature to 25 °C, then allow it to equilibrate before use.

3. Immediately after the SOLiD"™ Deposition Chamber assembly is disassembled,
thoroughly rinse the SOLiD™ Deposition Chamber with hot water to remove
residual buffers from previous deposition. Rinse the base of the chamber with
deionized water and allow it to dry overnight.

4. Degas the sonicator for 5 minutes before use.

5. Place the SOLiD"™ Deposition Chamber and SOLiD™ 4 or SOLiD™ Opti Slide
Carrier into the beaker. Place the beaker in the sonicator, then sonicate the
SOLiD™ Deposition Chamber and the SOLiD™ 4 or SOLiD™Opti Slide Carrier
for 10 minutes.
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6. After sonication, remove the SOLiD™ Deposition Chamber and SOLiD™ 4 or
SOLiD™ Opti Slide Carrier from the sonicator, then rinse the SOLiD™ Deposition
Chamber and SOLiD™ 4 or SOLiD™ Opti Slide Carrier thoroughly with
deionized water (3 to 5 minutes for each chamber). When rinsing the chamber, be
careful with the face and O-ring that come into contact with the slide.

IMPORTANT! Do not use abrasive chemicals or wipes, because they can
damage the chamber and gasket.

7. Dry the SOLiD™ Deposition Chamber and the SOLiD™ 4 or SOLiD™ Opti Slide
Carrier overnight or at 37 °C for 1 hour before use.
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Clean the SOLID™ Deposition Chamber using Extran 300

116

Required
equipment

Required
consumables

Only users upgrading from a SOLiD™ 3 or SOLiD™ 3 Plus System need to clean the
SOLiD™ Deposition Chamber a day before slide deposition with Extran 300 or with a
sonicator (see “Clean the SOLiD™ Deposition Chamber using a sonicator” on

page 114). The cleaning procedure needs to be performed only once after upgrading to
the SOLiD™ 4 System.

Table 22 Required equipment: Clean the Deposition Chamber with Extran 300

Item Source

Tub Major Laboratory Supplier (MLS)
Pipette or graduated cylinder MLS

Table 23 Required consumables: Clean the Deposition Chamber with Extran 300

Item Source
Extran 300 VWR
EM-EX0996-2
Deionized water Major Laboratory Supplier (MLS)*
Hot water MLS

1 Forthe SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant
precautions.

1. Prepare enough 1:1000 dilution of Extran 300 and deionized water to fill a large
tub suitable for washing SOLiD™ Deposition Chambers, leaving enough empty
volume in the tub for the addition of the SOLiD™ Deposition Chambers (for
example, 5 mL of Extran 300 in 4995 mL deionized water for a 7-L tub).

2. Immediately after the SOLiD™ Deposition Chamber assembly is disassembled,
thoroughly rinse the SOLiD™ Deposition Chamber assembly with hot water,
removing residual buffers from the previous deposition. Rinse the base of the
chamber with deionized water and allow it to dry overnight.

3. Place the SOLiD™ Deposition Chamber and SOLiD™ 4 or SOLiD"™ Opti Slide
Carrier into the tub to soak for 5 minutes.

4. Gently agitate the tub for 2 minutes. Be careful not to let the face of the SOLiD™
Deposition Chamber rub against the tub or other SOLiD™ Deposition Chambers.

5. Allow the SOLiD™ Deposition Chamber and SOLiD™ 4 or SOLiD™ Opti Slide
Carrier to soak for another 5 minutes.
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6. After the second soak, remove the SOLiD™ Deposition Chamber and SOLiD™ 4
or SOLiD™ Opti Slide Carrier from the tub and rinse thoroughly with deionized
water (3 to 5 minutes for each chamber). When rinsing the chamber, be careful
with the face and O-ring that come into contact with the slide.

IMPORTANT! Do not use abrasive chemicals or wipes, because they can
damage the chamber and gasket.

7. Dry the SOLiD™ Deposition Chamber and SOLiD™ 4 or SOLiD"™ Opti Slide
Carrier overnight before use.
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Clean the Instrument Buffer bottle

Required
equipment

Required
consumables

118

Regular cleaning of the Instrument Buffer bottle is required for every run. Failure to
clean the Instrument Buffer bottle regularly may allow microbial contaminants to
proliferate in the system.

If the level of Instrument Buffer in the Instrument Buffer bottle falls below the
recommended fill volume, do not add new Instrument Buffer to “top off” the Buffer
that has been standing in the Instrument Buffer bottle. Topping off can lead to
contamination.

Table 24 Required equipment: Clean the Instrument Buffer bottle

Item Source

Beaker or graduated cylinder Major Laboratory Supplier (MLS)

Bottle brush MLS

Table 25 Required consumables: Clean the Instrument Buffer bottle

Item Source
Deionized water Major Laboratory Supplier (MLS)*
Bleach MLS
Water MLS

1 Forthe SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant
precautions.

1. Rinse the Instrument Buffer bottle three times with approximately 1 L of
deionized water.

2. Inspect the Instrument Buffer bottle for visible signs of microbial contaminants.

3. If any contaminants are present, clean the Instrument Buffer bottle with bleach:

o

a. Pour approximately 500 mL of bleach into the Instrument Buffer bottle.
b.

Add approximately 500 mL of water to the bleach in the bottle.
Scrub the bottle with a bottle brush.
Rinse the bottle at least two times with water.

Rinse the bottle at least three more times with deionized water.
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Clean the air filter

Regular cleaning of the air filter is required once a month. Failure to clean the air filter
may cause the filter to clog with dust, which may lead to poor air flow and temperature
control for the flowcells. You should clean the filter in between runs (but not during
runs).

Required Table 26 Required consumables: Clean the air filter
consumables

Item Source

Kimwipes® wipers Major Laboratory Supplier (MLS)

1. At the back of the instrument, remove the plastic filter cover with the filter (see
Figure 64).

Figure 64 Remove the plastic filter cover.

2. Separate the plastic cover from the air filter (see Figure 65).

Figure 65 Separate the plastic cover (left) from the air filter (right).

3. Use a Kimwipes® wiper to wipe the filter clean. If the filter is heavily clogged,
rinse the filter under running water and dry thoroughly overnight.
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4. Reinstall the filter and plastic filter cover on the instrument.
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Flush the fluidic lines

120

Required
consumables

If the SOLiD™ 4 Analyzer is in continuous use, the fluidics system in the instrument
generally does not need much routine care beyond regular cleaning of the Instrument
Buffer bottle and flushing of the lines every three months. However, if the SOLiD™ 4
Analyzer will be sitting idle for more than two weeks, flush the fluidic system and
power off the instrument with the fluidic lines empty.

@ Note: The instrument flush procedure comprises two scripts. Each script takes
approximately 13 minutes to complete.

Table 27 Required consumables: Flush the fluidic lines

Item Source

Deionized water Major Laboratory Supplier (MLS)
Slides MLS

1. Open the Instrument Shutdown wizard by choosing Wizards » Instrument
Shutdown (Figure 66).

File Tools I Wizards | Window Help
Change Syringe...

nstrument Shutdown. .,

Figure 66 Open Instrument Shutdown Wizard.

2. In the Wizard’s introduction screen, click Next.
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In the System Wash screen, click Unlock Doors (Figure 67).

f~ Instrument Shutdown Wizard

System Wash

Faliow the steps to run the systematic wash scripts @

System Wash

The following steps guide the user in preparing the SOLID instrument for long-term
shutdown by systematic wash steps.

+| ¥

Run shutdown script with DI water
1. Unlock and open the doors.

2. Fill the deavel/Cleave2/Reset bottles with at least 30mL of DI H20,

3. Fil the Ligase Buffer/Phosphatase Buffer/Imaging Buffer bottles with at least
30mL of DI H20.

4. Fil the Instrument Buffer and the Storage Buffer bottles with 250mL of DI
H20.

5.  Load both flowcells with blank slides and carriers,

6. Lock the doors.

7. Run shutdown script.

Figure 67 Complete the actions in the first System Wash screen.

4.

Replace all of the bottles from the side of the instrument, the chiller block, and the
cabinet with rinsed-out bottles.

All bottles except the Instrument Buffer and Storage Buffer bottles should contain
at least 30 mL of deionized water. The Instrument Buffer and Storage Buffer
bottles. These two bottles require 250 mL.

Load a slide onto each of the flowcells. You can load used slides or 1-inch X 3-
inch standard microscope slides for this step.

Click Lock Doors.
Click Run Script to begin instrument flush.
@ Note: The script takes approximately 13 minutes to complete.

After the script has completed, click Next.
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Flush the fluidic lines

9. Inthe System Wash screen, click Unlock Doors and remove all of the bottles from
the side of the instrument, the chiller block, and the cabinet.

You will now perform a dry flush of the system (Figure 68).

i~ Instrument Shutdown Wizard
System wash
Followy the steps to run the systematic wash scripts @

System Wash

The following steps guide the user in preparing the SOLID instrument for long-term
shutdown by systematic wash steps.

+ ¥
Run shutdown script with air
1. Unlock and open the doors.
Doors UnLocked Successfully!

2. Remove all the bottles from the side of the instrument, the chiller block, and
the cabinet.

3. Lock the doors.

Doors Locked Successfully!

4, Re-run the script to run air through the lines,

Cancel

Figure 68 Complete the actions in the second System Wash screen.
10. To begin the dry instrument flush, click Run Script.
@ Note: This script takes approximately 13 minutes to complete.

11. Perform one of the following:

+ SOLiD™ 4 Analyzer in continuous use: If the SOLiD™ 4 Analyzer is in
continuous use and you are performing this flush every three months as
required for preventive maintenance, click Cancel (Figure 69). Do not shut
down the power to the Linux head node and compute nodes.

+ SOLiD™ 4 Analyzer idle for more than two weeks: If the SOLiD™ 4
Analyzer will not be used for more than two weeks, click ShutDown
(Figure 69). Close down the SOLiD™ Instrument Control Software and
power off the instrument.
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Appendix B Supplemental Procedures
Flush the fluidic lines

Shutdown Linux System

Vindovws

Linux head node

.

Compute node

Compute node

Compute node

Shutdown Linux System

1.

s

¥+

To power off Linux head node and compute nodes, press the
"ShutDown™ button.

Wait 30 sec for the systern to shutdown,

Verify whether the system is shutdown successfully by inspecting the light
indicator on the front panel.

If the light indicator is still on, please contact AB technical support.

=

Figure 69 Click Cancel if performing regular maintenance or ShutDown to power

off the instrument.
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Appendix B Supplemental Procedures
Install the SOLID™ System Flowcell O-ring

Install the SOLID™ System Flowcell O-ring

After each run, check the SOLiD™ System Flowcell O-ring for cuts and abrasions. If
you see any abnormalities, replace the O-ring. Inspect the O-ring groove for debris or
contamination. Clean the O-ring groove with water as needed.

Required Table 28 Required equipment: Install the SOLID™ Flowcell O-ring
equipment

Item Source

SOLiID™ System Flowcell O-ring, 10-pack Applied Biosystems
4398217

Procedure 1. Insert the O-ring into the groove on the flowcell so that the smooth side is on top
(see Figure 70).

2. Run your finger around the O-ring to make sure that there are no high spots.

Figure 70 Install the SOLID™ O-Ring on a flowcell.

124 Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Appendix B Supplemental Procedures
Clean the reagent strip cover

Clean the reagent strip cover

Inspect the top and bottom of the reagent strip covers after each run for splattered wet
or dry reagents. If you see reagent on a cover, clean the cover (see Table 31).

Required Table 29 Required equipment: Clean the reagent strip cover
equipment

Item Source

Pipette or graduated cylinder Major Laboratory Supplier (MLS)*
Scrub brush MLS

1 For the SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer.
Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant
precautions.

Required Table 30 Required consumables: Clean the reagent strip cover
consumables

Item Source
Extran 300 VWR
EM-EX0996-2
Kimwipes® wipers Major Laboratory Supplier (MLS)
Deionized water MLS
Cotton swabs MLS

Table 31 Clean the reagent strip cover according to location or amount of reagent
splatter

If you see... Then

Minor splashes Wipe the reagent strip cover with a Kimwipes® wiper. If the
reagents are dried, first wet the Kimwipes® wiper
moistened with deionized water or a dilution of Extran 300
wash detergent in deionized water.

Reagents in the holes of the Wipe the inside surfaces of the holes with a cotton swab. If
of the reagent strip cover the reagents are dried, first wet the cotton swab as
necessary with deionized water or a dilution of Extran 300
wash detergent in deionized water.

Large areas of dried reagents = Wash the covers in a dilution of Extran wash detergent (10
mL Extran 300 in 1 L of deionized water). If needed, use a
scrub brush.
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Replace the SOLID™ Light Source

WARNING! PHYSICAL INJURY HAZARD. Hot Surface. Surface of the
M\ sorip™ Light Source may be hot. Use care when working around the SOLiD"™
Light Source to avoid being burned.

Replace the SOLiD™ Light Source in the SOLiD™ 4 Analyzer every 1500 hours.

Required Table 32 Replace the SOLID™ Light Source
equipment

Item Source

SOLID™ Light Source Applied Biosystems
4388441

1. Unscrew the 4 screws retaining the light box access cover on the top of the
instrument.

2. Remove the cover to the light source from the housing.
3. Pull the light source straight up and out of the unit.

4. Slide anew SOLiD™ Light Source into place. Ensure that the light source is
oriented in the correct direction (see Figure 71).

5. Refit and screw down the access cover on the housing.

6. Inthe System Status menu on the ICS, click Reset to reset the lamp timer.

Figure 71  Orientation of the SOLID™ Light Source.
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Set up a run by importing a Run Definition file

A sequencing run can be set up by importing a Run Definition file that has been
created offline. Setting up a run by importing a run definition file saves time re-
entering information of a repeated run.

1. Click Manage Runs in the task pane on the left menu pane of the ICS (see
Figure 72).

id0062 - SO - 4.0 - User: lab_user
File  Tools tWizards  Window Help
Wwelcome: lab_user

Run Mame: Rur Mz

Created by: @ Create

'*E Assign Run ﬁ Edit Bur ’ ey "3' B\ 'OE s

Se Sample Slide Sam

""‘i{.) Create Runs E

< iZ‘(‘ Manage Runs

Flows Cell Details

 ——
Figure 72 Manage Runs.

2. Click Export Run (see Figure 73).

lid0062 - SOLID - 4.0 - User: lab_user
File  Tools ‘izards  Window Help
Welcome: lab_user

D

Setup > Manage Runs

The SOLID Run Manager provides a summary view of recent run activity, and allows operators to load masks
selected in the grid, it can be addressed by the buttons in the toolbar below,

”
I\ Images Data Free Space 3?5468_: Results Data Free Space 901

F—-_‘. Impart Run |‘—~_‘.‘_ ort Run E? Edit Selected Run "I'E Assign ko Flowcell _'_F‘. Import Mask.

'56,) Create Runs Run Mame M‘ Run Creator Skatus Type
iz_(\: Manage Runs solid0062_20091217_FRAG_BC lab_user Mok Started Fragment (BC)
solidd062_Z0091217_PE_BC lab_user Mot Started Paired End {BC)

=

E[ﬁ Flow Cell Details

 ——
Figure 73 Export Run.
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3. Open the Run Definition file that you exported using scalc (see Figure 74). If
desired, you can use another spreadsheet program.

% My Documents

File Edit Wiew Favorites Tools

Help

_} Back (> Lﬁ /_) Search It Folders v

Address hﬂ MMy Documents

File and Folder Tasks

Iﬂ Rename this file

E& Movve khis file

fD Copy this file

& Publish this file to the Web
(20 E-mail this file

iga Print this file

¥ Delete this file

Other Places

@ Deskiop

|5) Shared Documents
i My Computer
\-‘4 My Metwork Places

v
Mame = Size | Tvpe Date Modifie
[C)LabYIEW Data File Folder S/6/2008 11;
@My TMusic File Folder 4/18/2008 6:
@My Pictures File Folder 2faf2009 92
() Updaters File Folder 8/10/2007 8:
1KE Text Document 12/16/2009 ¢
Open
Print
Edit
7-Zip b3 :
Open With 3 3 Matepad
Send To 3
3t swriker
S & Internet Explorer
. Sopy | 2 ‘WordPad

Create Shortout
Delete i
Rename

Choose Program. ..

Properties

Figure 74 Open the Run Definition file.

4. In the Text Importer window, empty the Text Delimiter box by clicking in the Text
Delimiter box and pressing the Backspace key to delete the quotation marks (see
Figure 75). Then click OK.

= Text Import - [solid0062_20091217_PE_BC.txt]
Irnport — =
Character set |Western Europe (Windows-1252/winLatin 1) ¥ |
From row 1 >
Separator options - :
O Fixed width
(%) Separated by
Tab [ comma [ other l:l
[ semicalan [ space
[ Merge delimiters Text delimiter | w |
Fields - %
¢ &
[ |Standard |Stanaard |standard - |standard |standard |
| 1 persion u_serId runType izMultiplexing runtlame =
|2 1.2 lab__user DPAIRED-END TRUE _solidDDSZ_ =
| 3 primerSec baselength
| 4 e 3 I
| 5 F5-EC 3
| 6 F3 50 |
e e e e e e e e e e
5] | =

Figure 75 Empty the Text Delimiter box.
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6. Select Tools » Autocorrect Options. In the Custom Quotes tab, uncheck the
Replace box in the Double Quotes section (see Figure 76). If this box is checked,
the file will not be imported correctly into ICS because directional quotation
marks will be used instead of non-directional (straight) quotation marks.

AutoCorrect

English (US8) |
| Replace | Exceptions | Options |Eust0m Quotes |

Single quotes
[ replace
Skart quote: E] Default
End quote: E] Default

Default
Double quotes - =
Skart quote: E] Default
End quote: E] Default

Default

[ D@K ] [ Cancel ] [ Help ] [ Reset ]

Figure 76 Uncheck Replace in the Double quotes section.

7. Finish entering the sample, library, and if applicable, barcode information using
the fill down function. You can access this function by selecting
Edit » Fill » Down. If you assign multiple barcodes to a single library, enter the
barcodes in quotes, separated by commas (see Figure 77).
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& solid0062_20091217_PE_BC.txt - OpenOffice.org Calc

File Edit Yiew Insert Format Tools Data Window Help

B-rEPH® | BER Y aG- B @MUl by RPEEQ O .
[l vl[w ¥ B 7 U ===¢=s % W == O-82-4A-

Kaz vl A E = |

a | B [ & | D | E | F | G |

1 [version userld runType ishultiplexing  runMNarme runDesc mask protocal
| 2 W2 lab_user PAIRED-END TRUE solid0062_20091217_PE_BC 4_spot_mask_sf  |20LID_PE_Multiplex
| 3 |primerSet baselength
| 4 |BC 5
| & |F&-BC 25
| 6 |F3 a0
| 7 |zampleMame sampleDesc spotAssignments primarySetting library application multiplexingSeries  barcodes
| & |bcEamplet 1 Barcade Thk Lib1 BC Kit Maodule 1-16 "1,2"
| @ |beSamplel 1 Barcade Thh LibZ BC Kit Maodule 1-168 "3,4"
| 10 |beSamplel 1 Barcode Thh Lib3 BC Kit Maodule 1-16 "5 5"
| 11 |bcEample2 2 Barcode 1MW Lik1 BC kit Maodule 1-16 1
| 12 |bcEample2 2 Barcode 1MW Lik2 BC Kit Maodule 1-16 2
| 13 |bcSample2 2 Barcode 1MW Lib3 BC Kit Maodule 1-16 3
| 14 |bcSample2 2 Barcode 1M Libd BC Kit Maodule 1-16 4
| 15 |bcSample2 2 Barcode 1MW LibkG BC Kit Madule 1-16 a
| 16 |bcSample2 2 Barcode 1MW LibG BC Kit Madule 1-16 g
| 17 |bcSample2 2 Barcode 1MW Lib7 BC Kit Madule 1-16 7
| 18 |bcSample2 2Barcode 1MW LibS BC kit Maodule 1-16 g
| 18 |bcSample2 2 Barcode 1MW LIk BC kit Maodule 1-16 9
| 20 |bcSample2 2 Barcode 1M Lik10 BC Kit Maodule 1-16 10
| 21 |bcEample2 2 Barcode 1MW Lik11 BC Kit Maodule 1-16 11
| 22 |bcSample2 2 Barcode 1M Lik12 BC Kit Maodule 1-16 12
| 23 |bcSample2 2 Barcode 1M Lik13 BC Kit Madule 1-16 13
| 24 |bcEample2 2 Barcode 1MW Lik14 BC Kit Madule 1-16 14
| 25 |bcSample2 2Barcode 1M Lik15 BC Kit Madule 1-16 14
| 26 |bcSample2 2 Barcode 1M Lik16 BC kit Maodule 1-16 16
| 27 |bcEample3 3 Barcode 1M Lik1 BC kit Maodule 1-168 "1"

Figure 77 Complete the sample, library, and barcode information.

IMPORTANT! Be sure to review each sample’s library and barcode
assignment before starting a run. After a run starts, you cannot change the
library or barcode assignment.

8. Save the file by selecting File » Save. Do not select “Save As,” because scalc does

130

not allow files to be saved as .txt files.

9. Click Keep Current Format.

10. In ICS, click Manage Runs.
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11. Click Import Run and select the run definition file you modified with scalc (see
Figure 78).

solid0062 - SOLID - 4.0 - User: lab_user

Setup > Manage Runs

The S0LID Run Manager provides a summary view of recent run activity, and allows operators to load masks, import and export sample sheets, as well @
selected in the grid, it can be addressed by the buttons in the toolbar below,

" ( images Data Free spare a7secol ] Rests Data Freo Spare oG
Expritk Run .E-‘_‘it Selzcked Run 'UIAssigr. o Flovcel g Tmport Mask,

‘*\') Create Runs Run Marne Run Creator Status Type TMask Protocol Sam
solidd062_20091217_PE_BC lab_user Mot Started Paired End {BC) 4_spot_mask_sf | SOLD_PE_Mult... | 4
?\’5 Manage Runs
solidd062_20091217_FRAG_BC lab_user Mot Started Fragment {BC) 1_spot_mask_sf | SOLID_PE_Mult... | 1
|m| i~ Please select a file to import the run definition
Flow Cell Detail —
] Flow cell Details Loak in: |[a My Documents .v| ZrEE
= () LabYIEW Data
4 Iy Music

My Recent @ My Pictures
Documents [ Updaters

= lid0062_20091217_PE_BC.kxt
[IE Flow cell 1 U - i

EI Flow Cell 2

(]
o
4
=
o
=l

My Documents

&

My Computer

£

File name: | | [ Open ]

Iy Metwork,

Flaces Files of bype: |Tab delimited data vy | Cancel

Prime Euffer Line:

Figure 78 Import the run definition file.

12. To assign a run previously saved to the database:
a. Click on Manage Runs in the task pane.
b. Click the run, then select Assign to Flowcell.
c. Choose a flowcell, then click OK.
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Manually find the focus range

You should first attempt automatic range detection (see “Detect the focus range” on
page 55). If automatic detection fails, then use the manual mode.

Select the flowcell, 1. Close the front doors of the SOLiD™ 4 Analyzer. Open the Imager window by
then find the beads choosing Window » Imaging System.
on the slide
2. Select the Show Flowcell box in the bottom left hand corner of the Imager
window, then choose the number of the flowcell to set (Flowcell 1 or Flowcell 2;
see Figure 79).

{78 SOLiD Imager 1.9.8.1

File View Run Options Devices Todls Windows Help

| LessesaD B

f Acquire | AutoE xpoze |
Camera SM: 266272 IP:  127.0.01 Por: 8031
Stage Status | Expozure Time: | 216 j Gain:ﬁa Binning: E
Part Stalus  Motion  Postion  Speed Acceleration B\tDapth:rB_ﬂ Saturate Rate: [0.01 [ GolLive Delault\)’iew‘ Clear All I Save fs ]
M- bS 8317.00 100 100 Shutter Status Focus Status—— Filter Status -~ Mosepiece Status
i -26633.00 100 100 | ﬁ COM1

Stage Control
7 Mudge Size: [500 5 Re-Calbrate Stage

GoTax [891 7 Update Stage Status
GioTo': [28654 T el
‘ Stop ’ ole Zoom In Flowcel
ira
v

zlick —_——— .
% Show FlonCal = Go Ta Fiduciary Mark

Figure 79 Click Show Flowcell to find the beads on the slide.

B come: B come | BB cowe
E5B6A3 \ T
GoToll &
Stop | Auto Focus
¥ Enable Jog

#
=
JUgSensilw\y[S & GoTofl =

3. From the View menu, choose Stage Template, then navigate to the C:\Runs
directory. Find the folder in the Runs directory that corresponds to the run just set
up, then choose the .STG file for the run. Choosing Stage Template and the .STG
file superimposes the slide layout on the Imager screen.

4. Use the mouse to drag the green-box cursor to a position on the upper-left side of

the slide. Dragging the green-box cursor moves the flowcell stage to that corner of
the slide (see Figure 80 on page 133).
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Figure 80 Use the mouse to drag the green-box cursor and to move the flowcell
stage the same way.

Find the focal range 1. Set the Filter Status to WL (white light; see Figure 81).
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Figure 81 Click WL (white light) to set the Filter Status.
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2. Inthe Imager window, click the AutoFocus button, then wait about 20 seconds for
the Imager to focus on the slide (see Figure 82). The Camera 1 indicator displays
BUSY while autofocus is running. When the Camera 1 indicator displays READY,
click AutoExpose, then wait for the Camera 1 indicator to show READY. Click
AutoFocus so that the Imager can focus again (this time with correct exposure
settings). Note where the focus peak falls in the focus range by looking at the
value that displays where the peak is located.

e SOUID Imager 1.9.10

Fle Vew Fun Optios Dewvices Took Windows Help

wsmnﬂ_ _—

] - -
o M| caie | ustooe |~
m.s» A P 127001 Fer HON ,....
Slage Slatur Ewmurm-En'
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Figure 82 Click AutoFocus and AutoExpose so that the focus peak falls in the
focus range.
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3. When the Imager displays READY, click the Acquire button, then examine the
image on the screen (see Figure 83).

Image in focus Image out of focus

Figure 83 Examine the image on the screen.

\; Note: To zoom on the image, double-left-click the mouse. To un-zoom,
double-right-click. To drag the image, hold down the left mouse button.

4. If the image is in focus, proceed to “Calculate, then set the focal range” on
page 139. If the image is out of focus, proceed to step 5.

5. Check the Go Live check box in the Imager window. By checking the Go Live
check box, a live image of the flowcell displays. You can use this image to
manually find the focal range (see Figure 84).
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o SOLID Imager 1.9.10

File Wiew Run Options Devices Tools 'Windows Heip

Camera SM: 25255 I° 127001 Pot 8060
Clage Slahuy

Esgomte Trner |32 5 Gane @wi‘r__-j-
Bt Depthc (2 =] Sohuate Rate: [00%, [ Golive

Pat Siehut  Moten  Posion  Spesd Acceleiston

o DolniView| Ciowsl | Sawnia |
cow N G TW® W Shutter Sshur “Foc Sizhm Fibes Ssh Hosepece Slaus
T N W e B oo Bl oo B coms Bl oo
Sisge Conisal 54143
ﬂ Hoadgm Size |10 1 RleCalbwste Slage

. [
. Galax [T T E| T
ijﬂ.ﬂ ﬁ;;ﬂ‘lﬁ Zoom In Flovecel Sty | B Fosus !
ﬂ B e = G Too Ficucial Mk F Enstis Jog

Figure 84 Check Go Live to manually find the focal range.

6. Click the focus slider bar in the Imager window. A black box appears (see
Figure 85).
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Figure 85 Use the black box to change the focal distance.

7. When the black box is visible, hold down the Ctrl key and hold down either the
right or left arrow key on the keyboard. Holding down Ctrl and the arrow key
(right or left arrow) simultaneously changes the focal distance in 300-count
intervals.

8. While watching the live image on the screen, scan the focal distance:

* Use the Ctrltright arrow keys to scan the focal distance upward. When the
live image is in focus, release the keys, then record the value shown in the
black box of the Imager window.

» If an in-focus image cannot be found, then scan downward using the
Ctrl+left arrow keys, past the starting point, while watching the live image
on the screen. When the live image is in focus, release the keys, then record
the value shown in the black box of the Imager window.

The value in the black box of the imager window when the image is in focus is the
nominal Z distance.

For examples of in-focus images, see Figure 86.
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ank of heater block in focus - ﬂectitm of beads in focus

Figure 86 Examples of in-focus images.

9. Uncheck the Go Live check box in the Imager window to close the live-image
window.
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Calculate, then set 1. When the image is in focus, record the value of the Z distance in the Focus Status
the focal range pane. This is the nominal Z distance for this flowcell. Be sure to record the correct
Z distance value, not the value in the GoTo window (see Figure 87).
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Figure 87 Record the nominal Z distance.
2. Choose Options » Focusing.

3. Ensure that Do auto-exposure with auto-focus is checked. Enter a value 5000
less than the nominal Z distance for Z Min. Enter a value 5000 greater than the
nominal Z distance for Z Max. Enter 30 for the Number of Steps and choose
Histogram Range from the drop-down menu in the Focusing Method Selection
pane (see Figure 88).

IMPORTANT! Leave the Auto-Focus Options window open on the Desktop.
Do not click the Save to File button. Values entered in the Focusing box are
used by the Imager software even if the values are not saved.
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LM Auto-Focus Options E“E|E|

Focusz Settings

Outzide
Flowcell:

Z Mir: |E53102  |648830  |BR2503
£ Max: |BE3103  |B58830 |BEZ503

Fevert to| Fevertto| Revert to
Saved Saved Saved

Flaweel 1 Floweell 2

Saveto | Saveto | Saveto
File File File

Murmber of Steps: |30

[v Do auto-exposure with auto-focus

Focusing Method Selection

| Histogram Fange j

Figure 88 Enter auto-focus options.

4. Use the mouse to move the green box to the upper-left corner of the slide.

5. In the Imager window, click the Autofocus button, then wait about 20 seconds for
the Imager to focus on the slide. The Camera 1 indicator displays BUSY while the
autofocus is running. When the Camera 1 indicator displays READY, click
AutoExpose and wait for the Camera 1 indicator to display READY. Click
AutoFocus so that the Imager can focus again (this time with the correct exposure
settings).

6. When the Imager displays READY, click the Acquire button, then confirm that
the image is in focus.

7. Record the Z distance value from the Focus Status pane (see Figure 89).
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Figure 89 Record the Z distance value.

8. Open Notepad, then record the measured focal value for the spot on the slide that
has been focussed.

9. Repeat steps 4 to 8 for the top right, bottom left, bottom right, and center of the
slide. The range of these values should not exceed 5000 units. Calculate the
average value of the highest and lowest spots and record this value in Notepad (see
Figure 90).

IMPORTANT! If the range of these values exceeds 5000 units, the flowcell
is out of alignment. Call your Applied Biosystems Field Service Engineer
to align the flowcell.
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[P untitled - Notepad
File Edit

Farrnak

Yiew Help

653830
853930
548700
6459250
651550

highest = 653930
Towest = 648750
average of highest

set range +/- 5000

ki

range = 646360 - 536360

and Towest = G513460

M

Figure 90 Record the average focal value in Notepad.

10. Subtract 5000 counts from the calculated average, then enter that value in the Z
Min box. Add 5000 counts to the average, then enter that value into the Z Max
box. Confirm that the Number of Steps is 30. Click Save to File (see Figure 91).

M Auto-Focus Options

EEX

Focuz Settings
Flowcel 1 Flowcel 2 Jutside
Flowcell:
£ Mir: |[BE3103  |B46360  |BR2503
Z Max |BE3103  |6BE36]  |RE2503
Rewvert to| Revertto| Revert to
Saved Saved Saved
Saveto | Saveto | Saveto
File Filz Filz
MHurnber of Steps: |30
v Do auto-esposure with auto-focus
Focuzing Method Selection
| Hiztogram Range j

Figure 91

Enter the focus settings.

11. Click Yes when the warning displays (see Figure 92).
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v Confirm Save Focus Range E|

2 )  5ave Z min and max for Flowcell 2 to file?

T | T T

Figure 92 Click Yes when the Save Focus Range Warning displays.

12. When the Flowcell Selection window appears, choose the number of the flowcell
(1 or 2) that has just been measured and click OK. The focal range is saved.

13. (Optional) Repeat all previous steps starting from “Select the flowcell, then find
the beads on the slide” on page 132.
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Shut down the SOLID™ 4 Analyzer

The instrument can be shut down using the Instrument Shutdown wizard in the ICS.
For instruments that have UPS, in the event of power failure, an uninterrupted power
supply (UPS) is activated, UPS systematically shuts down the instrument: Analysis
jobs are stopped and Linux is shut down. Slides are preserved in Storage Buffer.

Required Table 33 Required equipment: Shut down the instrument
equipment

Item Source

UPS Applied Biosystems 4397781 (North America)
4393695 (International)

1. Open the Instrument Shutdown wizard by choosing Wizards » Instrument
Shutdown.

2. Follow the instructions in the wizard.

Reset the robot position

The Robot standby script sends the robot back to home position.
1. Open the Utility Scripts menu by choosing Tools » Utility Scripts.
2. Select Robot standby.

3. Select Run Script.

Store the slide in a flowcell

The Store flowcell script fills the flowcell with Storage Buffer.
1. Open the Utility Scripts menu by choosing Tools » Utility Scripts.
2. Select Store flowcell.

3. Select Run Script.
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Modify the Barcode Error Correction Level

A Barcode Error Correction Level is set at 0 mismatches by default. A Barcode Error
Correction Level of 1 mismatch increases the number of reads by about 10%, but
lower-quality sequencing reads are included in the data.

To modify the Barcode Error Correction Level:
1. In SETS, log in as the Administrator.
2. Select Analysis » Primary Analysis Settings » New.

3. In the Barcode Error Correction Level drop-down list, select 0 or 1 (see
Figure 93).

4. Save the primary analysis setting, then apply the setting to the multiplex
sequencing run when the run is created.

Primary Analysis Setting

Cwner Administrator
Name * |Barcode_1MM
Description

Minimum Calls m
Barcode Error Correction Kevel E1 v

Low and high threshaolds for traffic light parameters:

Figure 93 In Barcode Error Correction Level, select 0 or 1.
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C On-Instrument Reagent Volumes and
Reagent Strip Layouts

This appendix covers:

B Recommended fill volumes for on-instrument reagents. . .. .............. 148
Fragment sequencing (F3Tag) . ...... ...t 148
Paired-end sequencing (F5-BC/F5-P2Tag) ........................... 149
Mate-pair sequencing (F3/R3 Tags) .. ..., 149
Barcode sequencing (BCTag) ..ot 149
Workflow analysis (WFA). .. ... . e 150

B Reagent strip layouts. . . . ..ottt e 151
Fragment/paired-end sequencing, F3Tag ............................ 151
Mate-Pair sequencing, F3Tag ........... .. 0., 152
Mate-Pair sequencing, R3Tag . ........ .. ... ... 152
Paired-end sequencing, F5-P2 Tag . ......... ... ... ... ..., 153
Multiplex paired-end sequencing, F5-BCTag .. ....................... 153
Multiplex fragment/paired-end sequencing, BCTag .................... 154
Workflow analysis (WFA). .. ... ... e 154
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Appendix C On-Instrument Reagent Volumes and Reagent Strip Layouts

Recommended fill volumes for on-instrument reagents

Volumes of on- @ IMPORTANT! Verify that there is sufficient volume of Reset Buffer for each tag
instrument sequenced. The SOLiD"™ ToP Instrument Buffer contains sufficient Reset Buffer
reagents to reset two tags (see “On-Instrument Reagent Volumes and Reagent Strip
Layouts” on page 147). For multiplex sequencing, a bottle of Reset Buffer is
included with multiplex sequencing kits to account for sequencing the BC tag.

Table 34 Volumes of on-instrument reagents provided in the SOLID™ ToP
Instrument Buffer Kit

Volume (mL)

1 X Instrument Buffer* 8000
Cleave 1 Solution 350
Cleave 2.1 Solution* 350
Reset Buffer 170
Imaging Buffer* 250
Ligase Buffert 120
Universal Buffert 75

Storage Buffer 825

I Volumes shown are after preparation according to the instructions in “Install on-
instrument reagents” on page 32.

Fragment Table 35 Fill volumes for fragment sequencing (35 or 50 bp)
sequencing (F3

Tag) Volume (mL)
35 bp 50 bp
1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells
Instrument Buffer 2157 4125 2949 5710
Storage Buffer 343 587 423 748
Cleave 1 Solution 124 224 169 316
Cleave 2.1 Solution 124 224 169 316
Reset Buffer 91 164 91 164
Ligase Buffer 42 74 56 101
Universal Buffer 26 41 33 55
Imaging Buffer 82 142 107 191
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Paired-end Table 36 Fill volumes for paired-end sequencing (25 bp)
sequencing (F5-

BC/F5-P2 Tag) Volume (mL)
F5-P2 Tag F5-BC Tag
1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells
Instrument Buffer 1783 3378 1783 3378
Storage Buffer 398 698 398 698
Cleave 1 Solution 70 117 70 117
Cleave 2.1 Solution 70 117 70 117
Reset Buffer 91 164 91 164
Ligase Buffer 34 57 34 57
Universal Buffer 33 55 33 55
Imaging Buffer 66 109 66 109

Mate-pair Table 37 Fill volumes for mate-pair sequencing (25, 35, or 50 bp)
sequencing (F3/R3

Tags)
Volume per tag (mL)
25 bp 35 bp 50 bp

1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells s _g
=T
Instrument Buffer 1629 3069 2157 4125 2949 5710 % Y
o
Storage Buffer 289 480 343 587 423 748 3 i

=}
Cleave 1 Solution 93 163 124 224 169 316 % ®)
=}
Cleave 2.1 Solution 93 163 124 224 169 316 § =
o 94
Reset Buffer 91 164 91 164 91 164 2 c
w3
Ligase Buffer 33 55 42 74 56 101 =)
T =
Universal Buffer 21 32 26 41 33 55 b
S oo
Imaging Buffer 66 109 82 142 107 191 g ©
(731

Barcode Table 38 Fill volumes for barcode sequencing (5 or 10 bp)
sequencing (BC

Tag) Volume (mL)
5bp 10 bp
1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells
Instrument Buffer 638 1088 883 1577
Storage Buffer 189 279 227 356
Cleave 1 Solution 32 41 47 72
Cleave 2.1 Solution 32 41 47 72
Reset Buffer 91 164 91 164
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Volume (mL)
5bp 10 bp
1 Flowcell 2 Flowcells 1 Flowcell 2 Flowcells
Ligase Buffer 15 19 18 25
Universal Buffer 13 14 15 19
Imaging Buffer 33 43 41 59

Workflow analysis Table 39 Fill volumes for workflow analysis (WFA)

(WFA)
Volume (mL)
1 Flowcell 2 Flowcells
Instrument Buffer 294 400
Storage Buffer 116 134
Cleave 1 Solution 0 0
Cleave 2.1 Solution 0 0
Reset Buffer 43 67
Ligase Buffer 12 12
Universal Buffer 0 0
Imaging Buffer 26 30
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Reagent strip layouts
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Reagent strip layouts

Mate-Pair
sequencing, F3 Tag

D |
SOLiD™ Mixing Strip
Tube with Zinc
g

T O T e <A

“ ‘ , 7 7 MP Lib., F3 Tag,
: Primer E

;‘":

MP Lib., F3 Tag,
Primer D

-
7

MP Lib., F3 Tag,

) ) Primer A

Mate-Pair
sequencing, R3 Tag

SOLiD™ Mixing Strip
Tube with Zinc
&, S W )
T < .. < ,

X/ X/
Phosphatase [

.. b,
"W/;/’ 'l‘ujgy
L

MP Lib., R3 Tag,
Primer A
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Reagent strip layouts

Paired-end
sequencing,
F5-P2 Tag

D |
SOLiD™ Mixing
Strip Tube

capper Y Fop2 e W@ Frag Lib., F5-P2 Tag,

Enzyme ) Primer E Phosphatsss Primer E
N A

Capper Reverse Frag Lib., F5-P2 Tag,

Enzyme A Primer D Phosphiatess Primer D
A A

Capper F5-P2 Reverse Frag Lib., F5-P2 Tag,
Enzyme | Primer C Ehcsblizkes Primer C
Capper F5-P2 Reverse Reverse Reverse
Enzyme Primer B Probe A Probe B Phosphatase

LD A A /
Capper F5-P2 Reverse Reverse Y Focal Reverse
Enzyme | Primer A Probe A Probe B | Map Phosphatase

Multiplex paired-
end sequencing,
F5-BC Tag

>
5%
=

@
CBD:
o X
> O
2o
By

2
Q 3
o 94
D =
—~ C
» 3
S0
o =2
=

b g
S oo
O @
S o
=%

(ZI=1

Capper Reverse Reverse
Enzyme Probe A
Capper Reverse Reverse
Enzyme Probe A

Capper Reverse Reverse
Enzyme Probe A

Capper Reverse Reverse
Enzyme Probe A Probe B

Capper Reverse || Reverse Reverse BC Frag Lib., F5-BC
Enzyme Probe A Probe B Map Phosphatase Tag, Primer A
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Multiplex
fragment/paired-
end sequencing,

BC Tag

BC Frag Lib., BC Tag,
Bridge Probes

J/

BC Frag Lib., BC Tag,
Primers

BC Frag Lib., BC Tag,
Probes

BC BC BC BC BC
Primer A Primer B Primer C Primer D Primer E
/
Phosphatase Probe A Focal
y.

Workflow analysis
(WFA)

Probe A Focal SOLiD™ Workflow
Y Map Analysis Reagents
/
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This appendix covers:
B Times for individual processes . . ...t 156

B Times fOr entire PrOCESSES . . v v vt vt vttt et e e e e e e e e e 158
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Times for individual processes

Table 40 Times for individual processes

Process Estimated Time (h) Steps Estin;?its‘::i(r::)e per
Focal Map ~21t03 Reset
P2 Label —
Image
Sequencing Primers ~3to4 Reset ~3to4
ZFg/%C;nd Ligation Prime (1 cycle or 5 bp)
Ligate ~15t0 17
Dark Ligate (5 cycles or 25 bp)
Phosphatase ~18to0 22
(7 cycles or 35 bp)
Image ~2810 33
Cleave (10 cycles or 50 bp)
Sequencing Primers ~4t05 Reset ~4t05
3:’3‘17R8§)5 and Ligation Prime (1 cycle or 5 bp)
Bridge Probe ~16to 18
Ligate (5 cycles or 25 bp)
Dark Ligate ~19 1o 23
Phosphatase (7 cycles or 35 bp)
Image ~29 10 34
Cleave (10 cycles or 50 bp)
Ligation cycle without ~25t03 Ligate
priming (F3/R3) Dark Ligate e
Phosphatase
Image
Cleave
Sequencing Primers ~3.5 Reset ~15.5 10 21.5 (5 cycles
1 & 2 and Ligation Prime or 25 bp)
(F5-P2/F5-BC)
Ligate
Dark Ligate
Capper Enzyme
Image
Cleave
RevPhosphatase
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Estimated time per

Process Estimated Time (h) Steps primer (h)

Sequencing Primers ~4.5105.5 Reset ~16.5t0 21.5 (5 cycles
3, 4, & 5 and Ligation or 25 bp)

(F5-P2/F5-BC) Prime

Bridge Probe
Ligate

Dark Ligate
Capper Enzyme
Image

Cleave
RevPhosphatase

Ligation cycle without ~3to4 Ligate
priming (F5-P2/F5-BC) Dark Ligate L
Capper Enzyme
Image
Cleave

RevPhosphatase
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Appendix D Instrument Process Times
Times for entire processes

Times for entire processes

Table 41 Times for entire processes

158

Process Total Runtime#
Workflow Analysis (WFA) ~4 to 5 hours
Fragment (35 bp) ~4 1o 4.5 days
Fragment (50 bp) ~6 to 7 days
Mate-paired (25/25 bp) ~7 to 8 days
Mate-paired (35/35 bp) ~8 to 9 days
Mate-paired (50/50 bp) ~13 to 14 days
Paired-end (35/25 bp) ~8 to 9 days
Paired-end (50/25 bp) ~10 to 11.5 days
Multiplex fragment (35/5 bp) ~5to 5.5 days
Multiplex fragment (35/10 bp) ~6 to 6.5 days
Multiplex fragment (50/5 bp) ~7 to 8 days
Multiplex fragment (50/10 bp) ~8 to 9 days
Multiplex paired-end (35/25/5 bp) ~9 to 10 days

Multiplex paired-end (35/25/10 bp)
Multiplex paired-end (50/25/5 bp)
Multiplex paired-end (50/25/10 bp)

~10to 11 days
~11 to 12.5 days
~12 to 13.5 days

I The estimated time is for a dual slide run. Estimated times may vary due to differences in imaging time.
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Appendix E

SOLID™ 4 Analyzer Plumbing System

Schematic

CHEMISTRY CABINET
(SIDEWALL, UPPER LEFT)

\ CLEAVE SOLUTION 1
\‘\ TUBE ASSEMBLY

R P
N
UNIVERSAL BUFFER
TUBE ASSEMBLY \

\ LIGASI
TUBE ASSEMBLY
N

TUBE ASSEMBLY

/
y
/L
IMAGING BUFFER 2 7
. TUBE ASSEMBLY i
|
\ l

\ SPILL TRAY

12:1 SWITCHING

MANIFOLD W\I.Vj
o

N

\R

INSTRUMENT BUFFER
TUBE ASSEMBLY

BUFFER [

applied
4 bii)gsystems*

u SOLiD" 4 Analyzer

PLUMBING SYSTEM SCHEMATIC

PIN 4387534

CLEAVE SOLUTION 2
TUBE ASSEMBLY

FLOWCELLS
1&2

@ wstRument

WASTE BOTTLE
‘TUBE ASSEMBLY

.
5 N

mecmz\\\
TUBE ASSEMBLY

&) canray
TUBE ASSEMBLY

FLOWCELL WASTE BOTTLE
.\\ ‘TUBE ASSEMBLIES

MANIFOLD INSTRUMENT
& waste sorrLe
TUBE ASSEMBLY

T

SPLITTER ‘
VALVE

'STORAGE BUFFER
TUBE ASSEMBLY

8 ) BUFFER
" COMMON
TUBE ASSEMBLY

ROBOT
GANTRY

Il
UNIVERSAL

BUFFER 2

SPILL TRAY

WASTE T

;\\\

sg WASTE TUBE
COUPLER

WASTETUBE &
COUPLER (ENIEY

CHEMISTRY/WASTE SIDECART

Applied Biosystems SOLID™ 4 System Instrument Operation Guide

159

3
c
3
=5
>
«Q
(%2
<
(2}
L
(0]
3
»
Q
>
[v]
3
Q
(=p
(¢}

JezAleuy ¥, @MOS 3 xipuaddy




Appendix E SOLID™ 4 Analyzer Plumbing System Schematic
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Appendix F

I: Checklists and Workflow Tracking Forms

This appendix covers:

B Workflow checklists: set up a workflow analysis or sequencingrun .. ...... 162
B Workflow tracking: set up and perform a workflow analysis (WFA) run. . . .. 163
B Workflow tracking: set up a sequencing run (1-well).................... 164
B Workflow tracking: set up a sequencing run (4-well). . .................. 165
B Workflow tracking: set up a sequencing run (8-well).................... 166
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Workflow checklists: set up a workflow analysis or sequencing

run

162

Appendix F Checklists and Workflow Tracking Forms
Workflow checklists: set up a workflow analysis or sequencing run

Equipment Reagents Preparation Steps
O Covaris™ S2 System O 1XTEX Buffer
® O SOLID™ Bead O Deposition Buffer v2
g Concentration Chart O Double distilled filtered
3 O SOLID™ Deposition water
o Chamber O 1.5-mL LoBind Tubes —_
£ O SOLID™Slide Carrier O 3-mm adhesive disks
"§ O NanoDrop®ND-1000 O SOLD™ System
g O 6 Tube magnetic rack Sequencing Slide
a O Vortexer O Slide Prep Reagent
O Picofuge O Filtered pipettor tips
O Pipettors
O SOLID™4 Analyzer O 10x Instrument Buffer
O 8-Lreagent bottle O Storage Buffer
1] O Graduated cylinder O 1x T4 DNA Ligase Buffer
S O Magnetic stir bar (Parts 1 and 2)
2 O Pipettors O Universal Buffer (Parts 1
_ 9 and 2) _
R O Imaging Buffer (Parts 1
2 GE’ and 2)
E O Cleave Solution 1
a O Cleave Solution 2.1
‘T (Parts 1 and 2)
° O Reset Buffer
O Glycerol
O Double-distilled water
O SOLID™4 Analyzer O Deposition Buffer v2
=3 O Pipettors O Filtered pipettor tips
28 O Allen wrench O 70% ethanol _
£33 O SOLID™ Slide Storage O Kimwipes®
Chamber (optional) Slide Storage Buffer
O Tabletop centrifuge O 96-well square-well O Thaw appropriate reagent
= ‘é @ storage plate strip(s)
oL
£90%
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Appendix F Checklists and Workflow Tracking Forms F
Workflow tracking: set up and perform a workflow analysis (WFA) run

Workflow tracking: set up and perform a workflow analysis (WFA) run

Slide: Date:

Run: Date:

Sample Name

Sample information (pre-WFA)

AB00

Concentration
(beads/uL)
Deposition Volume
(pL)

WFA report

P2_rfu

P2_Exp

P2_Gain

P1#

P2#

P2#/P1# ratio

N2S

On Axis

Titration Metric

Sample information (post-WFA)

P2 Concentration
(beads/uL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer v2
Slide Prep Reagent
Instrument Buffer
Storage Buffer

T4 Ligase Buffer Part 1
T4 Ligase Buffer Part 2
Universal Buffer Part 1
Universal Buffer Part 2
Imaging Buffer Part 1
Imaging Buffer Part 2
Cleave Solution 1

Cleave Solution 2.1 Part 1
Cleave Solution 2.1 Part 2
Reset Buffer

Slide Storage Buffer

Workflow Analysis
Reagents
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Appendix F Checklists and Workflow Tracking Forms
Workflow tracking: set up a sequencing run (1-well)

Workflow tracking: set up a sequencing run (1-well)

164

Slide:

Date:

Run:

Date:

Sample Name

Sample information

AG00

Concentration
(beads/uL)

Deposition Volume
(W)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer v2

Slide Prep Reagent

Instrument Buffer

Storage Buffer

T4 Ligase Buffer Part 1

T4 Ligase Buffer Part 2

Universal Buffer Part 1

Universal Buffer Part 2

Imaging Buffer Part 1

Imaging Buffer Part 2

Cleave Solution 1

Cleave Solution 2.1 Part 1

Cleave Solution 2.1 Part 2

Reset Buffer

Slide Storage B uffer

F3 Tag Sequencing Kit

F3 — Primer A

F3 — Primer B

F3 — Primer C

F3 — Primer D

F3 — Primer E

F3 — Mixing Strip Tube

R3/F5-P2/F5-BC Tag
Sequencing Kit

R3/F5-P2/F5-BC - Primer A

R3/F5-P2/F5-BC — Primer B

R3/F5-P2/F5-BC — Primer C

R3/F5-P2/F5-BC — Primer D

R3/F5-P2/F5-BC — Primer E

R3/F5-P2/F5-BC - Mixing
Strip Tube

BC Tag Sequencing Kit

BC — Bridge Probes

BC - Primers

BC - Probes
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Appendix F Checklists and Workflow Tracking Forms F
Workflow tracking: set up a sequencing run (4-well)

Workflow tracking: set up a sequencing run (4-well)

Slide: Date:

Run: Date:

Samples 1 to 4

Sample Name

Sample information

AG00

Concentration
(beads/pl)
Deposition Volume
(pL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer v2

Slide Prep Reagent
Instrument Buffer

Storage Buffer

T4 Ligase Buffer Part 1

T4 Ligase Buffer Part 2
Universal Buffer Part 1
Universal Buffer Part 2
Imaging Buffer Part 1
Imaging Buffer Part 2
Cleave Solution 1

Cleave Solution 2.1 Part 1
Cleave Solution 2.1 Part 2
Reset Buffer

Slide Storage B uffer

F3 Tag Sequencing Kit

F3 — Primer A

F3 — Primer B

F3 — Primer C

F3 - Primer D

F3 — Primer E

F3 — Mixing Strip Tube
R3/F5-P2/F5-BC Tag
Sequencing Kit
R3/F5-P2/F5-BC — Primer A
R3/F5-P2/F5-BC — Primer B
R3/F5-P2/F5-BC — Primer C
R3/F5-P2/F5-BC — Primer D
R3/F5-P2/F5-BC — Primer E
R3/F5-P2/F5-BC - Mixing
Strip Tube

BC Tag Sequencing Kit

BC — Bridge Probes

BC — Primers

BC - Probes
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Appendix F Checklists and Workflow Tracking Forms

Workflow tracking: set up a sequencing run (8-well)

Workflow tracking: set up a sequencing run (8-well)

166

Slide:

Date:

Run:

Date:

Samples 1to 4

Sample Name

Sample Information

A600

Concentration (beads/pL)

Deposition Volume (L)

Volume Left

Beads Left

Samples 5to 8

Sample Name

Sample information

A600

Concentration (beads/pL)

Deposition Volume (uL)

Volume Left

Beads Left

Lot numbers

Slide

Deposition Buffer v2

Slide Prep Reagent

Instrument Buffer

Storage Buffer

T4 Ligase Buffer

Universal Buffer Part 1

Universal Buffer Part 2

Imaging Buffer Part 1

Imaging Buffer Part 2

Cleave Solution 1

Cleave Solution 2.1 Part 1

Cleave Solution 2.1 Part 2

Reset Buffer

Slide Storage B uffer

F3 Tag Sequencing Kit

F3 - Primer A

F3 - Primer B

F3 — Primer C

F3 - Primer D

F3 — Primer E

F3 — Mixing Strip Tube

R3/F5-P2/F5-BC Tag Sequencing

Kit

R3/F5-P2/F5-BC — Primer A

R3/F5-P2/F5-BC - Primer B

R3/F5-P2/F5-BC - Primer C

R3/F5-P2/F5-BC - Primer D

R3/F5-P2/F5-BC — Primer E

R3/F5-P2/F5-BC - Mixing Strip

Tube

BC Tag Sequencing Kit

BC — Bridge Probes

BC — Primers

BC - Probes
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Appendix G

The Covaris™" S2 System

This appendix covers:

B OPEration NOES . . o\ v vt et ettt et ettt e 168
Fillthetank. .. ... ... 168
Degasthe water. .. ...t 168
Setthechiller ...... ... ... 168
Perform required maintenance of the Covaris’ S2 System ............... 168

B Covaris™ S2 PrOgrams . ... ...........ouuemmie 168
CovalentDeclump 1 ... ... .. e 168
Covalent Declump 3 . ... .. i e 169
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G Appendix G The Covaris™ S2 System
Operation notes

Operation notes

Fill the tank  Fill the tank with fresh deionized water to the proper fill line. The water should cover

Degas the water

Set the chiller

Perform required
maintenance of the
Covaris™ S2
System

the visible part of the tube.

Degas the water for 30 minutes. To maintain degassed water, keep the pump
continuously on during operation and sample processing.

Set the chiller temperature to between 2 to 5 °C to ensure that the temperature reading
in the water bath displays 5 °C. The circulated water chiller should be supplemented

with 20% ethylene glycol.

The Covaris™ S2 System requires regular maintenance to work properly. Perform the
tasks in the table below (see Table 42):

Table 42 Required maintenance of the Covaris™ S2 System

Required maintenance task

Frequency to perform task

Degas water for 30 minutes prior to use

Before every use

Change water

Clean with bleach

Daily

Every two weeks

Covaris™ S2 Programs

Covalent

Declump 1

168

Table 43 Covalent Declump 1: 1 cycle Treatment 1 followed by 1 cycle

Treatment 2

Treatment 1 Treatment 2
Duty Cycle 2% 5%
Intensity 6 9
Cycles/Burst 100 100
Time 5 sec 30 sec
Target wattage power 4 15
performance estimate (W)*

I Not programmed.
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Covalent

Appendix G The Covaris™ S2 System

Covaris™ S2 Programs

Declump 3 Table 44 Covalent Declump 3: 3 cycles Treatment 1 followed by 1 cycle

Treatment 2

Treatment 1

Treatment 2

Duty Cycle 2% 5%
Intensity 6 9
Cycles/Burst 100 100
Time 5 sec 30 sec
Target wattage power 4 15

performance estimate (W)*

I Not programmed.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide
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G Appendix G The Covaris™ S2 System
Covaris™ S2 Programs
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Appendix H

Instrument Warranty Information

This appendix covers:

B Computer configuration . ..............vtitirntnrennnnennn.. 172
B Limited product warranty . . .. ........c.vrit et 172
B Warranty period effectivedate .. ............ ... ... .. .. .. .. .. ... 173
B Warranty claims .. ... i 173
B Warranty eXCePLIONS . . .. v\ v v vttt et ettt e e 173
B Warranty imitations . . .. ...ttt 174
B Damages, claims, and returns. . . ...ttt 175
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Appendix H Instrument Warranty Information
Computer configuration

Computer configuration

Applied Biosystems supplies or recommends certain configurations of computer
hardware, software, and peripherals for use with its instrumentation. Applied
Biosystems reserves the right to decline support for or impose extra charges for
supporting nonstandard computer configurations or components that have not been
supplied or recommended by Applied Biosystems. Applied Biosystems also reserves
the right to require that computer hardware and software be restored to the standard
configuration prior to providing service or technical support. For systems that have
built-in computers or processing units, installing unauthorized hardware or software
may void the Warranty or Service Plan.

Limited product warranty

172

Applied Biosystems warrants that all standard components of the SOLiD™ 4 Analyzer,
IKA® ULTRA-TURRAX® Tube Drive, the Covaris™ S2 System, APC UPS, and the
recirculating chiller will be free of defects in materials and workmanship for a period
of one (1) year from the date the warranty period begins. Applied Biosystems will
repair or replace, at its discretion, all defective components during this warranty
period. Applied Biosystems warrants the Genomic Solutions HydroShear® DNA
Shearing Device will be free of defects in materials and workmanship for a period of
one (1) year from the date the warranty period begins. Applied Biosystems will replace
a defective HydroShear® DNA Shearing Device during the warranty period. The
following parts of the HydroShear® DNA Shearing Device are use- replaceable and not
covered by the warranty on the HydroShear® DNA Shearing Device: shearing
assembly, syringes, syringe adapters, syringe shields, and output tubing. Applied
Biosystems reserves the right to use new, repaired, or refurbished instruments or
components for warranty and post-warranty service agreement replacements. Repair or
replacement of products or components that are under warranty does not extend the
original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its SOLiD™ 4
Analyzer such as peripherals, printers, and special monitors, will be free of defects in
materials and workmanship for a period of ninety (90) days from the date the warranty
begins. Applied Biosystems will repair or replace, at its discretion, defective
accessories during this warranty period. After this warranty period, Applied
Biosystems will pass on to the buyer, to the extent that it is permitted to do so, the
warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or
components used on or in the instrument are themselves warranted to be free of defects
in materials and workmanship for a period of ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be
free of defects in materials and workmanship when received by the buyer, but not
thereafter, unless otherwise specified in documentation accompanying the product.
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Appendix H Instrument Warranty Information I_l
Warranty period effective date

Applied Biosystems warrants that for a period of ninety (90) days from the date the
warranty period begins, the tapes, diskettes, or other media bearing the operating
software of the product, if any, will be free of defects in materials and workmanship
under normal use. If there is a defect in the media covered by the above warranty and
the media is returned to Applied Biosystems within the ninety (90) day warranty
period, Applied Biosystems will replace the defective media.

Unless indicated herein, Applied Biosystems makes no warranty whatsoever in regard
to products or parts furnished by third parties, including but not limited to the non-
APC- branded UPS or APC UPS, Covaris S2, Genomic Solutions HydroShear® DNA
Shearing Device, Recirculating Chiller, and IKA ULTRA-TURRAX purchased or
obtained from a third party. Such products or parts will be subject to the warranties, if
any, of their respective manufacturers to the extent they are ‘transferable or otherwise
available to Applied Biosystems' buyer.

Applied Biosystems at its sole discretion may refuse to provide buyer with support or
service for buyer's use of Covaris S2 in a method not described in a SOLiD™ System
protocol.

Applied Biosystems does not warrant that the operation of the instrument or its
operating software will be uninterrupted or be error-free.

Warranty period effective date

Any applicable warranty period under these sections begins on the earlier of the date of
installation or ninety (90) days from the date of shipment for hardware and software
installed by Applied Biosystems personnel. For all hardware and software installed by
the buyer or anyone other than Applied Biosystems, and for all other products, the
applicable warranty period begins the date the product is delivered to the buyer.

Warranty claims

Warranty claims must be made within the applicable warranty period, or, for chemicals
or other consumable products, within thirty (30) days after receipt by the buyer unless
otherwise specified in the documentation accompanying the product.

Warranty exceptions

uolBWIOU|

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation with incompatible solvents or samples
in the system; operation outside of the environmental or use specifications or not in
conformance with the instructions for the instrument system, software, or accessories;
improper or inadequate maintenance by the user; installation of software or interfacing,
or use in combination with software or products, not supplied or authorized by Applied
Biosystems; modification or repair of the product not authorized by Applied
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Appendix H Instrument Warranty Information

Warranty limitations

Biosystems; relocation or movement of the instrument by buyer or by any third party
not acting on behalf of Applied Biosystems; or intrusive activity, including without
limitation, computer viruses, hackers or other unauthorized interactions with
instrument or software that detrimentally affects normal operations.

Parts in contact with any liquid are considered wetted and may be deemed user-
replaceable and not be covered by the above warranties, including, but not limited to,
seals, filters, gaskets, shearing assemblies, valves, syringes, syringe adapters, syringe
shields, and output tubing.

Warranty limitations

174

THE FOREGOING PROVISIONS SET FORTH APPLIED BIOSYSTEMS' SOLE
AND EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND OBLIGATIONS
WITH RESPECT TO THE PRODUCTS WARRANTIED HEREIN, AND APPLIED
BIOSYSTEMS MAKES NO OTHER WARRANTY OF ANY KIND
WHATSOEVER, EXPRESSED OR IMPLIED, INCLUDING WITHOUT
LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE, WHETHER ARISING FROM A STATUTE OR
OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE OF
TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

THE REMEDIES PROVIDED HEREIN ARE THE BUYER'S SOLE AND
EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE
FOREGOING, TO THE FULL EXTENT ALLOWED BY LAW, IN NO EVENT
SHALL APPLIED BIOSYSTEMS BE LIABLE, WHETHER IN CONTRACT, TORT,
WARRANTY, OR UNDER ANY STATUTE (INCLUDING WITHOUT
LIMITATION, ANY TRADE PRACTICE, UNFAIR COMPETITION, OR OTHER
STATUTE OF SIMILAR IMPORT) OR ON ANY OTHER BASIS, FOR DIRECT,
INDIRECT, PUNITIVE, INCIDENTAL, MULTIPLE, CONSEQUENTIAL, OR
SPECIAL DAMAGES SUSTAINED BY THE BUYER OR ANY OTHER PERSON
OR ENTITY, WHETHER OR NOT FORESEEABLE AND WHETHER OR NOT
APPLIED BIOSYSTEMS IS ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES ARISING FROM
OR RELATED TO LOSS OF USE, LOSS OF DATA, FAILURE OR INTERRUPTION
IN THE OPERATION OF ANY EQUIPMENT OR SOFTWARE, DELAY IN REPAIR
OR REPLACEMENT, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF
GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL LOSS OR
PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF APPLIED BIOSYSTEMS
HAS ANY AUTHORITY TO MODIFY THE TERMS OF THIS LIMITED
WARRANTY STATEMENT OR TO BIND APPLIED BIOSYSTEMS TO ANY
AFFIRMATION, REPRESENTATION, OR WARRANTY CONCERNING THE
PRODUCT THAT IS NOT CONTAINED IN THIS LIMITED WARRANTY
STATEMENT, AND ANY SUCH MODIFICATION, AFFIRMATION,
REPRESENTATION, OR WARRANTY MADE BY ANY AGENT, EMPLOYEE, OR
REPRESENTATIVE OF APPLIED BIOSYSTEMS WILL NOT BE BINDING ON
APPLIED BIOSYSTEMS, UNLESS IN A WRITING SIGNED BY AN EXECUTIVE
OFFICER OF APPLIED BIOSYSTEMS.
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Appendix H Instrument Warranty Information I_l
Damages, claims, and returns

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM
APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion
of warranties, of liability, such as liability for gross negligence or willful misconduct,
or of remedies or damages, as or to the extent set forth above. In such countries and
jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages
set forth above shall apply to the fullest extent permitted by law, and shall not apply to
the extent prohibited by law.

Damages, claims, and returns

Damages If shipping damage to the product is discovered, contact the shipping carrier and
request inspection by a local agent. Secure a written report of the findings to support
any claim. Do not return damaged goods to Applied Biosystems without first securing
an inspection report and contacting Applied Biosystems Technical Support for a
Return Authorization (RA) number.

Claims  After a damage inspection report is received by Applied Biosystems, Applied
Biosystems will process the claim unless other instructions are provided.

Returns Do not return any material without prior notification and authorization.

If for any reason it becomes necessary to return material to Applied Biosystems,
contact Applied Biosystems Technical Support or your nearest Applied Biosystems
subsidiary or distributor for a return authorization (RA) number and forwarding
address. Place the RA number in a prominent location on the outside of the shipping
container, and return the material to the address designated by the Applied Biosystems
representative.
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H Appendix H Instrument Warranty Information
Damages, claims, and returns
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Applied Biosystems End User Software
License Agreement

This appendix covers:
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About this agreement

n Appendix | Applied Biosystems End User Software License Agreement

About this agreement

Title

Copyright

178

This appendix is the Applied Biosystems End User Software License Agreement for
Instrument Operating and Associated Bundled Software and Limited Product
Warranty.

NOTICE TO USER: PLEASE READ THIS APPLIED BIOSYSTEMS SOLiD™ 4
SYSTEM SOFTWARE SUITE END USER SOFTWARE LICENSE AGREEMENT
CAREFULLY. THIS IS THE CONTRACT BETWEEN YOU AND APPLIED
BIOSYSTEMS, LLC, REGARDING THE OPERATING SOFTWARE FOR YOUR
APPLIED BIOSYSTEMS WORKSTATION OR OTHER INSTRUMENT AND
BUNDLED SOFWARE INSTALLED WITH YOUR OPERATING SOFTWARE.
THIS AGREEMENT CONTAINS WARRANTY AND LIABILITY DISCLAIMERS
AND LIMITATIONS. YOUR INSTALLATION AND USE OF THE APPLIED
BIOSYSTEMS SOFTWARE IS SUBJECT TO THE TERMS AND CONDITIONS
CONTAINED IN THIS AGREEMENT AND YOU WILL BE BOUND BY THESE
TERMS AND CONDITIONS IF YOU INSTALL OR USE THIS SOFTWARE.

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT, YOU SHOULD PROMPTLY RETURN THIS SOFTWARE,
TOGETHER WITH ALL PACKAGING, TO APPLIED BIOSYSTEMS AND YOUR
PURCHASE PRICE WILL BE REFUNDED.

This Agreement accompanies the Applied Biosystems SOLiD System Software Suite
(“Software”) and related explanatory materials (“Documentation”). The term
“Software” also includes any upgrades, modified versions, updates, additions and
copies of the Software licensed to you by Applied Biosystems. The term

“Applied Biosystems,” as used in this License, means Applied Biosystems, LLC. The
term “License” or “Agreement” means this End User Software License Agreement.
The term “you” or “Licensee” means the purchaser from Applied Biosystems of this
license to use the Software.

Title, ownership rights and intellectual property rights in and to the Software and
Documentation shall at all times remain with Applied Biosystems, LLC and its
subsidiaries, and their suppliers. All rights not specifically granted by this License,
including Federal and international copyrights, are reserved by Life Technologies or
their respective owners.

The Software, including its structure, organization, code, user interface and associated
Documentation, is a proprietary product of Life Technologies or its suppliers, and is
protected by international laws of copyright. The law provides for civil and criminal
penalties for anyone in violation of the laws of copyright.
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Appendix | Applied Biosystems End User Software License Agreement n
License

License

Use of the software 1. 1.Subject to the terms and conditions of this Agreement, Applied Biosystems,
LLC grants you a non-exclusive license only to install and use the Software to
operate the single instrument or workstation in connection with which this License
was purchased and to display, analyze and otherwise manipulate data generated by
the use of such product. There is no limit to the number of computers on which
you may install and use the Software to display, analyze and otherwise manipulate
such data.

2. Ifthe Software uses registration codes, access to the number of licensed copies of
Software is controlled by a registration code. For example, if you have a
registration code that enables you to use five copies of Software simultaneously,
you cannot install the Software on more than five separate computers.

3. You may make one copy of the Software in machine-readable form solely for
backup or archival purposes. You must reproduce on any such copy all copyright
notices and any other proprietary legends found on the original. You may not
make any other copies of the Software except as permitted under Section 1 above.

Restrictions 1. You agree that you will not copy or use the Software, or the associated
documentation, in whole or in part, except as expressly permitted in this
Agreement.

2. You agree that you will not reverse assemble, decompile, or otherwise reverse
engineer the Software.

3. You agree that you will not remove any proprietary, copyright, trade secret or
warning legend from the Software or any Documentation.

4. You agree to fully comply with all export laws and restrictions and regulations of
the United States or applicable foreign agencies or authorities. You agree that you
will not export or reexport, directly or indirectly, the Software into any country
prohibited by the United States Export Administration Act and the regulations
thereunder or other applicable United States law.
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5. You agree that you will not modify, merge the Software, or any interest therein, or
create derivative works based on the Software, or any part thereof.

6. You agree that you will not sell, rent, transfer, or distribute this license or the
Software or any part thereof, or any interest therein, to any other person.

Trial TIfthis license is granted on a trial basis, you are hereby notified that license
management software may be included to automatically cause the Software to cease
functioning at the end of the trial period.
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Termination

US government end

180

users

European
community end
users

Regulated uses

You may terminate this Agreement by discontinuing use of the Software, removing all
copies from your computers and storage media, and returning the Software and
Documentation, and all copies thereof, to Life Technologies. Life Technologies may
terminate this Agreement if you fail to comply with all of its terms, in which case you
agree to discontinue using the Software, remove all copies from your computers and
storage media, and return the Software and Documentation, and all copies thereof, to
Life Technologies.

The Software is a “commercial item,” as that term is defined in 48 C.F.R. 2.101 (Oct.
1995), consisting of “commercialcomputer software” and“commercial computer
software documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept. 1995).
Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4 (June
1995), all U.S. Government End Users acquire the Software with only those rights set
forth herein.

If this Software is used within a country of the European Community, nothing in this
Agreement shall be construed as restricting any rights available under the European
Community Software Directive, O.J. Eur. Comm. (No. L. 122) 42 (1991).

You acknowledge that the Software has not been cleared, approved, registered or
otherwise qualified (collectively, “Approval”) by Applied Biosystems, LLC with any
regulatory agency for use in diagnostic or therapeutic procedures, or for any other use
requiring compliance with any federal or state law regulating diagnostic or therapeutic
products, blood products, medical devices or any similar product (hereafter collectively
referred to as “federal or state drug laws”) or the Software has been validated for any
such regulated uses. The Software must not be used for any purpose that would require
any such Approval or validation unless proper Approval is obtained or validation is
completed. You agree that if you elect to use the Software for a purpose that would
subject you or the Software to the jurisdiction of any federal or state drug laws, you
will be solely responsible for obtaining any required Approvals and otherwise ensuring
that your use of the Software complies with such laws or any required validation.
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Limited warranty and limitation of remedies

Limited Warranty. Applied Biosystems warrants that, during the same period as of
the SOLiD™ 4 Analyzer for which this Software is an instrument operating software,
the Software will function substantially in accordance with the functions and features
described in the Documentation delivered with the Software when properly installed,
and that for a period of ninety days from the beginning of the applicable warranty
period (as described below) the tapes, CDs, diskettes or other media bearing the
Software will be free of defects in materials and workmanship under normal use.

The above warranties do not apply to defects resulting from misuse, neglect, or
accident, including without limitation: operation outside of the environmental or use
specifications, or not in conformance with the instructions for any instrument system,
software, or accessories; improper or inadequate maintenance by the user; installation
of software or interfacing, or use in combination with software or products not supplied
or authorized by Applied Biosystems; intrusive activity, including without limitation
computer viruses, hackers or other unauthorized interactions with instrument or
software that detrimentally affects normal operations;.and modification or repair of the
products not authorized by Applied Biosystems.

Warranty Period Commencement Date. The applicable warranty period for software
begins on the earlier of the date of installation or three (3) months from the date of
shipment for software installed by Applied Biosystems' personnel. For software
installed by the purchaser or anyone other than Applied Biosystems, the warranty
period begins on the date the software is delivered to you. The applicable warranty
period for media begins on the date the media is delivered to the purchaser.

APPLIED BIOSYSTEMS MAKES NO OTHER WARRANTIES OF ANY KIND
WHATSOEVER, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE
OR DOCUMENTATION, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY OR THAT
THE SOFTWARE OR DOCUMENTATION IS NON-INFRINGING. ALL OTHER
WARRANTIES ARE EXPRESSLY DISCLAIMED. WITHOUT LIMITING THE
GENERALITY OF THE FOREGOING, APPLIED BIOSYSTEMS MAKES NO
WARRANTIES THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS,
THAT OPERATION OF THE LICENSED SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE OR WILL CONFORM EXACTLY TO THE
DOCUMENTATION, OR THAT APPLIED BIOSYSTEMS WILL CORRECT ALL
PROGRAM ERRORS. APPLIED BIOSYSTEMS' SOLE LIABILITY AND
RESPONSIBILITY FOR BREACH OF WARRANTY RELATING TO THE
SOFTWARE OR DOCUMENTATION SHALL BE LIMITED, AT APPLIED
BIOSYSTEMS' SOLE OPTION, TO (1) CORRECTION OF ANY ERROR
IDENTIFIED TO APPLIED BIOSYSTEMS IN A WRITING FROM YOU IN A
SUBSEQUENT RELEASE OF THE SOFTWARE, WHICH SHALL BE SUPPLIED
TO YOU FREE OF CHARGE, (2) ACCEPTING A RETURN OF THE PRODUCT,
AND REFUNDING THE PURCHASE PRICE UPON RETURN OF THE PRODUCT
AND REMOVAL OF ALL COPIES OF THE SOFTWARE FROM YOUR
COMPUTERS AND STORAGE DEVICES, (3) REPLACEMENT OF THE
DEFECTIVE SOFTWARE WITH A FUNCTIONALLY EQUIVALENT PROGRAM
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Third party products

AT NO CHARGE TO YOU, OR (4) PROVIDING A REASONABLE WORK
AROUND WITHIN A REASONABLE TIME. APPLIED BIOSYSTEMS SOLE
LIABILITY AND RESPONSIBILITY UNDER THIS AGREEMENT FOR BREACH
OF WARRANTY RELATING TO MEDIA IS THE REPLACEMENT OF
DEFECTIVE MEDIA RETURNED WITHIN 90 DAYS OF THE DELIVERY DATE.
THESE ARE YOUR SOLE AND EXCLUSIVE REMEDIES FOR ANY BREACH OF
WARRANTY. WARRANTY CLAIMS MUST BE MADE WITHIN THE
APPLICABLE WARRANTY PERIOD.

Third party products

This Software uses third-party software components from several sources. Portions of
these software components are copyrighted and licensed by their respective owners.
Various components require distribution of source code or if a URL is used to point the
end-user to a source-code repository, and the source code is not available at such site,
the distributor must, for a time determined by the license, offer to provide the source
code. In such cases, please contact your Life Technologies representative. As well,
various licenses require that the end-user receive a copy of the license. Such licenses
may be found on the distribution media in a folder called “Licenses.” In order to use
this Software, the end-user must abide by the terms and conditions of these third-party
licenses. After installation, the licenses may also be found in a folder named
“Licenses” located in the Software installation's root directory.

Limitation of liability

182

IN NO EVENT SHALL APPLIED BIOSYSTEMS OR ITS SUPPLIERS BE
RESPONSIBLE OR LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY
OR UNDER ANY STATUTE (INCLUDING WITHOUT LIMITATION ANY
TRADE PRACTICE, UNFAIR COMPETITION OR OTHER STATUTE OF
SIMILAR IMPORT) OR ON ANY OTHER BASIS FOR SPECIAL, INDIRECT,
INCIDENTAL, MULTIPLE, PUNITIVE, OR CONSEQUENTIAL DAMAGES
ARISING OUT OF THE POSSESSION OR USE OF, OR THE INABILITY TO USE,
THE SOFTWARE OR DOCUMENTATION, EVEN IF APPLIED BIOSYSTEMS IS
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH DAMAGES,
INCLUDING WITHOUT LIMITATION DAMAGES ARISING FROM OR
RELATED TO LOSS OF USE, LOSS OF DATA, DOWNTIME, OR FOR LOSS OF
REVENUE, PROFITS, GOODWILL OR BUSINESS OR OTHER FINANCIAL
LOSS. IN ANY CASE, THE ENTIRE LIABILITY OF APPLIED BIOSYSTEMS'
AND ITS SUPPLIERS UNDER THIS LICENSE, OR ARISING OUT OF THE USE
OF THE SOFTWARE, SHALL NOT EXCEED IN THE AGGREGATE THE
PURCHASE PRICE OF THE PRODUCT.

SOME STATES, COUNTRIES OR JURISDICTIONS LIMIT THE SCOPE OF OR
PRECLUDE LIMITATIONS OR EXCLUSION OF REMEDIES OR DAMAGES, OR
OF LIABILITY, SUCH AS LIABILITY FOR GROSS NEGLIGENCE OR WILLFUL
MISCONDUCT, AS OR TO THE EXTENT SET FORTH ABOVE, OR DO NOT
ALLOW IMPLIED WARRANTIES TO BE EXCLUDED. IN SUCH STATES,
COUNTRIES OR JURISDICTIONS, THE LIMITATION OR EXCLUSION OF
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Limitation of liability

WARRANTIES, REMEDIES, DAMAGES OR LIABILITY SET FORTH ABOVE
MAY NOT APPLY TO YOU. HOWEVER, ALTHOUGH THEY SHALL NOT APPLY
TO THE EXTENT PROHIBITED BY LAW, THEY SHALL APPLY TO THE
FULLEST EXTENT PERMITTED BY LAW. YOU MAY ALSO HAVE OTHER
RIGHTS THAT VARY BY STATE, COUNTRY OR OTHER JURISDICTION.
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General

184

This Agreement shall be governed by laws of the State of California, exclusive of its
conflict of laws provisions. This Agreement shall not be governed by the United
Nations Convention on Contracts for the International Sale of Goods. This Agreement
contains the complete agreement between the parties with respect to the subject matter
hereof, and supersedes all prior or contemporaneous agreements or understandings,
whether oral or written. If any provision of this Agreement is held by a court of
competent jurisdiction to be contrary to law, that provision will be enforced to the
maximum extent permissible, and the remaining provisions of this Agreement will
remain in full force and effect. The controlling language of this Agreement, and any
proceedings relating to this Agreement, shall be English. You agree to bear any and all
costs of translation, if necessary. The headings to the sections of this Agreement are
used for convenience only and shall have no substantive meaning. All questions
concerning this Agreement shall be directed to: Applied Biosystems, 850 Lincoln
Centre Drive, Foster City, CA 94404-1128, Attention: Legal Department.
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Symbols on instruments

Electrical The following table describes the electrical symbols that may be displayed on

symbols on  Applied Biosystems instruments.
instruments

Symbol Description

I Indicates the On position of the main power switch.

O Indicates the Off position of the main power switch.

Indicates a standby switch by which the instrument is switched on to the
Standby condition. Hazardous voltage may be present if this switch is on
standby.

Indicates the On/Off position of a push-push main power switch.

Indicates a terminal that may be connected to the signal ground reference of

J_— another instrument. This is not a protected ground terminal.
oy
D

Indicates a protective grounding terminal that must be connected to earth
ground before any other electrical connections are made to the instrument.

Indicates a terminal that can receive or supply alternating current or voltage.

Indicates a terminal that can receive or supply alternating or direct current or
>~ voltage.

Safety symbols The following table describes the safety symbols that may be displayed on
Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety labels on instruments” on page 188). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS
that occur in the text of this and other product-support documents.

Symbol Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard
and to proceed with appropriate caution.

B> [>
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Description

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

Indicates the presence of a biological hazard and to proceed with
appropriate caution.

Indicates the presence of a radiological hazard and to proceed with
appropriate caution.

Indicates the presence of a slipping hazard and to proceed with appropriate
caution.

Indicates the presence of an ultraviolet light (in the instrument?) and to
proceed with appropriate caution.

>R b |

CAUTION! Potential overhead hazard.

Environmental The following symbol applies to all Applied Biosystems electrical and electronic
symbols on  products placed on the European market after August 13, 2005.

instruments

Symbol

Description

|

i

L

Do not dispose of this product as unsorted municipal waste. Follow
local municipal waste ordinances for proper disposal provisions to reduce
the environmental impact of waste electrical and electronic equipment

(WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment
pick-up and recycling. See www.appliedbiosystems.com for a list of
customer service offices in the European Union.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide
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Safety labels on instruments

The SOLiD™ 4 System contains warnings at the locations listed in Table 45.
Table 45 Where to find safety labels on the SOLID™ 4 System

Safety label Located by...
CAUTION! Hot Surfaces. Flow cell cover and inside arc lamp box
CAUTION! Replace only with CERMAX Arc lamp box cover

[x300f, 300 W Lamp

WARNING! HOT! Do not remove lamp until Arc lamp box cover
15 minutes after disconnecting
supply!Surfaces.

CAUTION! Crush/Pinch hazard Syringe pump
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General instrument safety

ﬁ WARNING! PHYSICAL INJURY HAZARD. Use this product only as
specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and lifting CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved
the instrument and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been
installed, do not attempt to lift or move the instrument without the assistance of
others, the use of appropriate moving equipment, and proper lifting techniques.
Improper lifting can cause painful and permanent back injury. Depending on the
weight, moving or lifting an instrument may require two or more persons.

Moving and lifting é WARNING! Do not attempt to lift or move the computer or the monitor without

stand-alone the assistance of others. Depending on the weight of the computer and/or the
compur’:‘e;ﬁi taonrg monitor, moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:
* Make sure that you have a secure, comfortable grip on the computer or the
monitor when lifting.

* Make sure that the path from where the object is to where it is being moved is
clear of obstructions.

» Do not lift an object and twist your torso at the same time.

+ Keep your spine in a good neutral position while lifting with your legs.

* Participants should coordinate lift and move intentions with each other before
lifting and carrying.

» Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the  Ensure that anyone who operates the instrument has:

instrument o N . . .
* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.
* Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs”
on page 195.
Cleat_‘ling_ or CAUTION! Before using a cleaning or decontamination method other than
decontaminating those recommended by the manufacturer, verify with the manufacturer that the

the instrument proposed method will not damage the equipment.
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Physical hazard safety

Ultraviolet light WARNING! ULTRAVIOLET LIGHT HAZARD. Looking directly at a UV
light source can cause serious eye damage. Never look directly at a UV light
source and always prevent others from UV exposure. Follow the manufacturer’s
recommendations for appropriate protective eyewear and clothing.

Moving parts ii WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and
cut. Keep hands clear of moving parts while operating the instrument.
Disconnect power before servicing the instrument.

Solvents and WARNING! PHYSICAL INJURY HAZARD. Always wear eye protection
pressurized fluids when working with solvents or any pressurized fluids.

* Be aware that polymeric tubing is a polymeric material. Use caution when
working with any polymer tubing that is under pressure.

Always wear eye protection when near pressurized polymer tubing.
» Extinguish all nearby flames if you use flammable solvents.
» Do not use polymeric tubing that has been severely stressed or kinked.
* Do not use polymeric tubing with tetrahydrofuran or nitric and sulfuric acids.

* Be aware that methylene chloride and dimethyl sulfoxide cause polymeric tubing
to swell and greatly reduce the rupture pressure of the tubing.

* Be aware that high solvent flow rates (~40 mL/min) may cause a static charge to
build up on the surface of the tubing. Electrical sparks may result.
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Electrical safety

A WARNING! ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the SOLiD™ 4 System without its instrument panels in
place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

Fuses & WARNING! FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the
instrument, verify that the fuses are properly installed and that the instrument
voltage matches the power supply in your laboratory.

ii WARNING! FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

Power A WARNING! ELECTRICAL HAZARD. Grounding circuit continuity is
required for the safe operation of equipment. Never operate equipment with the
grounding conductor disconnected.

WARNING! ELECTRICAL HAZARD. Use properly configured and
approved line cords for the voltage supply in your facility.

WARNING! ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage rating The SOLiD"™ 4 System has an installation (overvoltage) category of II, and is classified
as portable equipment.
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Workstation safety

192

Correct ergonomic configuration of your workstation can reduce or prevent effects
such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring
your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION
HAZARD. These hazards are caused by potential risk factors that include but
are not limited to repetitive motion, awkward posture, forceful exertion, holding
static unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

* Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Appendix J Safety
Instrumentation safety

Safety and electromagnetic compatibility (EMC) standards

U.S. and Canadian
safety
standards

c(UL)us

Canadian EMC
standard

European safety
and EMC
standards

C€

Australian EMC
Standards

C

Applied Biosystems SOLID™ 4 System Instrument Operation Guide

This section provides information on:

+ U.S. and Canadian safety standards
* Canadian EMC standard

» European safety and EMC standards
* Australian EMC Standards

The SOLiD™ 4 System has been tested to and complies with standard:

UL 61010-1/CSA C22.2 No. 61010-1, “Safety Requirements for Electrical Equipment
for Measurement, Control, and Laboratory Use, Part 1: General Requirements.”

UL 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating
of Materials.”

This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Scientific, and Medical Radio Frequency Generators.”

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards

EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating
of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of
Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chemical safety

General chemical safety

194

Chemical hazard
warning

WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to
the Safety Data Sheet (SDS) provided by the manufacturer, and observe all
relevant precautions.

ﬁ WARNING! CHEMICAL HAZARD. All chemicals in the instrument,

including liquid in the lines, are potentially hazardous. Always determine what
chemicals have been used in the instrument before changing reagents or
instrument components. Wear appropriate eyewear, protective clothing, and
gloves when working on the instrument.

ﬁ WARNING! CHEMICAL HAZARD. Four-liter reagent and waste bottles can

crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in
the upright position. Wear appropriate eyewear, clothing, and gloves when
handling reagent and waste bottles.

é WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

Chemical safety To minimize the hazards of chemicals:

guidelines

Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. (See “About SDSs” on page 195.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the SDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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SDSs

About SDSs  Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of
hazardous chemicals to new customers. They also provide SDSs with the first shipment
of a hazardous chemical to a customer after an SDS has been updated. SDSs provide
the safety information you need to store, handle, transport, and dispose of the
chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to
replace the appropriate SDS in your files.

Obtaining The SDS for any chemical supplied by Applied Biosystems is available to you free 24
SDSs  hours a day. To obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.

2. In the Keyword Search field, enter the chemical name, product name, SDS part
number, or other information that appears in the SDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

*  Open — To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a
destination that you choose

\g Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact
the chemical manufacturer.
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Chemical waste safety

Chemical waste
hazards

Chemical waste
safety guidelines

Waste disposal

196

CAUTION! HAZARDOUS WASTE. Refer to Safety Data Sheets and local
regulations for handling and disposal.

ﬁ WARNING! CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness,
or death.

WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste
in a glass container because of the risk of breaking or shattering. Reagent and
waste bottles can crack and leak. Each waste bottle should be secured in a low-
density polyethylene safety container with the cover fastened and the handles
locked in the upright position. Wear appropriate eyewear, clothing, and gloves
when handling reagent and waste bottles.

To minimize the hazards of chemical waste:

Read and understand the Safety Data Sheets (SDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from
the primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing). For additional safety guidelines, consult the SDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the SDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and
health regulations.

If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Appendix J Safety J
Chemical safety
* Ensure that the instrument waste is stored, transferred, transported, and disposed

of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Biological hazard safety

General biohazard WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes but
is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves.
All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and
company/institution requirements before working with potentially infectious
materials. Read and follow the applicable guidelines and/or regulatory
requirements in the following:

» U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories
(http://www.cdc.gov/od/ohs/biosfty/bmbl5/bmbl5toc.htm).

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/
nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:
www.cdc.gov

Safety alerts

For the definitions of the alert words IMPORTANT, CAUTION, WARNING, and
DANGER, see “Safety alert words” on page 7.

198 Applied Biosystems SOLID™ 4 System Instrument Operation Guide


http://bmbl.od.nih.gov
http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html
http://www.cdc.gov

barcode

barcoded fragment

library
BC tag
bead count
bead signal

best beads

F3 tag

F5-P2 tag

F5-BC tag

fragment library

good beads

image signal

internal adaptor

library

mappable beads

mate-paired library

multiplexing

N2S plot

Glossary

Unique sequence identifier added to the sample during library construction

Fragment library with a barcode sequence appended to the 3" end of the sheared DNA
fragments

Barcode tag
The number of beads detected in a panel
The average signal intensity of every pixel associated with a bead

Number of beads that meet a stringent set of criteria based on spectral purity and
intensity

Tag to be sequenced using primers specific to the P1 Adaptor sequence

Tag to be sequenced using reverse ligation chemistry and using primers specific to the
P2 Adaptor sequence (for paired-end sequencing of non-barcoded fragment libraries)

Tag to be sequenced using reverse ligation chemistry and using primers specific to the
Internal Adaptor sequence (for paired-end sequencing of barcoded fragment libraries)

Library consisting of a sheared DNA fragment with P1 and P2 Adaptors ligated to the
5" end and 3’ end respectively

The number of beads that meet criteria (less stringent than best beads criteria) based on
spectral purity and intensity

The average signal intensity of every pixel whether or not it is associated with a bead or
not

Double-stranded oligonucleotide located between two tags to be sequenced

Set of DNA tags prepared from the same biological sample to be sequenced on the
SOLiD™ System

Beads with template that map back to the reference genome

Library consisting of two DNA tags a known distance apart linked by an internal
adaptor with P1 and P2 Adaptors ligated to the 5" end and 3’ end, respectively

Method to analyze multiple biological samples in a single spot using barcodes

Plot indicating noise-to-signal for each dye
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Glossary

on-axis beads

optimal titration
point

P1 Adaptor
P2 Adaptor

P24#/P1# ratio

P2-positive beads

pulse-spin

R3 tag

remove the
supernatant

resuspend the
beads

Satay plot

sonicate the beads

tag

templated bead
preparation

templated beads
titration

titration metric

200

The frequency of template-positive beads that meet a defined threshold of spectral
purity and signal intensity after a single ligation step

Library template concentration that gives the best sequencing results

Double-stranded oligonucleotide ligated at the 5" end of the library
Double-stranded oligonucleotide ligated at the 3" end of the library

The frequency of template-positive beads (P2#) relative to total beads (P1#) deposited
on the slide; this metric is also referred to as “% P2 Positive” value

SOLiD™ P1 DNA beads with fully extended and amplified template

Place the tube in a picofuge and spin for a few seconds to bring down any beads or
liquid stuck on the walls of the tube

Tag to be sequenced using primers specific to the Internal Adaptor sequence

Use a pipette to carefully remove the liquid from the tube without disturbing any beads

The beads can be resuspended in one of two ways:

* Gently pipet the solution up and down until the beads are suspended. Using a
slower speed to aspirate and expel the solution minimizes the amount of beads that
stick to the inside of the pipette tip.

* Vortex the solution until all of the beads are suspended. Place the beads in a
picofuge and pulse-spin for a few seconds to bring down any beads stuck on the
walls of the tube. Do not over-spin the beads or the beads aggregate into a pellet.

Indicator of spectral purity and signal intensity of the beads

Place the tube containing the beads in the appropriate tube holder, then place in the
Covaris™ S2 System; afterwards, run the appropriate program

A length of DNA to be sequenced

Process of adding library template to beads by emulsion PCR, enriching the beads to
remove beads without template, then modifying the 3” end of the template on the beads
to prepare for bead deposition and sequencing

SOLiD™ P1 DNA Beads with amplified library template attached

Library template concentration used to prepare an emulsion

Product of %P2 positive beads and the On-Axis beads; the titration that generates the
highest titration metric value is the optimal titration point for a given library

Applied Biosystems SOLID™ 4 System Instrument Operation Guide



Glossary

usable beads Number of beads that are called during color-calling
workflow analysis Type of run on the SOLiD™ system in which a small portion of templated beads are
(WFA) run deposited and analyzed to test for templated bead quality
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Related documentation

Documentation

Part .
Document number Description

Applied Biosystems 4445673 Provides procedures for preparing libraries.

SOLiD™ 4 System Library

Preparation Guide

Applied Biosystems 4445674 Provides brief, step-by-step procedures for

SOLiD™ 4 System Library preparing libraries.

Preparation Quick

Reference Card

Applied Biosystems 4448378 Describes how to prepare templated beads by

SOLID™ 4 System emulsion PCR (ePCR), required before

Templated Bead sequencing on the SOLID™ 4 System.

Preparation Guide

Applied Biosystems 4448329 Provides brief, step-by-step procedures for

SOLiD™ 4 System preparing templated beads by emulsion PCR

Templated Bead (ePCR), required before sequencing on the

Preparation Quick SOLID™ 4 System.

Reference Card

Applied Biosystems 4448380 Provides brief, step-by-step procedures for

SOLiD™ 4 System loading and running the SOLID™ 4 System.

Instrument Operation

Quick Reference Card

Applied Biosystems 4448639 Provides all the information that you need to set

SOLID™ 4 System Site up the SOLID™ 4 System.

Preparation Guide

Applied Biosystems 4448411 Provides an alternate platform to monitor runs,

SOLID™ 4 System SETS modify settings, and reanalyze previous runs that

Software User Guide are performed on the SOLID™ 4 System.

Applied Biosystems - Describes the software and provides procedures

SOLiD™ 4 System ICS for common tasks (see the Instrument Control

Software Help Software).

BioScope™ Software for 4448431 Provides a bioinformatics analysis framework for

Scientists Guide flexible application analysis (data-generated
mapping, SNPs, count reads) from sequencing
runs.

Working with 4452359 Provides an online suite of software tools for Next

SOLIDBioScope.com™ Generation Sequencing (NGS) analysis.

Quick Reference Card SOLiDBioScope.com™ leverages the scalable
resources of cloud computing to perform
computation-intensive NGS data processing.

Applied Biosystems 4448432 Describes the relationship between the software

SOLID™ 4 System comprising the SOLID 4 platform and provides

Software Integrated quick step procedures on operating each

Workflow Quick software to perform data analysis.

Reference Guide
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Documentation
Send us your comments

Part -
Document number Description
Applied Biosystems 4452360 Provides a quick guide to the sequencing kits you
SOLID™4 System need to perform fragment, paired-end, mate-pair,
Product Selection Guide multiplex fragment, and multiplex paired-end
sequencing.
Applied Biosystems 4451929 Provides a brief summary of changes made
SOLID™ System between the SOLID™ 3 Plus System
SOLiD™ 3 Plus to documentation and the SOLID™ 4 System
SOLiD™ 4 System User documentation.
Documentation Changes
Applied Biosystems 4449773 Provides a checklist to ensure that all necessary
SOLID™ 4 Upgrade preparations are made before upgrading to the
Checklist SOLID™ 4 System and provides a list of

consumables you can order.

\g Note: For additional documentation, see “How to obtain support” on page 9.

Send us your comments

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

@ IMPORTANT! The e-mail address above is for submitting comments and
suggestions relating only to documentation. To order documents, download PDF
files, or for help with a technical question, see “How to obtain support” on

page 9.
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Index

A italic text 9

Notes 9

user attention words 9
Covaris ™ S2 System operation and maintenance 167
customer feedback, on Applied Biosystems documents 204

Applied Biosystems
customer feedback on documentation 204
Information Development department 204

B cycle scans
viewing, for WFA run 65
Barcode Error Correction Level viewing, in sequencing run 96
and multiplex sequencing run record 75
modify 145 D

barcode sequencing, fill volumes for reagents 149

barcode: creating a library for a barcoded sample 79 DANGER, .descrlptlon 7
beads data analysis, about 17

Decant the SOLiD™ XD Slide Prep Reagent off of the
surface of the slide 29

density, bead deposition, determining 24, 56, 66

concentration chart 23

depositing 23

deposition density, determining 24, 56, 66
number per well according to run type 11 Deposition Chamber

number to use according to run 24 clean using a sonicator 114

biohazardous waste, handling 198 clean using Extran 300 116
bold text, when to use 9 documentation, related 203

bottles

clean the Instrument Buffer bottle 118 E

position of buffer bottles in chiller block 36 electrical safety 191

position of buffers and waste in the instrument 34 electromagnetic compatibility standards. See EMC

position of reagents in the instrument 35 standards

EMC standards 193

C end user software license agreement 177
CAUTION, description 7 Eppendorf Lo-Bind tubes, use of 22
Change Primer Schedule command 93 ergonomics, safety 192
Change Run Progress Point command 93
checklists and workflow tracking forms 161 F
chemical safety 194 fill volumes for on-instrument reagents 148
chemical waste safety 196 flowcell
clean O-ring, install 124

flush the fluidic lines 120 storing the slide in 144

the Instrument Buffer bottle 118 flush the fluidic lines 120

the reagent strip cover 125 focus range

the SOLiD™ Deposition Chamber using a detecting 61

sonicator 114

. o . finding manually 132
the SOLiD™ Deposition Chamber using Extran

fragment sequencing

: 300 116 fill volumes for on-instrument reagents 148
conventions reagent strip layouts 151
bold text 9
for describing menu commands 9
IMPORTANTS! 9 G
in this guide 9 glossary 199
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Index

guidelines
chemical safety 194
chemical waste disposal 196
chemical waste safety 196

H

hazard
icons. See safety symbols, on instruments 186
symbols. See safety symbols, on instruments
hazards. See safety

heat maps
viewing, for Workflow Analysis (WFA) run 65
viewing, in sequencing run 95

Image Prep, and pausing/resuming a run 89
IMPORTANT, description 7
Information Development department, contacting 204
install

on-instrument reagents 32

O-ring 42

reagent strips 45

slides on the instrument 39

the SOLiD™ Flowcell O-ring 124
installation category 191
instrument

operation, safety 189

process times 155
Instrument Buffer bottle, clean 118
introduction 11
italic text, when to use 9

L

library, creating; for barcoded samples 79
Light Source, replacing 126

Lo-Bind tubes, Eppendorf, use of 22

log

view run log for a Workflow Analysis (WFA) run 65

view run log in a sequencing run 95

M

maintenance, Covaris ™ S2 System 167
manually find the focus range 132
manuals, related 203
mate-pair sequencing
fill volumes for on-instrument reagents 148
Tag 1 reagent strip layouts 152
menu commands, conventions for describing 9
mismatches and Barcode Error Correction Level 145
moving and lifting safety

206

computers and monitors 189
instrument 189

moving parts, safety 190

multiplex sequencing run
Barcode Error Correction Level 75
create a run record 75

N
needle and needle holder 45

O

on-Instrument reagent volumes and reagent strip
layouts 147
Opti Slide Carrier, SOLID™ 27
O-ring
install 42
picture 42
overvoltage category (rating) 191

P

P2-positive beads 24
pause 93

Pause Run/Resume Run 89
physical hazard safety 190

Pipet 3 mL SOLiD™ XD Slide Prep Reagent over the
surface of the slide. 28

plumbing system schematic 159
pre-mixing 89

prepare and install slides and reagents 19
pressurized fluids, safety 190

process times

entire 158
individual 156

R

radioactive waste, handling 197
reagent
fill volumes, on-instrument 148
install on-instrument reagents 32
strip cover, clean 125
strips, install 45
reagent strip layouts
fragment sequencing 151
mate-pair sequencing, Tag 1 152
Workflow Analysis (WFA) run 154
repetitive motion, safety 192
replace the SOLiD™ Light Source 126
required kits and equipment
sequencing run 105
Workflow Analysis (WFA) run 102
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robot position, reset 144
run
Change Primer Schedule command 93
Change Run Progress Point command 93
fill volumes for on-instrument reagents 148
log, view, for a sequencing run 95
log, view, for a Workflow Analysis (WFA) run 65
multiplex record, create, for sequencing run 75
number of beads per well 11
Pause Run/Resume Run 89
pause/resume 89
purpose of different types 11
record, create, for Workflow Analysis (WFA) run 57
Run Control menu 92
Set Early Pause Point command 93
standard record, create, for sequencing run 71
Stop Run command 93
summary, about 11
time, estimated 11
types, overview 11
view cycle scans in a sequencing run 96
view heat maps in a sequencing run 95
Workflow Analysis (WFA) 55
Run Control Menu commands 92
Run Definition file, import to set up a run 127

S

safety 185
before operating the instrument 189
biological hazards 198
chemical 194
chemical waste 196
electrical 191
ergonomic 192
guidelines 194, 196
instrument operation 189
labels, on instruments 8, 188
moving and lifting computers and monitors 189
moving and lifting instrument 189
moving parts 190
physical hazard 190
pressurized fluids. See also compressed gases, safety
repetitive motion 192
solvents 190
standards 193
symbols, on instruments 186
ultraviolet light 190
workstation 192
Scan Slide, and pausing/resuming a run 89
SDSs
about 7
description 195
obtaining 9, 195

Index

sequencing run
about 13
Change Primer Schedule command 93
Change Run Progress Point command 93
create a multiplex run record 75
create a standard run record 71
fill volumes for on-instrument reagents 148
pause-resume, for pre-mixing 89
required kits and equipment 105
Run Control menu 92
Set Early Pause Point command 93
set up and perform a run 69
Stop Run command 93
view cycle scans 96
view heat maps 95
view run log 95
workflow 69
Set Early Pause Point command 93
set up
a run by importing a Run Definition file 127
set up, control, and monitor the run 53
shut down the SOLiD™ 4 Analyzer 144
Slide Carrier, SOLID™ 4 27
slides
prepare and install 39
slide carrier lockdown tabs 43
SOLiD Slide Storage Chamber 40
SOLID™ 4 Slide Carrier 27
SOLID™ Opti Slide Carrier 27
software
license agreement 177
operation, about 17
SOLID™
Slide Carrier lockdown tabs 43
SOLID™ 4 Analyzer plumbing system schematic 159
solvents, safety 190
standards
EMC 193
safety 193
Stop Run command 93
store the slide in a flowcell 144
strip layouts, reagent
fragment sequencing 151
mate-pair sequencing, Tag 1 152
Workflow Analysis (WFA) run 154
supplemental procedures
clean the reagent strip cover 125
clean the SOLiD™ Deposition Chamber using a
sonicator 114
clean the SOLiD™ Deposition Chamber using Extran
300 116
flush the fluidic lines 120
install the SOLiD™ Flowcell O-ring 124
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Index

manually find the focus range 132
replace the SOLiD™ Light Source 126

set up a run by importing a Run Definition file 127

shut down the SOLIiD™ 4 Analyzer 144
store the slide in a flowcell 144
symbols, safety 186
syringe 38

T

text conventions 9
times
entire processes 158
individual processes 156
run, estimated 11
tracking forms, workflow 161
training, information on 9

U

ultraviolet light, safety 190
user attention words, described 9

\'

volumes, fill, for on-instrument reagents 148

w

WARNING, description 7
waste
disposal, guidelines 196
profiles, description 196
WFA. See Workflow Analysis
Workflow Analysis (WFA) run
about 12
creating a run record 57
fill volumes for on-instrument reagents 148
reagent strip layouts 154
required kits and equipment 102
set up and perform a run 55
view run log 65
workflow 55
workflow checklists and tracking forms 161
workflow diagrams
bead concentration chart 23
preparing slides and reagents 20
relationship between types of runs 12
Workflow Analysis (WFA) run 55
workstation safety 192
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